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Preface

The SunUpdate Connection – Enterprise 1.0 User’s Guide provides information to system
administrators about how to use the SunSM Update Connection – Enterprise software tomanage
software updates to systems that run the SolarisTM Operating System or Linux distributions.

BeforeYouReadThis Book
To effectively use this book, you should be familiar with the following:

� Your client and host operating systems
� Basic Linux and Solaris commands
� CommonXWindows actions

You should understand Solaris dependency issues and Linux dependency issues, and know how
to use applications in XWindows. If youmanage Solaris hosts, you should be familiar with basic
Solaris commands. In general, you should be familiar with the hardware systems and network of
your organization.

HowThis Book IsOrganized
This book includes 15 chapters.

Chapter 1 describes the SunUpdate Connection – Enterprise concepts.

Chapter 2 gives a tour of themain window and basic usage of the GUI.

Chapter 3 describes how tomanage user accounts.

Chapter 4 describes how tomanage groups and how to view host properties.

Chapter 5 describes how to upload andmanage private software and files.

Chapter 7 describes how to set up and execute completemachine tests.

Chapter 8 describes how to set up and execute jobs tomanage installed components.

Chapter 9 describes how to createmachine definition profiles.
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Chapter 10 describes how to create job policies to control and automate solutions.

Chapter 11 describes how to set up and execute jobs tomanage hosts withmultiple profiles, policies,
schedules, and options.

Chapter 12 describes Solaris settings, jobs formultiple distributions, searching for components,
confirming actions, troubleshooting jobs, and various other job-related functions.

Chapter 13 describes how to set up incident queries and history queries, and how tomanage the
result reports.

Chapter 14 describes the SunUpdate Connection – Enterprise command-line interface (CLI).

Chapter 15 includes advanced information for environmentmanagement.

Chapter 16 describes how to view and change background parameters.

Note –Whenever possible, tasks include procedures for both the GUI and the CLI. Youmust be the
admin user or a user with full permissions to use the CLI.

The CLI commands can be issued to the command line or can be included in shell scripts. The
command syntax is shown, and when relevant, an example script is provided.

The CLI examples show how to authenticate the commands by providing the user name and the
password on the command line. If you do not specify the user name and password, you will be
prompted for the information.When you create a shell script with SunUpdate Connection –
Enterprise commands, specify the user name and password on each command line to avoid typing
this authentication information each time the script runs a command. You can use variables to
specify the user name and password.

RelatedBooks
In addition to this book, findmore information in the following publications.

� SunUpdate Connection – Enterprise 1.0 Administration Guide
This book includes procedures for installation, customization, backup and restore, support of
Shared Resources, and advanced configurations. This book also includes explanations of
solutions for Linux and Solaris technology, servers in the solution, and security.

� Online Help
This help is accessed in the GUI by pressing F1 and describes the user interface as well as other
GUI explanations.

� Release Notes
This book includes new features, platform support, problems and issues.

Preface
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What’sNew in This SunUpdate Connection – Enterprise
Release

SunUpdate Connection – Enterprise included support for the Solaris Operating System, which
makes SunUpdate Connection – Enterprise themigration choice for enterprises that are looking for
amore cost-effective solution.

This software include the following new features:

� Remote restart, both automated and on-demand
� Expansive incident reports for Solaris patchmanagement
� Profile attachment to hosts and groups for compliance checks
� Complex jobs that use one ormore profile deployments and system-wide scans
� Email notifications of host status and job status
� Improved and easy access to the graphical user interface (GUI)

Documentation, Support, andTraining
The Sunweb site provides information about the following additional resources:

� Documentation (http://www.sun.com/documentation/)
� Support (http://www.sun.com/support/)
� Training (http://www.sun.com/training/)

Sun will provide a technical faq in a read only format at
http://forum.sun.com/jive/forum.jspa?forumID=334. The URL is subject to change andmay be
removed at Sun’s discretion.

Typographic Conventions
The following table describes the typographic conventions that are used in this book.

TABLE P–1TypographicConventions

Typeface Meaning Example

AaBbCc123 The names of commands, files, and directories,
and onscreen computer output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

Preface
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TABLE P–1TypographicConventions (Continued)
Typeface Meaning Example

aabbcc123 Placeholder: replace with a real name or value The command to remove a file is rm
filename.

AaBbCc123 Book titles, new terms, and terms to be
emphasized

Read Chapter 6 in theUser’s Guide.

A cache is a copy that is stored
locally.

Do not save the file.

Note: Some emphasized items
appear bold online.

Shell Prompts in CommandExamples
The following table shows the default UNIX® system prompt and superuser prompt for the C shell,
Bourne shell, and Korn shell.

TABLE P–2Shell Prompts

Shell Prompt

C shell machine_name%

C shell for superuser machine_name#

Bourne shell and Korn shell $

Bourne shell and Korn shell for superuser #

Preface
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Introduction to the SunUpdate Connection –
Enterprise Product

SunUpdate Connection – Enterprise provides lifecycle changemanagement for Solaris
environments or Linux environments.

This chapter explains how SunUpdate Connection – Enterprise makes your network and system
administrationmore efficient andmore secure.

This chapter covers the following topics:

� “SunUpdate Connection – Enterprise Overview” on page 19
� “Features” on page 20
� “Applications” on page 20

SunUpdate Connection – EnterpriseOverview
SunUpdate Connection – Enterprise is a software tool that manages the complete lifecycle
deployment in an enterprise Linux environment and in an enterprise Solaris environment. The Sun
Update Connection – Enterprise solution significantly reduces the time and expertise required to
build and deploy an updated, secure, and reliable environment.

SunUpdate Connection – Enterprise ensures the integrity of the environment, which includes the
kernel, the operating system, open source components, middleware, third-party applications, and
homegrown applications. SunUpdate Connection – Enterprise uses a sophisticated patented
technology that maps interdependencies between software components.

The Certification Lab generates real-world deployment rules, themost exact and up-to-date, for
thousands of authenticated components. These rules are based on actual tests for every phase of the
system lifecycle. You can use SunUpdate Connection – Enterprise tomanage development, test, and
productionmachines with certified components and rules. You can alsomanagemachines with rules
you generate by using the local expansion technology to include third-part applications and
homegrown applications. Every day the Certification Lab addsmore components and deployment
rules to the universal server.

1C H A P T E R 1
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The system dependency server is installed at your site. This server extracts and retains system logic
from the underlying operating systems and hardware platforms of yourmanaged hosts. Logic
abstractionmaximizes ongoing system investment andmitigates the risk of being locked into a
single vendor, distribution, or hardware platform.

Features
SunUpdate Connection – Enterprise includes the following functions and features:

� Audit trail
� Auto-dependency handling
� Auto-discovery of installed components
� CLI andAPI for integration with IT processes and othermanagement tools
� Graphical user interface (GUI) for centralized control of numerous remotemachines
� Individual deployment resolutions for eachmanaged host
� Job automation
� Machine comparisons and cloning
� Patchmanagement
� Script repository
� Multiple host execution of pre-installation actions and post-installation actions
� Simultaneous support formultiple Solaris versions and Linux distributions and hardware
� Software inventory backups for rollback and disaster-recovery
� Software provisioning and file installation formultiple hosts
� Support for private and third-party components

Applications
The SunUpdate Connection – Enterprise solution is scalable, equally applicable to standalone
servers, clusters, andmainframes. This flexibility is a result of the architecture: a collection of
separate applications that interact to provide a synergistic environment for Linux and Solaris
optimization.

Features
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The SunUpdate Connection – Enterprise product includes the following applications:

� SystemDependency Server (SDS).Acts as your local proxy to the universal server at Sun.
The SDS includes the following:
� Server application. Pulls certified updates from the universal server and pushes local

packages and scripts to the local knowledge base.
� Dependencymanager (DM).Manages communications between applications, and

performs job queuing and data storage.
� Knowledge base.Caches both certified and generated deployment rules, as well as certified

and local components.
� Local expansion technology.Generates rules for local components.

� Agent. Is installed on eachmanaged host. The agent runs the dependency resolver (DR) to find
the best job solutions for the individual managed host.

� Console. Is the graphical user interface (GUI) fromwhich users initiate tasks for the agents on
themanaged hosts. You can also use a command-line interface (CLI) or application
programming interfaces (APIs) to create your own user interface.

Applications
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Getting Started

This chapter describes themain application window in the Console. This chapter also explains how
to access the user interfaces, how to start the SunUpdate Connection – Enterprise applications, and
how to start managing a host.

This chapter covers the following topics:

� “Overview of the Console User Interface” on page 23
� “Logging In and StartingApplications (TaskMap)” on page 35
� “ProvidingAuthentication Information (TaskMap)” on page 39
� “ManagingHosts (TaskMap)” on page 40

Overviewof theConsoleUser Interface
The following sections describe the following parts of the console user interface:

� “MainWindowControlArea” on page 23
� “MainWindow Inventory Panel” on page 31
� “MainWindow Jobs Panel” on page 33

MainWindowControlArea
The control area of themain window is divided into the following tool bars:

� “Hosts Tool Bar” on page 24
� “Components Tool Bar” on page 24
� “Actions Tool Bar” on page 27
� “Jobs Tool Bar” on page 28
� “Tools Tool Bar” on page 30

You can customize which tool bars appear in the control area. Right-click anywhere in a tool bar or
on themenu bar to select or deselect tool bar names.
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Hosts Tool Bar
Use the buttons of the Hosts tool to perform operations onmanaged hosts or groups.

TABLE 2–1HostsButtons

Icon Button Description Enabled

AddGroup Create a new user-defined group of
managed hosts.

Always

AddHost Predefine amanaged host. Start the console with the
manual_host_create

command.

Edit Host/Group Modify the properties of the selected
managed host or group.

Host or group selected

Delete Host/Group Delete the selected host or group. Host or group selected

Save Inventory Save a record of the installed
components of the selected host or
group with a name that you choose.

Host or group selected

Compare Inventories Compare current or saved
inventories. You can either compare
two different hosts or different
inventories of a single host.

Always

Profile Compliance Check Check that the selected host is
currently compliant with its
associated profile.

Host selected

Components Tool Bar
Use the buttons of the Components tool bar tomanipulate the Components list, mark selected
components for jobs, andmanage local components.

Overview of the Console User Interface
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TABLE 2–2ComponentsButtons

Icon Button Description Enabled

Distribution
Architecture

Drop-downmenu List of activated distributions. Select a
distribution to show its components in the
Components list.

Always

Find Search for components. Always

Details View detailed information about the selected
component.

Component selected

Show Installed In the Components list, show only the
components that are installed on the selected
host or group.All hosts are shown if none are
selected.

Always

Required Add the selected component to theActions
list andmark it as required, whichmeans
that it should be installed.

Component selected

NotAllowed Add the selected component to theActions
list andmark it as not allowed, whichmeans
that it should be uninstalled.

Component selected

Overview of the Console User Interface
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TABLE 2–2Components Buttons (Continued)
Icon Button Description Enabled

Upgrade Add the selected component to theActions
list andmark it as upgrade, whichmeans that
it should be upgraded to a later version, if
possible.

Component selected

Add Category Add a category to the Local Components list Local category selected

Add Local Add a local component to the Local
Components list, which is a private software
package or your own file.

Local category selected

Upload Local Upload software or file to an empty listing.
Or, replace an upload with one of the same
name.

Package selected

Edit Local Modify the properties of the selected item
from the Local Components list.

Component selected

Move Local
Component

Move the selected item to another category
in the Local Components list.

Component selected

Overview of the Console User Interface
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TABLE 2–2Components Buttons (Continued)
Icon Button Description Enabled

OpenHost File Open a file from a remotemanaged host for
viewing and editing.

Host and local file selected

Open Knowledge
Base File

Open a file from the knowledge base server
for viewing and editing.

Host and local file selected

Delete Local Delete the selected item from the Local
Components list.

Component selected

Actions Tool Bar
Use the buttons of theActions tool bar tomanage theActions list of the Inventory panel.Actions
buttons offer advanced features both for inventory-based jobs and for complex jobs.

TABLE 2–3ActionsButtons

Icon Button Description Enabled

Save a Profile Save theActions list as a reusable profile. Actions are in theActions
list

Multi
Distributions

Expand theActions list to include actions on
components of other active distributions.

Actions are in theActions
list

Run on Selected
Hosts

Execute actions ofActions list on selected
hosts.

Host or group selected and
there are actions

Overview of the Console User Interface
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TABLE 2–3ActionsButtons (Continued)
Icon Button Description Enabled

Delete Selected
Action

Delete selected action fromActions list. Action selected

Jobs Tool Bar
Use the buttons of the Jobs tool bar tomanage jobs.Most buttons are for complex jobs, while some
are also for inventory-based jobs.

TABLE 2–4 JobsButtons

Icon Button Description Enabled

New Job Create a new complex job. Always

Copy Job Copy the job with its profile based on the original
job.

Job selected

Stop Job Stop the selected job. Job in progress
selected

Reschedule Job Modify the schedule of a complex job. You can
only reschedule a job if the job had a schedule
when it was first created.

Job with schedule
selected

Rerun Job Rerun the selected job. Completed job
selected

Delete Job Delete the job from the Jobs list. Job selected

Overview of the Console User Interface
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TABLE 2–4 Jobs Buttons (Continued)
Icon Button Description Enabled

Job Summary Report View the summary information of a selected job. Job selected

ConfirmTask
Actions

Confirm or deny the actions of a task. Task with questions
selected

Copy Profile Copy the profile of a task and save it with a new
name.

Task selected

Edit Scheduled
Profile

Modify the profile of a task. You can onlymodify a
profile if it is yours and is scheduled to be used in a
future job.

Task with such a
profile selected

Copy Policy Copy the policy of a task and save it with a new
name.

Task selected

Edit Scheduled
Policy

Modify the policy of a task. You can onlymodify a
policy if it is yours and is scheduled to be used in a
future job.

Task with such a
policy selected

Overview of the Console User Interface
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TABLE 2–4 Jobs Buttons (Continued)
Icon Button Description Enabled

Show Progress Display the progress of a host running a job. Host in the Jobs
panel is selected

Show Log Display the log of actions taken on a host for a job. Host in the Jobs
panel is selected

Filter Display only job listings that meet the specified
criteria.

Always

Refresh Refresh the job status information. This list is
refreshed periodically.

Always

Tools Tool Bar
Use the buttons of the Tools tool bar tomanage user accounts, profiles, polices, reports, and Sun
Update Connection – Enterprise preferences.

TABLE 2–5ToolsButtons

Icon Button Description Enabled

Users Access the user account list and features. Always

Profiles Access the profile list and features. Always

Policies Access the policy list and features. Always

Overview of the Console User Interface
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TABLE 2–5Tools Buttons (Continued)
Icon Button Description Enabled

Reports Access the report list and features. Always

Preferences View and edit the behavior parameters of the console, the
agents, or the dependencymanager applications.

Always

MainWindow Inventory Panel
From the Inventory panel, you can see hosts and groups, components of the knowledge base for the
selected distribution, components installed on selected hosts and groups, and component-action
settings.

If you do not see the Inventory panel on themain window, choose Inventory from the Viewmenu.

FIGURE 2–1MainWindow– Inventory Panel

Overview of the Console User Interface
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Hosts List
TheHosts frame shows information about hosts and groups. Right-click to open theHosts menu in a
pop-up window.

This frame includes the following fields:

� Hosts –Group names, with number of hosts in group, host names, and the status icon of the host
� Distro –Distribution installed on themanaged host
� Arch –Hardware architecture of themanaged host
� IP Address – IP address of themanaged host
� Register Time –Date and time at which the agent was registered with the dependencymanager
� Last Inventory update –Date and time that the host inventory was last updated to the console
� FindHost – Search feature for host names

TABLE 2–6Hosts List Status Icons

Icons Description

Default group –All Hosts group and distribution groups

User-defined group

Managed host

Disconnected host. The agent is not reaching the dependencymanager

Unrecognized group

Unrecognized host. Errors with themachine or with the agent

Components List
The Components frame shows hardware drivers for distributions, local components, and software
packages of the selected distribution. Right-click to open the Components menu in a pop-up
window.

Overview of the Console User Interface
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Actions List
TheActions frame shows actions that you set on specific components. Right-click to open the
Actionsmenu in a pop-up window.

This frame includes the following fields:

� Action –One of these values: Required, Not Allowed, or Upgrade.
� Component –Any item from the Components list of any active distribution
� Arch –Hardware architecture of a component
� Distro –Distribution of a component

MainWindow JobsPanel
The Jobs panel shows the status of jobs, both complex jobs and inventory-based jobs. Select a job to
view its tasks and the hosts that are running the task.

If the Jobs panel does not appear on themain window, choose Jobs from the Viewmenu.

FIGURE 2–2MainWindow– Jobs Panel

Jobs List
The Jobs panel shows completed, active, and scheduled jobs. Job information includes the following:

� Job name
� Name of the user who created the job

Overview of the Console User Interface
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� Date and time at which the job was received by the dependencymanager
� Mode and status icons

Right-click the Jobs list to open the Jobsmenu in a pop-up window.

TABLE 2–7 Jobs ListMode Icons

Icons Description

Perform an action (deploy) on amanaged host.

Simulate the action, but do not actually do anything on themanaged hosts.

TABLE 2–8 Jobs Panel Status Icons

Icons Description

At least onemanaged host is waiting to receive the job or is in process

All selectedmanaged hosts have successfully completed the job

At least onemanaged host is disconnected from the dependencymanager

At least onemanaged host failed to complete the job

The job is scheduled to run on a recurring basis, or it is a job template without a schedule

The job is scheduled for single future run

The job is paused until you confirm the actions for one of the tasks

Overview of the Console User Interface
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Tasks List
The Tasks panel shows the job tasks. Right-click to open the Tasks submenu of the Jobsmenu in a
pop-up window.

� Task status
� Task name
� Name of the profile associated with the task
� Name of the policy associated with the task

Hosts in Jobs List
TheHosts in Jobs panel lists selected hosts receiving the task selected in the Tasks list. Right-click to
open theHosts submenu of the Jobsmenu in a pop-up window.

� Host status in the job
� Host name

Logging In andStartingApplications (TaskMap)
The following table identifies the tasks that youmight performwhen you need to log in to the
console and to start or restart SunUpdate Connection – Enterprise applications.

Task Description For Instructions

Log in to the console for the first
time.

Youmust log in as the admin user the
first time you log in to the SunUpdate
Connection – Enterprise Console.As
the admin user, you can create other
user accounts to be used formanaging
systems.

“To Log In to the Console for the
First Time” on page 36

Log in to the console. You do not need to be superuser to run
the console, but youmust be a user
with full permissions or use the admin
user’s password to log in.

“To Log In to the Console”
on page 37

Access the command-line
interface (CLI).

You do not need to be superuser to use
the CLI, but youmust be a user with
full permissions or use the admin user’s
password to log in.

“ToAccess the uce_cliCLI”
on page 38

Logging In and StartingApplications (TaskMap)
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Task Description For Instructions

(Optional) Restart the system
dependency server.

The system dependency server starts
automatically after installation. If you
need to restart it, youmust restart both
the server application, which includes
the knowledge base, and the
dependencymanager application.

“To Restart the System
Dependency Server” on page 38

(Optional) Restart the agent on a
managed host.

The agent starts automatically after
installation. The agent softwaremust
be installed on eachmachine you want
tomanage.

“To Restart theAgent” on page 38

� To Log In to theConsole for the First Time
SunUpdate Connection – Enterprise provides a default user, the admin user. Log in as admin the first
time you access the console. Youmust be the admin user to create other user accounts.

You can also use the uce_cli command. Formore information, see Chapter 14.

Start the console.

$ uce_console

Adialog box appears.

Click Exit to prevent the console from starting.

Wait for your locally active distributions to be updated from the universal server.

The Login window appears.

Log in as the adminuser.

Specify the password.

The default password is 123.

ClickOK.

After the first login of any user, including the admin user, the Change Password window appears.
Change default passwords immediately.

Type the newpassword, verify it, and clickOK.

The password is changed.

The console opens, and shows themain window.
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� To Log In to theConsole
You do not need to be superuser to access the console.

You can also use the uce_cli command. Formore information, see Chapter 14.

Start the console.

$ uce_console

The Login window appears.

Type your user name in theUserNamefield.

Type your password in the Password field.

ClickOK.

The console initializes and themain window appears.

If you do not want to log in, click Cancel.
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� ToAccess the uce_cliCLI
You do not need to be superuser to use the CLI, but youmust be a user with full permissions or use
the admin user password.

Type a CLI command.
$ uce_cli -command -param value [...] [-flag][...] -u username -p password

Formore information about the uce_cli command, see Chapter 14.

� ToRestart the SystemDependency Server
Log in to the systemdependency server as superuser.

Restart the server.
# /etc/init.d/uce_server restart

Restart theDM:
# /etc/init.d/uce_engine restart

(Optional) If you have a proxy SDS, restart the proxy.

a. Log in to the systemdependency server proxy systemas superuser.

b. Restart themain server.

c. Restart the proxy:
# /etc/init.d/uce_proxy restart

Restart theDMof both the server and the proxy server.

� ToRestart theAgent
Log in to themanagedhost as superuser.

Restart the agent.
# /etc/init.d/uce_agent restart

◗
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ProvidingAuthentication Information (TaskMap)
The following table identifies the tasks that youmight performwhen you need to provide
authentication information to the console application.

Task Description For Instructions

View authentication information. Some of your Linux and Solaris
managed hosts might need to
download content from an external
vendor source. These vendor sources
require that you specify a user name
and a password to access and
download content.

“To ViewAuthentication
Information” on page 39

Edit authentication information. Youmust be the admin user to edit the
authentication information for an
external vendor source.

The user name and password you
specify are not verified with the
external vendor source. So, ensure that
you supply the correct information or
jobs that attempt to access an external
vendor source will fail.

“To EditAuthentication
Information” on page 40

� ToViewAuthentication Information
Some of your Linux and Solaris managed hosts might need to download content from an external
vendor source. These vendor sources require that you specify a user name and a password to access
and download content.

ChooseAuthentication from the Toolsmenu.

TheAuthentication window opens.

Note –TheAuthentication windowmight openwhen you start the console. This window opens when
the authentication information for a vendor source is incomplete.

View the authentication information for each vendor source that is appropriate for your
environment.

Acomplete vendor source entry includes the following information:

� Name of the vendor source
� User name you use to access content
� Password shown as asterisks
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� ToEditAuthentication Information
Youmust be the admin user to edit the authentication information for an external vendor source.

Note –The user name and password you specify are not verified with the external vendor source. So,
ensure that you supply the correct information or jobs that attempt to access the external vendor
source will fail.

ChooseAuthentication from the Toolsmenu.

TheAuthentication window opens.

Select the vendor source that needs its information updated, and click Edit.

TheAuthentication Editor window opens.

Type the user nameassociatedwith the selected vendor source in theUsernamefield.

Type the password in the Password field.

Type the password again in the Verify Password field.

ClickOK.

TheAuthentication Editor window closes.

The updated authentication information appears in theAuthentication window.

ManagingHosts (TaskMap)
The following table identifies the tasks that youmight perform to get started with basic
host-management features.

Task Description For Instructions

Viewmanaged hosts. The console shows a hierarchical view
of the inventory of each of the
managed hosts. You can also customize
your view of the information.

“To ViewManagedHosts”
on page 41
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Task Description For Instructions

Save the inventory of amanaged
host.

An inventory is saved for each
managed host prior to running a job.
By creating an inventory, you can roll
back to a previous inventory if you
have problems with the current
inventory.

You can also use this procedure to save
an inventorymanually.When you
assign it a name, the name should be
used to help you identify a particular
configuration.

“To Save the Inventory of a Host”
on page 42

Change the inventory of a
managed host.

You can create and execute a simple job
on amanaged host. This procedure can
be used as a starting point for running
simple jobs.

“To Change the Inventory of a
Host” on page 42

� ToViewManagedHosts
SunUpdate Connection – Enterprise provides a hierarchical view of the inventory of all managed
hosts.An inventory is a list of components that are installed on amanaged host.

This view includes a brief description of the information shown for each host. You can also perform a
procedure tomanipulate the views.

Choose Inventory from theViewmenu to open the Inventory panel.

In theHosts list, view the data of themanagedhostswhose agents have registeredwith the system
dependency server.

Expand theAll Hosts group and a distribution subgroup to view the list of managed hosts.

Information about eachmanaged host appears in the following columns:

� Distro – Linux distribution version or Solaris release that is installed on themanaged host
� Arch –Hardware architecture of themanaged host
� IP Address – IP address of themanaged host
� Register Time –Date and time at which the agent registered with the dependencymanager
� Last Inventory update –Date and time that the host inventory was last updated to the console

Select amanagedhost from the list to view information about it.

When no host is selected, you can browse the Components list to see what is available in the
knowledge base for installation. This information pertains only to the distribution selected in the
drop-down list in the tool bar.
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� To see the Components list of a different distribution, change the selection of the tool bar
drop-down list.

� To see which of the knowledge base components are installed on a specific host or hosts, select
one ormore hosts or groups from theHosts list. The components installed on the selected hosts
aremarked as Installed on the Components list.

� To see only the installed inventory of hosts, select the hosts. Then, choose Show Installed from
the Components menu.
The Components list displays only the inventory of the selected hosts.

� ToSave the Inventory of aHost
SunUpdate Connection – Enterprise provides a rollback feature. You can restore amanaged host to a
previous inventory, either full or filtered, as needed. The software automatically saves host
inventories before executing a job to ensure that rollback is possible. You can also save inventories
manually and give themmeaningful names. Using such namesmakes it easier for you to choose the
particular configuration to use.

From theHosts list, right-click a host or a group and choose Save Inventory.

The Save Inventory window opens.

(Optional) Specify the nameof the saved inventory.

The default file name uses this format name_yymmdd_hhmmss.

name is either the name of amanaged host or a group. yymmdd represents the date as a two-digit
year, two-digit month, and two-digit day. hhmmss represents the time as a two-digit hour, two-digit
minute, and two-digit second.

ClickOK.

The host inventory is saved and the Save Inventory window closes.

If you selected a group, an inventory is saved for eachmanaged host in the group.

Viewa list of saved inventories in the Inventory Comparisonwindow.

Right-click amanaged host or group in the Hosts list, and then choose Compare Inventories.

Expandone of the Inventory drop-down lists to see the list of saved inventories for the selected host
or group.

� ToChange the Inventory of aHost
This procedure creates and executes a simple job. Besides offering a starting point, you should run a
task-driven job the first time you use SunUpdate Connection – Enterprise to deploy software.
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From theViewmenu, choose Inventory.

From thedrop-down list on the tool bar, select a distribution for a particular architecture.

The Components list changes to display components of the selected distribution.

From theHosts list, select a host.

From the Components list, right-click a component, and then select Required.

The action-component setting appears in theActions list.

From the tool bar, click Run Job.

The Run Job window opens.

Specify a job name, a description, and select Deploy.

ClickOK.

The job starts and the Run Job window closes.
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UserAccounts

This chapter explains how to access, create, edit, and delete user accounts.

Most of the procedures described in this chapter are applicable only to users with admin user
permissions. Users of other permissions can change their passwords, email addresses, and
notification events.

The following topics are covered:

� “Managing UserAccounts (TaskMap)” on page 45
� “ManagingYour OwnAccount (TaskMap)” on page 55

ManagingUserAccounts (TaskMap)
The admin user can create, edit, and delete user accounts. You cannot create another user account
with the admin user name.

User names are case insensitive.All user namesmust be unique, so you cannot create a new account
with the Admin user name.

Users can be granted full permissions to create deployment jobs over all managed hosts.

You can also restrict user permissions.
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User restrictions include the following:

� Simulations –Restrict a user to create jobs that only simulate deployment onmanaged hosts.
This restriction would be useful for a teammanager, who could use the simulation results in time
estimates and prioritization of administration tasks; or use the restriction for new teammembers
to safely become familiar with the environment.

� PermittedGroups –Restrict a user to have permissions only on specified groups. If you have a
large IT team, this restriction could help youmanage and audit the work of teammembers.

You can restrict a user to either simulations or to permitted groups, or to both. User accounts that
are restricted, either for jobs or for groups, are also automatically restricted with Local
components. Restricted users may select Local components for their jobs, but they do not have
permission to add, edit, or delete components to the Local inventory.

The following table identifies the tasks that youmight performwhen you want tomanage users as
the admin user.

Task Description For Instructions

Create a user account that has full
permissions.

An account with these permissions can
run deployments jobs on any hosts.

“To Create a Full-Permission
UserAccount” on page 47

Create a user account that can
only run simulation jobs.

Use this procedure to create a user that
can only run simulation jobs. If this
user needs to be able to run
deployment jobs, the user needs full
permissions.

“To Create a UserAccount
Restricted to Simulations Only”
on page 49

Create a user account that can
run jobs only on selected groups.

You create a user account that is only
permitted to run jobs on particular
groups. If this user needs to be able to
run jobs on all groups, the user needs
full permissions.

“To Create a UserAccount with
Group Restrictions” on page 51

Create a copy of a user account. Copy a user account to create a new
one with similar preferences.

“To Copy a UserAccount”
on page 52

Edit a user account. In this procedure you edit user
accounts. Use it to change the name,
password, notifications, email, or list of
permitted groups.

“To Edit a UserAccount”
on page 53

Delete a user account. You can use this procedure to delete a
user account that you no longer need.

“ToDelete a UserAccount”
on page 54

Delete more than one user
account at the same time.

You can use this procedure to delete
more than one user account at a time.

“ToDeleteMultiple User
Accounts” on page 54

ManagingUserAccounts (TaskMap)
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� ToCreate a Full-PermissionUserAccount
In this procedure you create new user accounts with full permissions over all jobs, hosts, groups, and
components (including Local componentmanagement).

Log in as the adminuser.

Do one of the following:

� From the tool bar, click the Users button.
� From the Tools menu, choose Users.

The Users window opens.

Dooneof the following:

� From the tool bar of the Users window, click the New button.
� Right-click in a blank space in the Users window and choose New.

TheUser Editor window opens.
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Type a name for the user account.

Type a password for the user and then verify it.

Type a description of the account.

Check theGrant Full Permissions checkbox.

In theNotifications section, type an email address towhich the user of this accountwill receive Sun
Update Connection – Enterprise notification emails.

Check theNotifywhenoptions that are relevant for this user.

ClickOK.

TheUser Editor window closes. The new user name, with full permissions, is added to the Users
window.
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� ToCreate aUserAccount Restricted to Simulations
Only
In this procedure you create new user accounts that are restricted for simulations only. These users
cannot touch hosts. Restricted users cannotmanage Local inventory, though they can select Local
components for to include in simulation jobs.

Log in as the adminuser.

Do one of the following:

� From the tool bar, click the Users button.
� From the Tools menu, choose Users.

The Users window opens.

Dooneof the following:

� From the tool bar of the Users window, click the New button.
� Right-click in a blank space in the Users window and choose New.

TheUser Editor window opens.
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Type a name for the user account.

Type a password for the user and then verify it.

Type a description of the account.

Uncheck theGrant Full Permissions checkbox.

The Limited Permissions options are enabled.

Check the Limit user to simulate jobs checkbox.

Click theGroups button to the right of the PermittedGroups field.

The Select Hosts window opens.

Select the groups overwhich this user is to have permissions and click theAddbutton.

Youmust select permitted groups for restricted users, which are listed in the right-hand list of the
Groups window. Groups that you do not add are invisible to this user

ClickOK to close the Select Hostswindowand return to theUser Editor.
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In theNotifications section, type the email address towhich to sendnotification emails.

Check theNotifywhenoptions that are relevant for this user.

ClickOK.

TheUser Editor window closes and the new user name appears in the Users window.

� ToCreate aUserAccountwithGroupRestrictions
In this procedure you create new user accounts withmanagement permissions over permitted
groups only. Restricted users cannotmanage Local inventory, though they can use Local components
in jobs.

Log in as the adminuser.

Do one of the following:

� From the tool bar, click the Users button.
� From the Tools menu, choose Users.

The Users window opens.

Dooneof the following:

� From the tool bar of the Users window, click the New button.
� Right-click in a blank space in the Users window and choose New.

TheUser Editor window opens.

Type a name for the user account.

Type a password for the user and then verify it.

Type a description of the account.

Uncheck theGrant Full Permissions checkbox.

The Limited Permissions options are enabled.

Decide if youwant this user to be able to execute deployment jobs.

� Check Limit user to simulate jobs to restrict this user to simulations.
� Uncheck this option to allow this user to execute deployments on the permitted groups.

Click theGroups button to the right of the PermittedGroups field.

The Select Hosts window opens.
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Select the groups overwhich this user is to have permissions and click theAddbutton.

Groups that you do not add will be invisible to this user.

ClickOK.

The Select Hosts window closes. The permitted groups are listed in the User Editor window, in the
Permitted Groups field.

In theNotifications section, type an email address towhich the user of this accountwill receive Sun
Update Connection – Enterprise notification emails.

Check theNotifywhenoptions that are relevant for this user.

ClickOK.

TheUser Editor window closes and the new user name appears in the Users window.

� ToCopyaUserAccount
In this procedure you create new user accounts based on existing ones. Use it to createmultiple user
accounts with similar permissions.

Log in as the adminuser.

Do one of the following:

� From the tool bar, click the Users button.
� From the Tools menu, choose Users.

The Users window opens.

Select a user nameand thendoone of the following:

� From the tool bar of the Users window, click the Copy button.
� Right-click the selected user name and choose Copy.

The User Editor window opens with the permissions and notification options of the selected user
name.

Type a newuser nameandpassword, and verify the newpassword.

The permissions options are not available for editing.

Check the email address andnotification options, and change these as needed.

ClickOK.

TheUser Editor window closes and the new user name is added to the Users window.
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� ToEdit aUserAccount
In this procedure you edit user accounts. Use it to change the name, password, notifications, email,
or list of permitted groups.

You cannot edit the following options of user accounts:

� You cannot change the selection of Full Permissions.
� You cannot change the selection of Restrict user to simulate jobs.
� You cannot edit the Permitted Groups list.

Log in as the adminuser.

Do one of the following:

� From the tool bar, click the Users button.
� From the Tools menu, choose Users.

The Users window opens.

Select a user nameand thendoone of the following:

� From the tool bar of the Users window, click the Edit button.
� Right-click the selected user name and choose Edit.

The User Editor window opens, with the properties of the selected user name displayed.

You can change any of the account details:

� User Name
� Password (andVerify Password)
� Description

You can change your email address and theNotifyWhenoptions (events forwhich youwant Sun
Update Connection – Enterprise to send you an email):

� Job paused for confirmation
� Job finished
� Job failed
� Host disconnected

ClickOK.

TheUser Editor window closes.

If you changed the user name, the new name appears in the Users window, in place of the old name.
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� ToDelete aUserAccount
In this procedure you delete user accounts.

You cannot delete user accounts in the following circumstances:

� The user is logged in.
� The user has an active job.
� The user has scheduled jobs.

Log in as the adminuser.

Do one of the following:

� From the tool bar, click the Users button.
� From the Tools menu, choose Users.

The Users window opens.

Select the user name that youwant to delete.

Do one of the following:

� From the tool bar of the Users window, click the Delete button.
� Right-click the selected user name and choose Delete.

In the confirmation dialog box that opens, clickDelete.

The user name is removed from the list.

� ToDeleteMultipleUserAccounts
Log in as the adminuser.

Do one of the following:

� From the tool bar, click the Users button.
� From the Tools menu, choose Users.

The Users window opens.

Select the user names youwant to deletewith the Shift or Control keys, or use themouse to select an
area in the list, and then click theDelete button in the tool bar.

In the dialog box that opens, choose one of the following.

� Delete All –Delete all selected user accounts at once.
� Delete –Confirm the delete command for each account separately.
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ManagingYourOwnAccount (TaskMap)
When you log into the console with a user name other than admin, you canmanage your own user
account. You do not have access to other user account features.

This section includes the procedure to change your password.After logging in, you can open the
User Editor of your own account and change the password.

The first time that any user logs into the console, SunUpdate Connection – Enterprise automatically
opens the Change Password window, enabling you to give your account a password that is private
even from the admin user who created the account.

Type and verify a new password for this user account and then click OK. The change takes effect
immediately.

Note – If the Change Passwordwindow does not open automatically on the first login, the default
behavior of SunUpdate Connection – Enterprise has been changed. See “DMPreferences – Clients”
on page 303.

The following table identifies the tasks that youmight performwhen you want tomanage your own
account.

Task Description For Instructions

Change your password. You do not have to be the admin user to
change the password of your own
account.

“To ChangeYour PasswordOn
Demand” on page 55

Change your email address. Use this procedure to change the email
address to which notification emails
are sent.

“To ChangeYour EmailAddress”
on page 56

Relogin as a different user. You can log in as another user when
you are logged in.

“To Relogin with a Different User
Name” on page 57

� ToChangeYour PasswordOnDemand
In this procedure you change the password of your user account at any time.

Log in as any user.

Do one of the following:

� From the tool bar, click the Users button.
� From the Tools menu, choose Users.

The Users window opens.
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Select your currently logged in user name from the list.

Do one of the following:

� From the tool bar of the Users window, click the Edit button.
� Right-click the selected user name and choose Edit.

The User Editor window opens.

Change your password and then verify it.

ClickOK.

The change takes effect immediately.

� ToChangeYour EmailAddress
You can receive emails from SunUpdate Connection – Enterprise when specific events occur. In this
procedure you change the email address to which you receive event notifications.

Log in as any user.

Do one of the following:

� From the tool bar, click the Users button.
� From the Tools menu, choose Users.

The Users window opens.

Select your currently logged in user name from the list.

Do one of the following:

� From the tool bar of the Users window, click the Edit button.
� Right-click the selected user name and choose Edit.

The User Editor window opens.

Change your email address.

You can also change the selections of events for which you will receive notification; change the
checkbox selections under NotifyWhen:

� Job paused for confirmation
� Job finished
� Job failed
� Host disconnected
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ClickOK.

The change takes effect immediately.

� ToReloginwith aDifferentUserName
In this procedure you log out of the console and automatically re-login, without having to type the
shell command line to start the console, with a different user name and password.

Note –This feature is not available in the console onMicrosoftWindows.

Log in as any user.

From the Filemenu, choose Login as different user.

In the confirmation dialog box that opens, click Relogin.

The console goes down and then closes. The startup windows open; then the Login window opens.

Type the alternate user nameandpassword, and then clickOK.
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Hosts andGroups

This chapter explains how to create, edit, and delete user-defined groups. Creating groups allows you
tomanage hosts in a consistent and efficient manner. This chapter also explains the purpose of the
default groups; and it explains how to test single hosts for compliance with your company
requirements.

The procedures of this section are relevant to the admin user and to users with full permissions. Users
with restricted permissions do not have access to groupmanagement features.

The following topics are covered:

� “Terms” on page 59
� “Groups” on page 60
� “Managing Groups (TaskMap)” on page 61
� “ManagingHosts (TaskMap)” on page 67
� “Profile Compliance” on page 73

Terms
This chapter uses the following terms:

Group Logical set of managed hosts.

ManagedHost Linux or Solaris environment that is managed by SunUpdate
Connection – Enterprise through an agent.

Default Group Group created by SunUpdate Connection – Enterprise according
to local configurations. Includes theAll Hosts group and
distribution groups.

Distribution Group Default group containing all managed hosts with the same
distribution and hardware platform.

Profile Machine type definition.Associate a group ormanaged host with
a profile to run compliance checks, which test whether a group or
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host complies with all requirements of the associated profile.

Groups
Managed hosts are assigned to and identified with groups. If you send a job to a group, all hosts in the
group receive the job simultaneously. SunUpdate Connection – Enterprise has two types of groups:
user-defined groups and default groups.

User-DefinedGroups
Create groups tomake a large SunUpdate Connection – Enterprise systemmore efficient. Groups
enable you to simultaneously and consistently control managed hosts of similar functions and to
prevent inappropriate configurations.

AUser-defined group can hold asmany hosts as you choose. Such a group can be comprised ofmixed
or homogeneous operating systems and can be nested within other groups.

Default Groups
Adefault group is system-defined collection of hosts and cannot be deleted or edited.

� All Hosts group.Contains all managed hosts. Everymachine with an installed agent
automatically belongs to this group.

� Distribution groups.Contains all hosts of a particular distribution and hardware platform.
When anAgent registers with the SDS, it is identified by its operating system (specific Linux or
Solaris distribution) and assigned to the group of agents with the same distribution and hardware
platform.

For example, you install the agent on five RedHat 8.0 Intel 32-bit machines. The agents rise. In the
console you see a group called RH8_IA32 Hosts, and the five machines are listed under it. You install
the agent on another fivemachines with SLES 9 on Power 64-bit.When the agents rise, you see a new
group, SLES9_PPC64 Hosts, and it contains the five machines.

UpdatedGroups in Jobs
If you set a job to start at a single future date, any change in the host list of the group is reflected in the
list of hosts that run the job.

For example, you select a group of five hosts to receive a job scheduled for the first of the next month.
Before the job runs, you add two hosts to the group.When the first of themonth comes, the job is
sent to the seven hosts in the selected group.

Groups
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If you set a job to a recurring schedule, you can add hosts to the group, and the next run of the job will
be sent to the new host list. You cannot remove hosts from the group.

Say you reschedule the job of the previous example to be a recurring job for the first of eachmonth.
Before the next month, you want to remove four hosts from the group.When you attempt to do so,
you receive an errormessage. Youmust delete the recurring job before you can edit the group.

Hosts andGroups in theHosts List
To view theHosts list, make sure the Inventory panel is open in themain window. From the View
menu, choose Inventory.

TheHosts list displays default and user-defined groups, and their hosts. The distribution groups
appear under theAll Hosts group and contain only those distributions that are represented by
managed hosts whose agents have risen and automatically registered their hosts with the system
dependency server. Every group has a number next to it, which indicates howmany hosts are in that
group.

See “Hosts List” on page 32 for explanations of the Hosts List columns and status icons.

ManagingGroups (TaskMap)
The following table identifies the tasks that youmight performwhen you want tomanage groups.

Task Description For Instructions

Create a group. Youmight want to create a group of
managed hosts so that you can
managed them by function rather than
by operating system and platform
architecture type. For example, you can
create a group of web servers and
manage them as a group rather than
individually.

“To Create a Group” on page 62

Create a nested group. Youmight want to create a nested
group ofmanaged hosts to clearly
deliniate differences between different
kinds of systems that perform similar
functions. Or, youmight use nested
group to show how different hosts are
related to each other.

“To Create a Nested Group”
on page 63
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Task Description For Instructions

Edit a group. When you edit a group, you can
change its name or change the list of
hosts that is assigned to it.

“To Edit a Group” on page 65

Delete a group. You can delete a group that you no
longer want.

“ToDelete a Group” on page 66

Delete more than one group at a
time.

You can use this procedure to delete
more than one group at a time.

“ToDeleteMultiple Groups”
on page 66

� ToCreate aGroup
In this procedure, you create groups of managed hosts. Your groups can be on the same level as the
default groups, or you can create a hierarchy of groups. The first procedure explains how to create a
group in general. Then there is a procedure for creating nested groups.

Login as a userwith full permissions or as the adminuser.

Do one of the following:

� From the tool bar, click theAddGroup button.
� In the Host list, right-click and chooseAddGroup.
� From theHosts menu, chooseAddGroup.

TheNewGroup window opens.

Type a name for the group.
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If youwant all hosts in this group to comply to a profile, select one from the Profile drop-down list.

This does not lock the hosts to the profile; you can still run any job on the group. It does provide
information, letting you knowwhenever one of the hosts in the group does not comply with the
profile requirements.

Type anoptional, free-text description of the group.

Select the hosts that youwant to put into this group and then click theAddbutton.

The SelectedHosts list shows the hosts that are to be assigned to this group.

ClickOK.

TheNewGroup window closes. The new group appears in the Hosts list of themain window.

� ToCreate aNestedGroup
Dooneof the following:

� In the Hosts list, select an existing group. The new group will be a nested group of the selected
group. Right-click the selected group and chooseAddGroup.

� Do not select a group yet. You can choose the parent group when you create the new group. Click
theAddGroup button.

TheNewGroup window opens.

Check the Parent Groupfield:

� If you selected a group before opening the NewGroup window, notice that the name of the
selected group appears in the Parent Group field.

� If you want to assign the new group to a different parent group, including if you did not select a
group beforehand, click the Group Select button.

The Group Selection window opens.

Select one group to be the parent of the newgroup and then clickOK.

Finish creating the newgroup as in the previous procedure.

Creating a Groupwith the CLI

TheAddGroup command in the CLI can create a top-level group. It has an optional parameter to
create a nested group. To add hosts to the created group, use theAddHost to Group command. See
“AddGroup (-ag) Command” on page 266 and “AddHost to Group (-ahg) Command” on page
266.
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#! /bin/bash

function login {

echo -n “Type your user name:”

read user

echo -n “Type your password:”

read password

}

function groupBasics {

echo -n “Type a name for the new group:”

read newGroup

echo -n “Should the new group be nested? (y | n):”

read pGyes

}

function createGroupWParent {

echo “Existing groups are:”

uce_cli -lg -u “$user” -p “$password”

echo “Copy the name of the group to be the parent.”

echo -n “It cannot be a default group:”

read parentGroup

echo “Creating $newGroup under $parentGroup”

uce_cli -ag -g “$newGroup” -pG “$parentGroup” -u “$user” -p “$password”

}

function createGroupNoParent {

echo “Creating group without parent”

uce_cli -ag -g “$newGroup” -u “$user” -p “$password”

}

function addHost {

echo “Add a host to $newGroup...”

echo “Hosts are:”

uce_cli -lah -u “$user” -p “$password”

echo -n “Copy the host name that you want to add:”

read hostname

uce_cli -ahg -h “$hostname” -g “$newGroup” -u “$user” -p “$password”

}

login

groupBasics

if [ “$pGyes” = “y” ]; then

createGroupWParent

else

createGroupNoParent

fi

addHost
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� ToEdit aGroup
In this procedure you edit groups of managed hosts. Use this procedure to change the name of a
group, or the list of managed hosts assigned to it. If the group is scheduled for future jobs, the host list
of the job is updated for the added hosts.

You cannot edit a group in the following circumstances:

� You cannot edit a group that is currently in an active job.
� You cannot remove hosts from a group that is scheduled for a future job.

Login as a userwith full permissions or as the adminuser.

In theHosts list, select the group that youwant to edit.

Do one of the following:

� From the tool bar, click the Edit Group button.
� Right-click the selected group in the Hosts list and choose Edit.
� From theHosts menu, choose Edit.

The Group Properties window opens.

Change any of the following:

� Name
� Parent Group
� Profile
� Description
� Addmore hosts
� Remove hosts, if not in scheduled jobs

Editing a Groupwith the CLI

Agroup can be edited with the CLI command to rename a group. See “RenameGroup (-rg)
Command” on page 267.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “The list of existing groups is:”

uce_cli -lg -u “$user” -p “$password”

echo -n “Copy the full path and name of the group you want to rename:”

read origName
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echo -n “Type a name for the new group:”

read newName

uce_cli -rg -sG “$origName” -tG “$newName” -u “$user” -p “$password”

� ToDelete aGroup
In this procedure you delete user-defined groups. The hosts are not deleted, but nested groups are.
Though you cannot delete default distribution groups, if you uninstall the SunUpdate Connection –
EnterpriseAgent from the last managed host of a distribution group, that group is deleted
automatically.

You cannot delete groups in the following circumstances:

� The group is a default group:All Hosts or a distribution group.
� The group is in a currently active job.
� The group is selected for a scheduled job.

Login as a userwith full permissions or as the adminuser.

In theHosts list, select the group that youwant to delete.

Do one of the following:

� From the tool bar, click the Delete Group button.
� Right-click the selected group and choose Delete.
� From theHosts menu, choose Delete.

In the dialog box that opens, clickDelete again.
The group and its child groups are deleted.

� ToDeleteMultipleGroups
Login as a userwith full permissions or as the adminuser.

In theHosts list, hold Shift or Controlwhile selecting groups.

Do one of the following:

� From the tool bar, click the Delete Group button.
� Right-click the selection and choose Delete.
� From theHosts menu, choose Delete.

In the dialog box that opens, click one of the following:

� Delete All –Delete all selected groups at the same time.
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� Delete –Delete each selected group one at a time.

Deleting a Groupwith the CLI

TheDelete Group command in the CLI deletes a given user-defined group and its nested groups. It
does not delete hosts and cannot be used to delete default groups. See “Delete Group (-dg)
Command” on page 267.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “The list of existing groups is:”

uce_cli -lg -u “$user” -p “$password”

echo -n “Copy the full path and name of the group you want to delete:”

read delGroup

uce_cli -dg -g “$delGroup” -u “$user” -p “$password”

ManagingHosts (TaskMap)
Amanaged host is any computer or virtual machine:

� running a supported Linux distribution or Solaris on SPARC
� that has the SunUpdate Connection – EnterpriseAgent installed and
� is connected through TCP/IP to the system dependency server (SDS).

Amachine becomes an SunUpdate Connection – Enterprise managed host when the agent starts
up and registers its machine with the SDS.

Users with full permissions and the admin user can perform the procedures in this section.

The following table identifies the tasks that youmight performwhen you want tomanage hosts.

Task Description For Instructions

EnableAddHost creation in the
console.

TheAddHost commands on the
console are disabled by default. Use the
flag that permits you to add hosts
manually before starting or restarting
the console.

“To EnableAddHosts
Commands” on page 68

Example 4–3
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Task Description For Instructions

Create a host. Use this procedure tomanually add a
host to SunUpdate Connection –
Enterprise. Usually, SunUpdate
Connection – Enterprise recognizes
and automatically adds hosts when
their agents rise.

“ToAdd aHost” on page 69

Assign a host to one ormore
groups.

You assign amanaged host to
user-defined groups. This does the
same as adding hosts to groups, but
from the perspective of each host and
the groups it should belong to, rather
than adding hosts to a single group.

“ToAssign aHost to Groups”
on page 70

Edit amanaged host. View and edit the properties of a
managed host.

“To Edit aManagedHost”
on page 71

Delete amanaged host. You can delete amanaged host that you
no longer want.

“ToDelete aManagedHost from
SunUpdate Connection –
Enterprise” on page 72

Delete more than onemanaged
host at a time.

You can use this procedure to delete
more than onemanaged host at a time.

“ToDeleteMultipleManaged
Hosts from SunUpdate
Connection – Enterprise”
on page 72

� ToEnableAddHosts Commands
TheAddHost commands on the console are disabled by default. Turn on the flag that permits you to
add hosts manually before starting or restarting the console.

Copy the following line from /usr/local/uce/console/bin/uce.rc to .uce.rc and change its
value to true.

( all ) ( invisible.gui.__general.manual_host_create, false );

Start the consolewith the parameter and value.

� Linux: uce_console -manual_host_create true

� Windows: uce_console.exe -manual_host_create true
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� ToAddaHost
In this procedure, youmanually add a host to SunUpdate Connection – Enterprise.As SunUpdate
Connection – Enterprise will recognize and automatically add hosts when their agents rise, you will
not use this procedure in general. Use theAddHost feature to predefine hosts.

Login as a userwith full permissions or as the adminuser.

Do one of the following:

� From the tool bar, click theAddHost button.
� In the Hosts list, right-click and chooseAddHost.
� From theHosts menu, chooseAddHost.

The NewHost window opens.

In theHost Name text box, create an SunUpdate Connection – Enterprise name for the host.

In theUnique String text box, type the unique string of themachine.

From theDistro list, click one of the locally activated distributions.

From the Profile list, optionally click a user-definedprofile to attach to this host.

Type anoptional description of the host.

In theGroups list, select a user-definedgroup and click theAddbutton.

ClickOK.

TheNewHost window closes.

Adding aHostwith the CLI

TheAddHost to Group command allows you to predefine a host, before it has an installed agent. In
this command, the -D parameter is mandatory. See “AddHost to Group (-ahg) Command” on page
266.

#! /bin/bash

function login {

echo -n “Type your user name:”

read user

echo -n “Type your password:”

read password

}
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function addHost {

echo “Add a host”

echo “Existing hosts are:”

uce_cli -lah -u “$user” -p “$password”

echo -n “Create a new name, one not already used:”

read hostname

echo “Active distros are:”

uce_cli -ld -u “$user” -p “$password”

echo -n “What is the distribution of the host?”

read distro

uce_cli -ah -h “$hostname” -D “$distro” -u “$user” -p “$password”

}

login addHost

� ToAssign aHost toGroups
You assign amanaged host to user-defined groups. This does the same as adding hosts to groups, but
from the perspective of each host and the groups it should belong to, rather than adding hosts to a
single group.

Login as a userwith full permissions or as the adminuser.

In theHosts list, expand agroup and select a singlemanagedhost.

Do one of the following:

� From the tool bar, click the Edit Host button.
� Right-click themanaged host and choose Edit.
� From theHosts menu, choose Edit.

TheHost Properties window opens.

In theGroups list, select a group and click theAddbutton.

The host is added to the selected group. You can assign amanaged host tomultiple user-defined
groups of any hierarchy.

ClickOK.

TheHost Properties window closes.

Assigning aHost to a Groupwith the CLI

TheAddHost to Group command allows you to add a single host to a single group. See “AddHost to
Group (-ahg) Command” on page 266.

See Example 4–1 for an example script.
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� ToEdit aManagedHost
In this procedure you will view and edit properties of amanaged host.

You cannot edit managed hosts in the following circumstances:

� The host is currently in an active job.
� The host is selected for a scheduled job.
� The host belongs to a group that is currently in an active job.
� If the host belongs to a permitted group of a user with restricted permissions, which group is

selected for a scheduled job, you cannot remove a group from the Selected Groups list of the host.

Login as a userwith full permissions or as the adminuser.

In theHosts list, expand agroup and select a singlemanagedhost.

Do one of the following:

� From the tool bar, click the Edit Host button.
� Right-click themanaged host and choose Edit.
� From theHosts menu, choose Edit.

TheHost Properties window opens.

(Optional) Change theHost Name.

The name is for SunUpdate Connection – Enterprise display only and the name does not affect the
host. You cannot change the Unique String, IPAddress, or Distribution.

(Optional) Change the Profile of the host.

This step does not lock the host to the profile. You can still run any job on themanaged host. This
step does provide information, letting you knowwhenever the host does not comply with the profile
requirements.

(Optional) Change the free-text description.

(Optional) Addmore groups to the SelectedGroups list of this host.

(Optional) Removegroups from the SelectedGroups list, but only if the groups are not selected for
active or scheduled jobs.

ClickOK.

TheHost Properties window closes.
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� ToDelete aManagedHost fromSunUpdate
Connection – Enterprise
You cannot delete managed hosts in the following circumstances:

� The agent of the host is still running.
� The host is in a currently active job.
� The host is selected for a scheduled job.

If you delete a host and then restart its agent, it is re-registered as an SunUpdate Connection –
Enterprise managed host, but it is not assigned to user-defined groups.

Log into a terminalwith root permissions and stop the agent application.
# /etc/init.d/uce_agent stop

Log in to SunUpdate Connection – Enterprise as a userwith full permissions or as the adminuser.

In theHosts list, select the host fromwithin any group.

Doone of the following:

� From the tool bar, click the Delete Host button.
� Right-click the selected host and choose Delete.
� From theHosts menu, choose Delete.

In the confirmation dialog box that opens, clickDelete.

The host name is removed from all groups and the host is deleted from SunUpdate Connection –
Enterprise.

� ToDeleteMultipleManagedHosts fromSunUpdate
Connection – Enterprise
You cannot delete managed hosts in the following circumstances:

� The agent of the host is still running.
� The host is in a currently active job.
� The host is selected for a scheduled job.

If you delete a host and then restart its agent, it is re-registered as an SunUpdate Connection –
Enterprise managed host, but it is not assigned to user-defined groups.

Log into a terminalwith root permissions and stop the agent application on eachmanagedhost.
# /etc/init.d/uce_agent stop
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Log into SunUpdate Connection – Enterprise as a userwith full permissions or as the adminuser.

In theHosts list, hold Shift or Controlwhile selecting hosts.

Do one of the following:

� From the tool bar, click the Delete Host button.
� Right-click the selection and choose Delete.
� From theHosts menu, choose Delete.

In the dialog box that opens, click one of the following:

� Delete All –Delete all selected hosts at once.
� Delete –Delete selected hosts separately.

Deleting aManagedHostwith the CLI

TheDelete Host command functions only if the agent is already stopped. The following script
example stops the agent, so the user would need root permissions to run it. See “Delete Host (-dh)
Command” on page 265.

#! /bin/bash

echo “To run this script, you need root permissions.”

echo “If you are not root, exit this script and re-login.”

echo -n “Enter your Sun Update Connection – Enterprise user name:”

read user

echo -n “Enter your password:”

read password

echo -n “Enter the name of the host you want to delete:”

read host

echo “Stopping the agent...”

/etc/init.d/uce_agent stop

echo “Deleting the host...”

uce_cli -dh -h “$host” -u “$user” -p “$password”

Profile Compliance
You can assign a profile to amanaged host. You can also assign a profile to a group. Profile
assignment does not limit the jobs you can run on hosts or groups. However, it does allow you to run
a profile compliance check.

Aprofile compliance check tests whether a host complies with the requirements of its assigned
profile, and to the profiles assigned to the groups to which the host belongs.
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EXAMPLE 4–7Checking aHost for Profile Compliance

This example uses predefined profiles, which run tests on a complete system. Once you have created
your own profiles (see Chapter 9), that specifically define the requirements of your different
machines, you can assign the appropriate profile to each host or group. In the example, you would
probably change the assigned profile of the host fromCheck System toWeb Server.

You have a host that will be a web server. You assign the Check System profile to this host. The Check
System profile tests formissing or conflicting dependencies.

You assign the web server host to the test group. This group tests the integrity and stability of
upgraded software. Its assigned profile is the UpgradeAll Components check.

When the web server host has passed all tests, youmove it to the web server production group. This
group has an assigned profile of Check Security, which tests for known security holes.

At any time, you can run the profile compliance test andmake sure that the web server host does not
have dependency issues.While it is in the test group, you can also check, simultaneously, that all its
software is upgraded.While it is in the production group, you can check (again, at the same time as
you check for dependencies) that the server is secured.

� ToCheckProfile Compliance
In this procedure, you will run a profile compliance check on a host that belongs to a group. Both the
host and the group have assigned profiles. This proceduremay be run by any user, of any level
permissions.

In theHosts list, expand agroup and select a singlemanagedhost or group.

Doone of the following:

� From the tool bar, click the Profile Compliance Check button.
� Right-click the selected host and choose Profile Compliance.
� From theHosts menu, choose Profile Compliance Check.

The Profile Compliance window opens.

The Profile Compliance Check executes within seconds, resulting in compliance status for the profile
attached to the host, and for the profiles attached to groups to which the host belongs.

Select a profile in the list. Its details appear in the bottom panel.

If the icon of a profile is marked with an exclamationmark in a red circle, the host is not compliant
with that profile. Create a Complex Job to fix the issues (see Chapter 11).
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Local Inventory

This chapter explains how to set up the SunUpdate Connection – Enterprise knowledge base to
recognize your local components, both software packages and private files; and how the Local
Expansion technology, which generates deployment rules for your local software, is initiated.

Local inventory components are available for use in any job, by any user. Even users with restricted
permission can create jobs with local software and local files. However, you will see in this chapter’s
procedures that management features of local components are available only to users with full
permissions and to the admin user. This is to avoid change conflicts in the Local Inventory.

This chapter covers the following topics:

� “Terms” on page 75
� “Local Inventories – NCOs and Files” on page 76
� “Managing Local Categories” on page 78
� “Understanding Local Software” on page 83
� “Uploading Linux Software” on page 84
� “Uploading Solaris Software” on page 90
� “Editing NCOListings in Components List” on page 95
� “Managing Local Files” on page 102

Terms
This chapter uses the following terms:

CertifiedObject (CO) Component that has passed the certification process of the
Certification Lab and is available for download andmanagement.

Component Any logical unit that is, or can be, part of amachine. Such a unit is
not only a software component itself, but also any logical
construct of the component hierarchy.
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Components list Organizational structure of software in SunUpdate Connection –
Enterprise, using a hierarchy of logical holders for actual software
packages.

Inventory (1) List of components installed on amanaged host. (2) List of
components on the universal server.

Knowledge Base A local knowledge base is a private, on-site only, collection of
NCO listings and their deployment rules as generated by the
Local Expansion technology.

Local Expansion technology Application that generates knowledge for local components
unknown to the universal server.

Local Files Files that you add to the local knowledge base. Categorized as the
following:
� Action – Script or binary that directly causes a change in a

host. Defined as a pre-action or a post-action according to its
order in a job.

� Configuration File –Non-action file that can contain
user-definedmacros.

� Macro – Script or binary that overwrites a variable with a
value, usually taken from a host to localize a file.

� Probe – Script or binary that runs a test on a host as a job
prerequisite.

Local Software (NCO) Component from a local environment, a third party, or Solaris
that has not passed certification and is not permitted to be
distributed without a specific license.

Also known as a NonCertifiedObject (NCO).

Local Inventories –NCOs andFiles
For each supported distribution, there is a component inventory.

Inventories include default categories:

� Hardware –Contains local hardware information.
� Software –Contains COs, indicated by the certified component icon:
� Running Kernel – Lists the active KernelBase. Search under Software for other installable kernel

components
� Notifications – Lists actions to be done, such as restart, on specific hosts

Local Inventories – NCOs and Files
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� Local –This chapter deals with the Local category and the components it may contain, indicated
by the Local component icon:

Non CertifiedObject (NCO) Software packages that are not in the knowledge base of the
universal server (such as private, proprietary, and third-party
software packages), but are installed on a local machine or for
which you have a source, such as a third-party CD.

Local Files Private scripts, binaries, executables, and configuration files
available for environmentmanagement.

Your local components, NCOs and Local Files, are added to the knowledge base on your site. They
are never pushed outside of your enterprise.

Only users with full permissions or the admin user can set up local inventories.All users can use them
in jobs.

Troubleshooting – Local InventoryManagement Fails
Description: An SunUpdate Connection – Enterprise command fails with the following

error:

Cannot process comand. Reason: another command running.

Cause: SunUpdate Connection – Enterprise is busy handling back-end processes and
your new command timed out. This error is most commonly seen while you
manage Local Inventories.

Workaround: Execute the command again, or wait a fewminutes before running the
command again.

Inventory Panel
Themain window is comprised of the Inventory panel and the Jobs panel. Tomanage Local
Inventory, the Inventory panel must be visible.
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FIGURE 5–1MainWindow

If the Inventory view is not open when you log into SunUpdate Connection – Enterprise, from the
Viewmenu, choose Inventory. In the Components list of the Inventory view, find the Local category.

If the Local category is empty, or not visible, check whether Show Installed is selected. If it is, only
components installed on selected hosts are shown in the Components list; if none are selected, the
Components list shows only COs. Deselect this option to see all Local categories.

Managing Local Categories
In this section, you will learn how to add, edit, and delete categories in the Components list under
Local.

Each category can hold package groups and packages, whichmay be either software or files,
depending on the top-level default category under which you create your own categories.

These features are available only to users with full permissions and to the admin user.
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Default Local Categories
Expand the Local category to see the default categories. You cannot edit or delete these categories.

� Local RPMs or Local PKGs –Your local software components (NCOs)
� Configuration files – Local versions of configuration files
� Macros – Scripts that pull data from hosts to replacemacro signs in local Configuration files
� Pre-actions – Executables that do something to a host before the tasks of a job begin
� Post-actions – Executables that do something to a host after the tasks of a job finish
� Probes – Executables that test a pre-requisite condition of a host, to see whether a job should

begin

User-Defined Local Categories
Under a default category, you create, edit, or delete your own categories. Choose the default category
that best describes the software or files that you will be adding to the knowledge base.

AddingCategories
You customize the Local components list by adding your own categories to the default ones under
Local.

� ToAddaCategory

In the Components list, under Local, select a default category.

Do one of the following:

� From the tool bar, click theAdd Category button.
� From the Components menu, choose Local ->Add Category.
� In the Components list, right-click the selected category and choose Local ->Add Category.

TheAdd Category window opens.
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Type a nameanddescription for the new category.

Check distributions towhich youwant this category to be assigned.

Click Apply.

The status column indicates when the category is uploaded to the knowledge base.

Click Close.

TheAdd Category window closes. Youmight have to wait until the Components list is updated with
the new category; time depends on your local environment configuration.

Adding a Categorywith the CLI

The create a new category CLI command puts the category into all distributions (default) if you do
not use the -D parameter. To add the category to one specific distribution, use the -D parameter and
the name of the distribution. (The -ld command outputs the names of distributions.) See “Add
Local Category (-alc) Command” on page 268.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo -n “Type a name for the new category:”

read newCatName
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echo -n “Enter a desription for the new category:”

read newCatDesc

echo “Under which category should this one be added?”

echo “Valid answers: Local RPMs, Local PKGs, Probes, Pre-actions,”

echo “Post-actions, Macros, Configuration files,”

echo “or an existing user category under one of these: /existing_subcategory”
read parent

uce_cli -alc -T “$newCatName” -ds “$newCatDesc” -pT “$parent” -u “$user” -p “$password”

EditingCategories
In this procedure, you edit Local categories. You can change the name, description, and list of
distribution assignments of any category that you or another user created. You cannot change the
default categories.

� ToEdit a Category

From theDistro drop-down list, select the distribution-architecture holding the component that you
want to change.

In the Components list, select the category that youwant to change.

Doone of the following:

� From the tool bar, click the Edit Local Component button.
� Right-click the selected category and choose Edit.
� From the Components menu, choose Edit.

The Category Properties window opens.
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Edit as needed: Name, Description, selectedDistributions.

Click Apply.

The status column indicates when the category has been changed for each distribution.

Click Close.

The Category Properties window closes. Youmight have to wait until the console is updated with the
changes. The time depends on your local environment configuration.

DeletingCategories
In this procedure, you delete a user-defined Local categories. Everything inside of the category will be
deleted as well. However, if there aremany components in the category, the delete functionmight fail
with the another process running error. To ensure this does not occur, delete the contained
components before deleting the category.

� ToDelete a Category

In the Components list, select the category that youwant to delete.

Do one of the following:

� From the tool bar, click the Delete Local Component button.
� Right-click the selected category and choose Delete.
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� From the Components menu, choose Delete.
The Delete Local Component window opens.

Check the distributions fromwhich youwant to delete the category.

Click Apply.

The status column indicates when the category has been deleted from each distribution.

Click Close.

TheDelete Local Component window closes. Youmight have to wait until the console is updated
with the changes. The time depends on your local environment configuration.

Understanding Local Software
In this section, you will learn how to add, edit, and delete local software components that are
Non-Certified by the Lab (NCOs). These procedures are available only to users with full permissions
or the admin user.

NCODetection andRuleGeneration
If amNCO is installed on amanaged host, SunUpdate Connection – Enterprise automatically
detects it and adds it to your local knowledge base. If the NCO is not yet installed (it is on a CD or
other source), you can add it to the knowledge base on demand.
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When anNCO is added to the local knowledge base, the Local Expansion technology generates rules
for NCOdeployment. (Be aware that rules generated on-site are not as rigorous as those created by
Sun.)

NCOs in Component Lists
TheNCO is placed in the Components list. If it is a new package, it is placed under Local RPMs or
Local PKGs. If it is an unknown version of a known package (for example, if your organization
creates a proprietary patch for an application), the NCO is placed under Software. You can use the
Find feature (see “To Find Components” on page 212) to find it under a Software listing.

NCOPrivacy
Your local knowledge base data (the package, its listing, its rules) are never pushed back to the
universal server, nor are they overwritten by downloaded updates. The local knowledge base is
secured for your private site.

Uploading Linux Software
Though SunUpdate Connection – Enterprise should automatically detect NCOs that are already
installed on a host in the solution, sometimes you want tomanually add your NCOs to your local
knowledge base. Procedures for adding RPMs that belong to Linux distributions are slightly different
than those for adding Solaris PKGs.

The procedures in this section include the following:

� “Using Console onWindows” on page 84
� “Adding Undetected Linux Software” on page 85
� “Attaching Linux Software to Detected Listings” on page 88

UsingConsole onWindows
You cannot upload RPMswith a console onMicrosoftWindows. Use the SunUpdate Connection –
Enterprise CLI on a Linuxmachine to upload RPMs. See Example 5–2.
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AddingUndetected Linux Software
In this procedure, you add a local RPM to the knowledge base, when it has not been detected
automatically. For example, you would use this procedure for uploading a third-party bundle of
components from a CD.

You cannot upload RPMswith a console onMicrosoftWindows. Use the SunUpdate Connection –
Enterprise CLI on a Linuxmachine to upload RPMs. See Example 5–2.

� ToUploadaNewRPM

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a Linux distribution-architecture.

The Components list shows the components relevant to your selection. TheNCOs that you add with
this procedure will be added to the inventory of the displayed distribution.

Select Local/Local RPMs/[category].

Do one of the following:

� From the tool bar, click theAdd Component button.
� Right-click the selected category and choose Local ->Add.
� From the Components menu, choose Local ->Add.

TheAdd Software window opens.
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Select a sourcemachine:

� If the console has access to the RPM, select Console.
� If a remotemanaged host has access to the RPM, selectManagedHost.

Note –Remote upload is limited to 5Mbytes. Console upload is unlimited. You should upload
from the console whenever possible.

� ToUpload from theConsoleMachine
If you selected console, follow this procedure. If you selectedManagedHost, go to “ToUpload from a
ManagedHost” on page 87.

Click the Select File button of the File Namefield.

The Choose RPMwindow opens.

Browse to and select packages youwant to add. Use the Control or Shift keys tomake amultiple
selection fromonedirectory.

ClickOpen.

The Choose RPMwindow closes, and the path names appear in the File Name list of theAdd
Software window.Add asmany packages as you want.
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Click Apply.

The Status column indicates when the upload is done. Youmight have to wait until the console is
updated with the changes. The time depends on your local environment configuration.

� ToUpload fromaManagedHost
If you selectedManagedHost, follow this procedure. Note that this procedure upload only one RPM
at a time.

Click the Select Host button of theHost Namefield.

TheHost Selection window opens.

Select themanagedhost that has the software, and clickOK.

TheHost Selection window closes and the host name appears in the Host Name field of theAdd
Software window.

In the File Namefield, type the full path nameof the package.

Click Apply.

The Status column indicates when the upload is done. Youmight have to wait until the console is
updated with the changes; time depends on your local environment configuration.

ToUploadNCOswith the CLI

TheAdd Software Package command allows you to give a path name of a package for upload. The
package should be on the local machine or on amount point. The Distribution parameter is required
in this command (the -ld command outputs a list), and you add the package to a single distribution
at a time. See “Add Software Package (-asp) Command” on page 268.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “The list of active distributions is:”

uce_cli -ld -u $user -p $password

echo -n “Type the exact name of the distribution for this software:”

read distro

echo -n “Type the source path name of the file:”

read pathname

echo -n “Is this software a secured version of a previous one? (y | n)”

read secure
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if [ “$secure” = “y” ]; then

uce_cli -asp -f “$pathname” -secure -D $distro -u “$user” -p “$password”

else

uce_cli -asp -f “$pathname” -D $distro -u “$user” -p “$password”

fi

Attaching Linux Software toDetected Listings
In this procedure, you learn how to attach a local RPM to anNCOname in the Components list. The
namemust already be in the Components list.

TABLE 5–1Reasons for Performing theAttach Procedure

Environment Indicator

Sometimes a packagemay be uploaded and automatically
attached to the NCO listing, but you want to replace the
package with one of your own choosing.

A local component listing that has a package
already associated with it, is indicated by the
full icon.

Sometimes the system dependency servermay be unable to
upload the package itself. Use this procedure tomanually
attach the correct software with the listing.

Asoftware component listing without an
attached software, is indicated by the empty
icon.

Sometimes, after a package was uploaded, the Local
Expansion technologymay discover that this software has
missing local dependencies; its rules require components that
are not yet in the knowledge base. Until you fix this issue, the
component can not bemanaged by SunUpdate Connection –
Enterprise.

An exclamation point in a red circle, on either a
full (has software attached) or an empty (does
not have software attached) listing, indicates
that there aremissing local dependencies.

Console onWindows
You cannot upload or attach RPMswith a console onMicrosoftWindows. Use the SunUpdate
Connection – Enterprise CLI on a Linuxmachine to upload RPMs. See Example 5–2.

� ToAttach anRPM

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows the components relevant to your selection.

Select Local/Local RPMs/[category]/package group/<package>.

Doone of the following:

� From the tool bar, click the Upload knowledge base File button.
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� Right-click the selected component and choose Local -> Upload.
� From the Components menu, choose Local -> Upload.

TheAttach Target File window opens.

Check each distribution towhich this NCO is applicable.

Select a sourcemachine:

� If the console has access to the NCO, select Console.
� If a remotemanaged host has access to the NCO, selectManagedHost.

Note –Remote upload is limited to 5Mb; console upload is unlimited. It is recommended that you
upload from the console whenever possible.

� ToAttach anRPM from theConsoleMachine
If you selected console, follow this procedure. If you selectedManagedHost, go to “ToAttach an
RPM from aManagedHost” on page 89.

Click the Select File button of the File Namefield.
The Choose RPMwindow opens.

Browse to and select the relevant package.

ClickOpen.
The Choose RPMwindow closes, and the path name appears in the File Name field of theAttach
Target File window.

� ToAttach anRPM fromaManagedHost
If you selectedManagedHost, follow this procedure.

Click the Select Host button of theHost Namefield.
TheHost Selection window opens.

Select themanagedhost that has the software, and clickOK.
TheHost Selection window closes, and the host name appears in the Host Name field of theAttach
Target File window.

In the File Namefield, type the full path nameof the package.

Click Apply.
The Status column indicates when the upload is done. The Local Expansion technology generates
deployment rules for the new package.
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Uploading Solaris Software
Solaris software and file formats are not known by Linux. Therefore, the procedures for adding
Solaris software to your local knowledge base include creating a tar file of Solaris packages:

Expand the PKG, to create a directory of files; then tar the directory.

Using SunUpdate Connection – Enterprise, you will upload the tar file. SunUpdate Connection –
Enterprise will recognize it as a Solaris software andmake the PKG accessible for deployment in jobs.

The procedures in this section include the following:

� “Using Console onWindows” on page 90
� “Adding Undetected Solaris Software” on page 90
� “AddingMultiple Solaris Packages” on page 91
� “Adding Solaris Software with a Script” on page 92
� “Attaching Solaris Software to Detected Listings” on page 93

UsingConsole onWindows
You cannot upload PKGs with a console onMicrosoftWindows. To upload single PKGs, on the SDS
machine, use the script created for external upload. See “Adding Solaris Software with a Script”
on page 92.

AddingUndetected Solaris Software
In this procedure, you add a Solaris PKG to the knowledge base, when it has not been detected
automatically. This procedure is best used for single packages, when you feel more comfortable using
the console rather than a command-line.

BeforeYouBegin
When you upload Solaris software, it must be in the form of a tarball, not a PKG.

1. Make sure the software is a directory of files, not a PKG.

2. Tar the directory: tar -cf name.tar /path/*

3. Copy the tarball to the consolemachine.

If you are using a console onMicrosoftWindows, this procedure is not applicable. See “Adding
Solaris Software with a Script” on page 92.
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� ToUploada Single PKG

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select the Solaris distribution-architecture.

Select Local/Local PKGs/[<category>].

Do one of the following:

� From the tool bar, click theAdd Component button.
� Right-click the selected category and choose Local ->Add.
� From the Components menu, choose Local ->Add.

TheAdd Software window opens.

In Upload File From, select Console.

Click the Select File button of the File Namefield.
The Choose RPMwindow opens. This window has the same name for both Linux (RPM) and Solaris
(tarball).

Browse to and select the package youwant to add. Use the Control or Shift keys tomake amultiple
selection fromonedirectory.

ClickOpen.
The choose RPMwindow closes, and the path name appears in the File Name List of theAdd
Software window.

Click Apply.
The Status column indicates when the upload is done. Youmight have to wait until the console is
updated with the changes; time depends on your local environment configuration.

If a software component is a security fix for an earlier version (see “To Fix Local SoftwareMissing
Dependencies” onpage 100), check the Security Fix option.

AddingMultiple Solaris Packages
In this procedure, you add a large amount of Solaris software to your local knowledge base. Use this
procedure for upload of Solaris software CDs. This procedure does not use the console; it uses a web
application created specifically tomake SunUpdate Connection – Enterprise support and
management of Solaris more efficient. Notice that this procedure is also found in theAdministrator’s
Guide; it must be done after installation of the SunUpdate Connection – EnterpriseAgent on a
Solaris machine, to enable the system dependency server to recognize Solaris software.
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BeforeYouBegin
Make sure of the following:

� You have standardNFS or direct access to the PKGs from the system dependency server
machine. The CD is in the CD-ROMof the SDSmachine; or the SDS has direct access to Solaris
files. This procedure does not support FTP orHTTP.

� Directories and files to be uploaded are readable by the nobody user.
� If the software is in PKG format, expand the PKGs. Each creates a directory (and possible

sub-directories) and places there the files of the package.

� ToUploadSolaris CDs

Open awebbrowser and in theURLaddress field, type:

https://SDS-hostname-or-IP-address:8002/upload.html

In the Packagepath text box, type the full path to the directory that contains the Solaris software.

For example, if you specify the /tmp/tmpdsol directory, it should contain all the subdirectories and
contents copied from the Products directory on the CD ISO image.

Note –There is no recursive search, so the upload pathmust be only one level above the software
directories.

ClickUpload.

The packages are added to the Solaris knowledge base of the SunUpdate Connection – Enterprise
system dependency server. The browser window shows the automated actions: reading packages,
adding packages, and searching formissing packages.

Adding Solaris Softwarewith a Script
In this procedure, you will use a script from the SunUpdate Connection – Enterprise CLI application
to upload Solaris software. Use this procedure if you are unfamiliar with Solaris commands and
having trouble unpacking the PKGs or tarring the directories.

BeforeYouBegin
Install the latest SunUpdate Connection – Enterprise CLI.

The script is /usr/local/uce/cli/bin/pkg_loader.sh
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� ToUploadSolaris SoftwareWithpkg_loader

Change to the followingdirectory by typing:
cd /usr/local/uce/cli/bin/

Type the following command:

Note – -p is required and its value is the path of the packages to be uploaded.

-r is optional and provides a recursive search through the given path.

-d is optional and provides debugging information.

./pkg_loader.sh -p path [ -r ] [ -d ]

Type a SunUpdate Connection – Enterprise user namewith full permissions.

Type a password for the SunUpdate Connection – Enterprise user.

For the channel, type the number of the distribution-architecture, according to the displayed list of
Available Channels, towhich the packages youwant to uploadbelong.

At the prompt Would you like all found components to be added under specific category?,
type y to put the packages in a user-defined category, and then at the Category name prompt, type
the nameof the category.

If the category does not yet exist in the SunUpdate Connection – Enterprise components list, it will
be created. If you type n, the packages are added under a default category in the components list.

pkg_loader.shwill tar the Solaris package directories. Then it uploads the tarballs to the knowledge
base. SunUpdate Connection – Enterprise recognizes them as Solaris packages and enables you to
deploy them as PKGs.

Attaching Solaris Software toDetected Listings
In this procedure, you learn how to attach a Solaris software to a name in the Components list under
Local/Local PKGs. The namemust already be in the Components list. Use this procedure to: replace
a package with another one; manually upload a package; fixmissing dependencies. See Table 5–1 for
more explanations of when to use an attach procedure.

Console onWindows
If you are using a console onMicrosoftWindows, this procedure is not applicable. See “Adding
Solaris Software with a Script” on page 92, or delete an existing component (that you want to replace
or fill), and use the scirpt to upload the new PKG.
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BeforeYouBegin
When you upload Solaris software, it must be in the form of a tar file, not a PKG.

1. Make sure the software is a directory of files, not a PKG.
2. Tar the directory:

tar -cf name.tar /path/*

3. Copy the tarball to the consolemachine.

� ToUploadSolaris Software

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.
The Components list shows the components relevant to your selection.

Select Local/Local PKGs/[category]/package group/package.

Do one of the following:

� From the tool bar, click the Upload knowledge base File button.
� Right-click the selected component and choose Local -> Upload.
� From the Components menu, choose Local -> Upload.

TheAttach Target File window opens.

Check the relevant Solaris architecture-distribution.

In theUpload File Fromoptions, select Console.

Click the Select File button of the File Namefield.

The Choose RPMwindow opens.

This window has the same name for both Linux (RPM) and Solaris (tarball).

Browse to and select the relevant package.

ClickOpen.

The Choose RPMwindow closes, and the path name appears in the File Name field of theAttach
Target File window.

Click Apply.

The Status column indicates when the upload is done. The Local Expansion technology generates
deployment rules for the new package.
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EditingNCOListings in Components List
After you have added your local components to the SunUpdate Connection – Enterprise knowledge
base, remainingmanagement procedures are the same, whether for Local RPMs or for Local PKGs,
and on a console of any platform.

This section includes the following procedures:

� “Editing Local Software Package Groups” on page 95
� “Editing Local Software Packages” on page 96
� “Deleting NCOs” on page 97
� “Managing Local Patches andDependencies” on page 98
� “Using Local Security Fixes” on page 99
� “Fixing Local Dependencies” on page 100
� “Troubleshooting NCOs” on page 101

Editing Local SoftwarePackageGroups
In this procedure you edit a package group that SunUpdate Connection – Enterprise creates when
you add a local component to the knowledge base. Use this procedure to apply a package group to
additional distributions.

� ToEdit a PackageGroup

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows the components relevant to your selection.

Select Local/Local RPMs | Local PKGs/[category]/package group.

Do one of the following:

� From the tool bar, click the Edit Local Component button.
� Right-click the selected component and choose Local -> Edit.
� From the Components menu, choose Local -> Edit.

The Package Group Properties window opens.

Change the description or the list of applicable distributions.

Click Apply.

The Status column displays icons to indicate the success or error.
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Click Close.

The Package Group Properties window closes.Wait for the console to be updated.

Editing Local SoftwarePackages
In this procedure you edit the properties of a local package. Use this procedure to add the software to
the knowledge bases of more distributions or tomark a package as a security fix for a previous
version.

� ToEdit a Package

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows the components relevant to your selection.

Select Local/Local RPMs | Local PKGs/[category]/package group/package.

Do one of the following:

� From the tool bar, click the Edit Local Component button.
� Right-click the selected component and choose Local -> Edit.
� From the Components menu, choose Local -> Edit.

The Package Properties window opens.

If this package is a fix for a previous package, select Security fix (see “ToMark Local Software as a
Security Fix” onpage 99).

Change the description or the list of applicable distributions.

Click Apply.

The Status column displays icons to indicate the result of the change.

Click Close.

The Package Group Properties window closes.Wait until the console is updated with the changes;
time depends on your local environment configuration.
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Movinga Local RPM toAnother PackageGroup

� ToMovea Local RPM toAnother PackageGroup
Use theMove Package Group window to reorganize the Local RPMs heirarchy for one ormore
distributions on your system dependency server.

This procedure applies to local RPMs only. You can onlymove a local RPM to a different category
under the Local RPMs category.

From theHosts list, select a host or a host group to specify the distribution type.

From the Components list, expand the Local folder and then expand the Local RPMs folder to see the
local RPMcategories for this distribution.

Expand the local RPMcategory that contains the RPM that youwant tomove.

Select the RPMelement tomove.
If you select one of the components under the RPM element, theMove option is disabled.

Open theMove PackageGroupwindow in one of theseways:

� From the tool bar, click theMove the Selected Local Component button.
� From the Components menu, choose Local->Move.
� In the Components list, right-click the selected package and choose Local->Move.

TheMove Package Group window opens.

Specify the distributions youwant affected by this change.
By default, all distributions are affected by the change.

To select a subset of the distributions, deselect SelectAll, and then select one ormore distributions.

Select the category towhich youwant tomove the RPM.
To create a new category under Local RPMs, see “ToAdd a Category” on page 79.

Click Apply.

Verify that the RPMwasmoved correctly.

Click Close to close thewindow.

DeletingNCOs
In this procedure, you removeNCOs from your Local components list or from specific distributions.
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BeforeYouBegin
Make sure that the NCO is uninstalled from every host before attempting to remove it from the
knowledge base. If it is installed on amanaged host, it will be automatically detected and added again
to your local knowledge base.

� ToDelete anNCO

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows the components relevant to your selection.

Under Local/Local RPMs | Local PKGs/, select the component that youwant to delete.

It may be a user-defined category, a package-group, or a package.

Dooneof the following:

� From the tool bar, click the Delete Local Component button.
� Right-click the selected component and choose Delete.
� From the Components menu, choose Delete.

The Delete Local Component window opens.

Check the distributions fromwhich youwant to delete theNCO.

Youmay check any or all distributions, even those that did not have the NCO.

Click Apply.

The Status column displays icons to indicate the result of the delete.

Click Close.

TheDelete Local Component window closes.Wait until the console is updated.

Managing Local Patches andDependencies
If you create a homegrown patch for either a CO or anNCO, you can upload your component and
mark it as a patch.

For example, your organization has a software developed in-house. Some time later, it is discovered
that this software has a security issue. The component is patched to fix the security issue and is
packed again.
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Without SunUpdate Connection – Enterprise, you would have to uninstall every instance of the
software and install the new one.With SunUpdate Connection – Enterprise, everything is handled
automatically. You upload the new version to the knowledge base, and in theAdd Software window,
youmark the upload as a Security Fix.

You run a Security Check (“Running Predefined Profiles” on page 140).Wherever the earlier version
was installed, the agents upgrade it to the secured version.

Using Local Security Fixes
In this procedure youmark a local component as being a security fix for an earlier version.

ToMark Local Software as a Security Fix
In theAdd Software window, select Upload as: Security Fix.

If you are using a console onWindows, use the CLI command.

Marking as a Fix in CLI
Execute the CLI -asp commandwith the -secure option. See “Add Software Package (-asp)
Command” on page 268.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “The list of active distributions is:”

uce_cli -ld -u $user -p $password

echo -n “Type the exact name of the distribution for this software:”

read distro

echo -n “Type the source path name of the file:”

read pathname

echo -n “Is this software a secured version of a previous one? (y | n)”

read secure

if [ “$secure” = “y” ]; then

uce_cli -asp -f “$pathname” -secure -D $distro -u “$user” -p “$password”

else

uce_cli -asp -f “$pathname” -D $distro -u “$user” -p “$password”

fi

ToHandle a Series of Fixes
If you upload a package andmark it as Security Fix, consider earlier versions:

EditingNCO Listings in Components List

Chapter 5 • Local Inventory 99



� Maintain a series of Security Fixes by keeping all versionsmarked as Security Fix.All packages
are considered secure.

� Edit properties of previous packages by unmarking the earlier versions. SunUpdate Connection
– Enterprise considers only the latest marked package as secure.

Fixing Local Dependencies
Adependency is a component that is needed by a package for deployment. This dependent
componentmay be another software component, a file, a symbol, and so on.When you upload
packages to your local knowledge base, the Local Expansion technology finds the list of dependencies
for each package. If the knowledge base is missing dependencies, use the information given by Sun
Update Connection – Enterprise to fix them.

NCOswithmissing dependencies aremarked with an exclamation point in a red circle icon:

BeforeYouBegin
Before you fixmissing dependencies of amarkedNCO, you should wait at least twominutes from
the time that uploaded succeeded. The Local Expansion technology generates rules for local
components on a scheduled basis; if you wait, some of themissing dependencies may be handled
automatically.

If the NCO is Solaris software, make sure the dependent components to be uploaded are tarballs and
have been copied to the consolemachine.

� To Fix Local SoftwareMissingDependencies

Log inwith full permissions or as the adminuser.

From the Components list, select the componentmarkedwith an exclamation point in a red circle.

Do one of the following:

� From the tool bar, click the Details button.
� Right-click the selected component and choose Details.
� From the Components menu, choose Details.

The Component Information window opens.
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Open theDependencies tab.

In the Requires section, missing components aremarked with an exclamation point in a red circle.

From the Internet or private source, find the packages that provide themissing components.

If the package is a PKG, expand it and tar the directory.

Add the packages to the local knowledgebase.

When all missing dependencies are uploaded, the icon of the local component changes to standard.

TroubleshootingNCOs

CannotAttachNCO
Description: Upload of theAttach procedure failed with the following error:

Package-Name mismatch. Use Add button.

Cause: The selected component and the RPM you selected to attach have different
names.

Workaround: Use theAdd feature instead ofAttach.

AttachedNCO isMarkedwith anExclamationPoint in aRedCircle
Description: Upload succeeded, but the package icon is marked with an exclamation point

in a red circle.
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The rules of this RPM show that dependent components aremissing from the
local knowledge base.

Workaround: See “To Fix Local SoftwareMissing Dependencies” on page 100.

Cannot FindNCO
Description: Upload of theAttach procedure succeeded, but the NCO is not listed under

Local RPMs or under Local PKGs.

ACO (under Software, rather than under Local) has the same name, version,
and release. Your NCOwas added to the package group of the appropriate
name under Software.

Workaround: Run the Local Software Review predefined test (see “Predefined Profiles”
on page 136), or use the Find feature to find this software component and to
check that the listing is correct for your component.

CannotDelete anNCOComponent
Description: When you try to delete a selected Local component, you receive the following

errormessage:

Cannot be deleted.If an NCO is installed on any managed host within

the selected distributions, it will be detected and uploaded again. To

prevent Sun Update Connection – Enterprise from undoing your delete

command, the message reminds you to uninstall the software component

from all hosts before deleting it from the knowledge base.

Workaround: Do the following:
1. Open the Inventory panel (View -> Inventory).
2. From the Components list, right-click the software component and choose

Component Properties. The Component Information window opens. In
the Installed tab, see the list of all managed hosts that have this component
installed.

3. Create and deploy a job to uninstall this component from the listed hosts.
4. Return to themain window and delete the component.

Managing Local Files
In this section, users with full or admin permissions add, edit, and delete local files.

Local files are scripts, binaries, executables, and files that are private to your enterprise or otherwise
unknown to the universal server. The following table explains the categories.
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TABLE 5–2Local FileCategories

Category Description Use

Configuration
files

Installs a version of a configuration file Install configuration file versions for efficient
changemanagement on a customized environment

Macros Outputs a value into a local
configuration file

Install a local configuration file that includes a
macro sign and the sign will be replaced with the
local value

Post-action Performs an action on the host after
the job tasks are carried out

Run action scripts or binaries on hosts to fulfill a
post-job requirement

Pre-action Performs an action on the host before
the job tasks are carried out

Run action scripts or binaries on hosts to fulfill a
pre-job requirement

Probe Runs a test on a host; if returns success,
the job tasks are begun

Run test on hosts tomake sure they can do a job
before the tasks begin

Actions
An action is a script, binary, or executable that does something to a host. You categorize your actions
as either Pre or Post.

Pre-actions are run before the tasks of a job begins. If a pre-action finishes successfully, it returns a
value of zero and the next actions of the job are carried out. If a pre-action returns a non-zero value,
the job stops.

Post-actions are run after the other tasks of a job are completed. If a post-action returns a non-zero
value, the job ends with a failure status.

For example, you want to install theApache server.Aprerequisite ofApache installation is that /home
be unmounted.After it is installed, you want to run other applications that need /home to be
mounted.

You create a pre-action unmount_home.sh:

#!/bin/sh -f

# unmount home from remote server

umount server01:/home

if [ $?==0]; then exit 0; fi

You create a post-action mount_home.sh:

#!/bin/sh -f

# mount home to remote server

mount server01:/home

if [ $?==0]; then exit 0; fi
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You upload these actions. Then you create a profile to installApache, and add these actions to the job
basket. The job does the following:

1. runs any probes that you put in
2. unmounts /home
3. installsApache
4. mounts /home

WritingActions
Make sure the action returns zero (0) on success.

Make the name of the action understandable and descriptive. You can view it in the Jobs panel as a
task that either succeeded or failed.

UploadingActions
In this procedure you upload an existing executable as a Pre-Action or Post-Action to the knowledge
base. You can create a category under Pre-Actions or Post-Actions before uploading an action (see
“Adding Categories” on page 79).

� ToAddanAction

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows Local components applied to the selected distribution.

From the Components list select Local/Post-Actions | Pre-Actions/[category].

Do one of the following:

� From the tool bar, click theAdd Component button.
� Right-click the selected category and choose Local ->Add.
� From the Components menu, choose Local ->Add.

TheAdd PostAction or theAdd PreAction window opens.

Type a name for the component thatwill point to your Post-action or Pre-action. This should not be
the complete file name. The name should be a name that is easily understood.

Type a free-text description.

Check each distribution towhich this file should be applied.
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Select a sourcemachine:

� If the console has access to the file, select Console.
� If a remotemanaged host has access to the file, selectManagedHost.

Note –Remote upload is limited to 5Mbytes. Console upload is unlimited. It is recommended
that you upload from the console whenever possible.

� ToUploadaPost-actionor aPre-action from theConsoleMachine
If you selected console, follow this procedure. If you selectedManagedHost, go to “ToUpload a
Post-action or a Pre-action from aManagedHost” on page 105.

Click the Select File button of the File Namefield. The Choose Filewindowopens.

Browse to and select the relevant file.

ClickOpen.

The Choose File window closes, and the path name appears in the File Name field of theAdd Pre
Action orAdd PostAction window.

Click Apply.

The Status column indicates when the upload is done.

Click Close to close thewindow, or Reset to addmore.

� ToUploadaPost-actionor aPre-action fromaManagedHost
If you selectedManagedHost, follow this procedure.

Click the Select Host button of theHost Namefield.

TheHost Selection window opens.

Select themanagedhost that has the file, and clickOK.

TheHost Selection window closes. The host name appears in the Host Name field of theAdd Pre
Action orAdd PostAction window.

In the File Namefield, type the full path nameof the file.

Click Apply.

The Status column indicates when the upload is done. Click Close to close the window, or Reset to
addmore.
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Uploading a Post-action or a Pre-actionwith the CLI
TheAdd Target Local command is the same for Pre-actions, Post-actions, Configuration files,
Macros, and Probes. The following syntax is for Pre-actions and Post-actions. The -tP parameter is
for Pre-actions; -tS is for Post-actions. The example script adds a Post-action.

In the CLI syntax, a category under the default Local categories is mandatory. See the procedure:
Example 5–1 on for theAdd Local Category CLI command. See “Add Target Local (-atl)
Command” on page 270.

#! /bin/bash

function login {

echo -n “Type your user name:”

read user

echo -n “Type your password:”

read password

}

function distro {

echo “Active distributions are:”

uce_cli -ld -u “$user” -p “$password”

echo -n “To which distro should this script be added?”

read distro

echo

}

function category {

echo “Under which category should this Post-action be added?”

echo “Valid answers: any subcategory under Post-actions. See list:”

uce_cli -fc -T “Post-actions” -sons -D $distro -u “$user” -p “$password” #> tmp.file

sed “s/ROOT\/Local\/Post-actions//” tmp.file

echo -n “Start your answer with / :”

read parent #rm tmp.file

echo

}

function setup {

echo -n “Type the full path name of the file to upload:”

read pathname

echo -n “Type a display name for the local file:”

read displayName

}

login

distro

category

setup

uce_cli -atl -f “$pathname” -pT “Post-actions$parent” -tS “$displayName” -D $distro -u “$user” -p “$password”

Example 5–3
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Probes
Aprobe is a script or binary that tests whether a host fulfills prerequisites for successful completion of
a job.

If a probe returns zero, the next tasks of the job are carried out. This ensures that only hosts that
currently meet your requirements will run jobs.

If a probe returns 1, the job fails on the host. The probe name is displayed in the Status window as the
point of failure. Now you can easily troubleshoot the host.

EXAMPLE 5–4Creating aProbe

You create a probe that tests disk space. It returns zero if there is more than theminimumdefined in
the script.

#!/bin/csh -f

set minimum_space=10000000000

set actual_space=\Qdf -k | awk ’{print $4}’ | tail -1\Q

if ( $actual_space > $minimum_space ) then

echo $actual_space

exit 0

endif

exit 1

Upload this probe. Create a job that includes the probe. The tasks are carried out if the available space
of the host meets your requirements.

WritingProbes
Make sure the action returns zero (0) on success and one (1) on failure.

Make the name of the probe a boolean statement, tomake it as clear as possible; users will view it in
the Jobs panel as a task that either succeeded or failed.

SunUpdate Connection – Enterprise might run a probemany times during a job. To ensure that
operations are efficient, make sure that your probes are as short and fast as possible.

UploadingProbes
In this procedure you add probes to the local knowledge base. You can create a category under Probes
before uploading a probe (see “Adding Categories” on page 79).

Managing Local Files

Chapter 5 • Local Inventory 107



� ToAddaProbe

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows Local components applied to the selected distribution.

From the Components list select Local/Probes/[category].

Do one of the following:

� From the tool bar, click theAdd Component button.
� Right-click the selected category and choose Local ->Add.
� From the Components menu, choose Local ->Add.

TheAdd Probe window opens.

Type a display name for the component thatwill point to your probe.

This should not be the complete file name, but it should be a name that is easily understood.

Type a free-text description.

Check each distribution towhich this file should be applied.

Select a sourcemachine:

� If the console has access to the file, select Console.
� If a remotemanaged host has access to the file, selectManagedHost.

Note: remote upload is limited to 5Mb; console upload is unlimited. It is recommended that you
upload from the console whenever possible.

� ToUploadaProbe from theConsoleMachine
If you selected console, follow this procedure. If you selectedManagedHost, go to “ToUpload a
Probe from aManagedHost” on page 109.

Click the Select File button of the File Namefield.

The Choose File window opens.

Browse to and select the relevant file.

ClickOpen.

The Choose File window closes, and the path name appears in the File Name field of theAdd Probe
window.
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Click Apply.
The Status column indicates when the upload is done. Click Close to close the window, or Reset to
addmore.

� ToUploadaProbe fromaManagedHost
If you selectedManagedHost, follow this procedure.

Click the Select Host button of theHost Namefield.
TheHost Selection window opens.

Select themanagedhost that has the software, and clickOK.
TheHost Selection window closes. The host name appears in the Host Name field of theAdd Probe
window.

In the File Namefield, type the full path nameof the file.

Click Apply.

The Status column indicates when the upload is done. Click Close to close the window, or Reset to
addmore.

Uploading a Probewith the CLI

TheAdd Target Local command is the same for Pre-actions, Post-actions, Configuration files,
Macros, and Probes. The following syntax is for Probes.

In the CLI syntax, a category under the default Local categories is mandatory. See the procedure
Example 5–1 for theAdd Local Category CLI command. See “Add Target Local (-atl) Command”
on page 270.

#! /bin/bash

function login {

echo -n “Type your user name:”

read user

echo -n “Type your password:”

read password

}

function distro {

echo “Active distributions are:”

uce_cli -ld -u “$user” -p “$password”

echo -n “To which distro should this script be added?”

read distro

echo

}
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function category {

echo “Under which category should this Probe added?”

echo “Valid answers: any subcategory under Probes. See list:”

uce_cli -fc -T “Probes” -sons -D $distro -u “$user” -p “$password” > tmp.file

sed “s/ROOT\/Local\/Probes//” tmp.file

echo -n “Start your answer with / :”

read parent

rm tmp.file

echo

}

function setup {

echo -n “Type the full path name of the file to upload:”

read pathname

echo -n “Type a display name for the local file:”

read displayName

}

login

distro

category

setup

uce_cli -atl -f “$pathname” -pT “Probes$parent” -tR “$displayName” -D $distro -u “$user” -p “$password”

Configuration Files
The configuration files of a Linux or Solaris machine determine everything about the environment:
the kernel version, the bootloader, the file system, the printers, and so on.All of these files are
writable, to a system administrator with permissions and knowledge. Changemanagement in a
Linux or Solaris environment usually includesmanaging files as well as applications.

A local configuration file is any file that you want to store on the knowledge base and distribute to
multiple hosts for simultaneous and consistent configurations.Macros (see “Macros” on page 116)
are used to localize these files for values relevant to eachmanaged host.

EXAMPLE 5–6UpdatingConfigurationFiles

Your enterprise with 200 Linux servers is reorganizing; personnel are changing offices and floors.
Everyone wants their machine to print to the closest printer. Instead of reconfiguring every printcap
file for every host (probablymore than once, as the printers and the staff aremoved around the
complex), youmake different versions of this file.

You change printcap slightly for each version:

# /etc/printcap

# Version for RH 9 on 12th floor West

lp:\
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EXAMPLE 5–6UpdatingConfiguration Files (Continued)

:sd=/var/spool/lpd/lp:\

:mx#0:\

:sh:\

:rm=printer12
:rp=pr1:

Asecond version:

# /etc/printcap

# Version for RH WS3 on 10th floor Main

lp:\

:sd=/var/spool/lpd/lp:\

:mx#0:\

:sh:\

:rm=printer10
:rp=pr1:

And so on. You create a file declaration for /etc/printcap. Then you upload the versions of the file
to the file declaration.

Now you can change the printer configuration of any host within seconds, by selecting the
appropriate version and sending it to the hosts that need it. The contents of their old printcap is
overwritten with the contents of the version that you selected.

Creating FileDeclarations
Afile declaration holds a path name for installation on remote hosts.When you select a local
Configuration File to install on remote hosts, the file is installed in the path and under the name that
is determined by the file declaration. Thus, a file declaration can holdmultiple versions of the same
file; or different files that you want to be installed in the same path name on different hosts. This
allows you to simultaneouslymanage configuration files of a heterogenous environment.

You can create a sub-category under Configuration Files before uploading a Configuration file (see
“Adding Categories” on page 79).

� ToAddaFileDeclaration

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows Local components applied to the selected distribution.

From the Components list select Local/Configuration Files/[category].
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Dooneof the following:

� From the tool bar, click theAdd Component button.
� Right-click the selected category and choose Local ->Add.
� From the Components menu, choose Local ->Add.

TheAdd Target File Declaration window opens.

In theTarget File path name text-field, type the path namewhere youwant the files thatwill be held
under this declaration to be installed on the target hosts. Do not delete the starting back-slash.

Type a free-text description.

Check each distribution towhich this file should be applied.

Click Apply.
The status column indicates when the file declaration is uploaded to the knowledge base.

Click Close.
TheAdd Target File Declaration window closes.

The file declaration is created.Afile with a suffix of -Unknown is also created. This is a placeholder
and prevents accidental overwrites.

Adding a File Declarationwith the CLI

Youmay add a file declaration to all distributions (default; do not use the -D parameter) or to a single
distribution. If you choose to add a file declaration to a single specified distribution, you can add the
Configuration files only to that distribution. Remember that a file declaration, declares the target
path name for installation; it does not upload the file itself.

In the CLI syntax, a category under the default Local categories is mandatory. See the procedure:
Example 5–1 on for theAdd Local Category CLI command. See “Add File Declaration (-afd)
Command” on page 269.

#! /bin/bash

function login {

echo -n “Type your user name:”

read user

echo -n “Type your password:”

read password

}

function distro {

echo “Active distributions are:”

uce_cli -ld -u “$user” -p “$password”

echo -n “To which distro should this be added?”
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read distro echo

}

function category {

echo “Under which category should this File Declaration be added?”

echo “Valid answers: any subcategory under Configuration files. See list:”

uce_cli -fc -T “Configuration files” -sons -D $distro -u “$user” -p “$password” > tmp.file

sed “s/ROOT\/Local\/Configuration files//” tmp.file

echo -n “Start your answer with / :”

read parent

rm tmp.file

echo

}

function setup {

echo -n “Type the full path name for target installation:”

read path name

}

login

distro

category

setup

uce_cli -afd -tfp “$pathname” -pT “Configuration files$parent” -D $distro -u “$user” -p “$password”

Uploading Local Configuration Files
The File Declaration declares the full target path name for installation of a file on hosts; it is not the
file itself. In this procedure you upload your local versions of Configuration files to the local
knowledge base.

� ToAdda Local Configuration File

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows Local components applied to the selected distribution.

From the Components list, select Local/Configuration Files/category/file declaration.

Do one of the following:

� From the tool bar, click theAdd Component button.
� Right-click the selected category and choose Local ->Add.
� From the Components menu, choose Local ->Add.

TheAdd Configuration File window opens.
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Type a display version-name for the file.

This text field is called Version (rather thanName), because the files that you add to a specific file
declaration should all be different versions of one file. The Version value will be displayed in the
Components list as a suffix to the file name.

When you install this file on a remote host, it is installed under the full path name of the file
declaration.

Type a free-text description.

Check each distribution towhich this file should be applied.Make sure that the file declaration is on
all the selected distributions.

Select a sourcemachine:

� If the console has access to the file, select Console.
� If a remotemanaged host has access to the file, selectManagedHost.

Note: remote upload is limited to 5Mb; console upload is unlimited. It is recommended that you
upload from the console whenever possible.

� ToUploadaConfiguration File from theConsoleMachine
If you selected console, follow this procedure. If you selectedManagedHost, go to “ToUpload a
Configuration File from aManagedHost” on page 114.

Click the Select File button of the File Namefield.

The Choose File window opens.

Browse to and select the relevant file.

ClickOpen.

The Choose File window closes, and the path name appears in the File Name field of theAdd
Configuration File window.

Click Apply.

The Status column indicates when the upload is done. Click Close to close the window, or Reset to
addmore.

� ToUploadaConfiguration File fromaManagedHost
If you selectedManagedHost, follow this procedure.

Click the Select Host button of theHost Namefield.

TheHost Selection window opens.
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Select themanagedhost that has the software, and clickOK.
TheHost Selection window closes. The host name appears in the Host Name field of theAdd
Configuration File window.

In the File Namefield, type the full path nameof the file.

Click Apply.

Uploading a Configuration Filewith the CLI

TheAdd Target Local command is the same for Pre-actions, Post-actions, Configuration files,
Macros, and Probes. The following syntax is for Configuration files. This command creates a file
declaration automatically. It cannot be used to add a file to an existing declaration.

In the CLI syntax, a category under the default Local categories is mandatory. See Example 5–1 on for
theAdd Local Category CLI command. See “Add Target Local (-atl) Command” on page 270.

#! /bin/bash

function login {

echo -n “Type your user name:”

read user

echo -n “Type your password:”

read password

}

function distro {

echo “Active distributions are:”

uce_cli -ld -u “$user” -p “$password”

echo -n “To which distro should this file be added?”

read distro

echo }

function category {

echo “Under which category should this file be added?”

echo “A file declaration will be created automatically.”

echo “Valid answers: any subcategory under Configuration files. See list:”

uce_cli -fc -T “Configuration files” -sons -D $distro -u “$user” -p “$password” > tmp.file

sed “s/ROOT\/Local\/Configuration files//” tmp.file

echo -n “Start your answer with / :”

read parent

rm tmp.file

echo

}

function setup {

echo -n “Type the full path name of the file to upload: “

read pathname

echo -n “Type a version suffix for this version of the file: “

read version
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echo -n “Type a display name for the local file: “

read displayName

}

login

distro

category

setup

uce_cli -atl -f “$pathname” -pT “Configuration files$parent” -tF “$displayName” -v “$version” \

-D $distro -u “$user” -p “$password”

Macros
Amacro is a short script that outputs a single line. This output replaces amacro sign in a local
Configuration file.

Themacro value is used to customize a Configuration file for its host machine. You create a job that
installs a Configuration file onmultiple hosts.

This Configuration file has <^AM^>macro<^AM^> in its content, wheremacro is the name of themacro
in the knowledge base.

Each Agent sees the <^AM^> sign and runs the namedmacro script. The result of themacro run is a
line of local data. The value of themacro is entered in place of themacro sign.

EXAMPLE 5–9UsingMacros

You are reorganizing your network servers. You will be reconfiguring the /etc/hosts file for
multiple hosts, perhaps several times. Instead of changing this file for every host every time, you
create versions of this file and upload them as Configuration files. In each version, you replace the
specific local host namewith: <^AM^>hostname<^AM^>

You create a script named hosname.sh:

#!/bin/sh -f

# find local host name

hostname

You upload hostname.sh as amacro called hostname to the local knowledge base. You send the
Configuration file as part of a job. Each agent that receives the file, gets themacro sign, downloads
the hostnamemacro, and executes hostname.sh, which replaces <^AM^>hostname<^AM^>with
the real local host name on each host.

WritingMacros
Whenwritingmacros:

� Make sure that the name of themacro script is the same as themacro sign in the files.
� Make sure themacro outputs the appropriate string.
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The value of themacro, that is seen in the Configuration file, is the value that was given when the
Configuration file was installed and the agent ran themacro from the knowledge base. If you create a
macro that changes its value dynamically (or if you edit the content of themacro file), changes do not
apply to the remote host files. If you want to change the content of the Configuration files with a new
macro, you will have to upload themacro to the knowledge base and re-install the file on the hosts,
letting the agents run the newmacro.

UploadingMacros
In this procedure you addmacros to the local knowledge base. Use this procedure to store local
macro scripts, which will later be automatically downloaded and run onmultiple hosts. You can
create a category underMacros before uploading amacro (see “Adding Categories” on page 79).

� ToAddaMacro

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows Local components applied to the selected distribution.

From the Components list, select Local/Macros/[category].

Do one of the following:

� From the tool bar, click theAdd Component button.
� Right-click the selected category and choose Local ->Add.
� From the Components menu, choose Local ->Add.

TheAddMacro window opens.

Type a display name for the component thatwill point to themacro.

This should not be the complete file name, but it should be a name that is easily understood.

Type a free-text description.

Check each distribution towhich this file should be applied.

Select a sourcemachine:

� If the console has access to the file, select Console.
� If a remotemanaged host has access to the file, selectManagedHost.
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Note –Remote upload is limited to 5Mb; console upload is unlimited. It is recommended that you
upload from the console whenever possible.

� ToUploadaMacro from theConsoleMachine
If you selected console, follow this procedure. If you selectedManagedHost, go to “ToUpload a
Macro from aManagedHost” on page 118.

Click the Select File button of the File Namefield.

The Choose File window opens.

Browse to and select the relevant file.

ClickOpen.

The Choose File window closes, and the path name appears in the File Name field of theAddMacro
window.

Click Apply.

The Status column indicates when the upload is done. Click Close to close the window, or Reset to
addmore.

� ToUploadaMacro fromaManagedHost
If you selectedManagedHost, follow this procedure.

Click the Select Host button of theHost Namefield.

TheHost Selection window opens.

Select themanagedhost that has the file, and clickOK.

TheHost Selection window closes. The host name appears in the Host Name field.

In the File Namefield, type the full path nameof the file.

Click Apply.

The Status column indicates when the upload is done. Click Close to close the window, or Reset to
addmore.

Adding aMacrowith the CLI

TheAdd Target Local command is the same for Pre-actions, Post-actions, Configuration files,
Macros, and Probes. The following syntax is forMacros.
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In the CLI syntax, a category under the default Local categories is mandatory. See Example 5–1 on
Example 5–1 for theAdd Local Category CLI command. See “Add Target Local (-atl) Command”
on page 270.

#! /bin/bash

function login {

echo -n “Type your user name:”

read user

echo -n “Type your password:”

read password

}

function distro {

echo “Active distributions are:”

uce_cli -ld -u “$user” -p “$password”

echo -n “To which distro should this script be added?”

read distro

echo

}

function category {

echo “Under which category should this Macro be added?”

echo “Valid answers: any subcategory under Macros. See list:”

uce_cli -fc -T “Macros” -sons -D $distro -u “$user” -p “$password” > tmp.file

sed “s/ROOT\/Local\/Macros//” tmp.file

echo -n “Start your answer with / :”

read parent

rm tmp.file

echo

}

function setup {

echo -n “Type the full path name of the file to upload:”

read pathname

echo -n “Type a display name for the macro:”

read displayName

}

login

distro

category

setup

uce_cli -atl -f “$pathname” -pT “Macros$parent” -tM “$displayName” \

-D $distro -u “$user” -p “$password”

Editing Files
After you have added local files to your knowledge base, youmay edit them in various ways. Youmay
edit the files on the knowledge base.Any editing you do will affect the file that is stored to the
knowledge base, not the original file.
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Youmay edit the files you installed onmanaged hosts, making the changes directly on the hosts.
These files are known as Host files. Youmay open and save changes to the content of a Host file using
SunUpdate Connection – Enterprise, but the changes will not be affected in the knowledge base
unless you add the file as a knowledge base file.

Editing Local File Properties
In this procedure, you edit the properties of Configuration files, File Declarations,Macros,
Post-actions, Pre-actions, and Probes in the knowledge base. If your environment changes, you can
use this procedure to change the distributions to which Local Files are applied.

� ToEdit Local File Properties

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows Local components applied to the selected distribution.

From the Components list, under Local/default category/[user category>]/, select the relevant
Post-action, Pre-action, Probe,Macro, Configuration file, or File Declaration.

Do one of the following:

� From the tool bar, click the Edit Local Component button.
� Right-click the selection and choose Local -> Edit.
� From the Components menu, choose Local -> Edit.

AProperties window opens.

Change the list of selected active distributions.

Change any of the displayedproperties.

Click Apply.

The changes are uploaded to the knowledge base. If you addedmore distributions to the selected list,
the file itself is uploaded to the knowledge base of the new distributions.

EditingKnowledgeBase Files
In this procedure you edit the contents of a Post-action, Pre-action, Probe,Macro, or Configuration
file that has already been uploaded to the local knowledge base.
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� ToEdit a Local File

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.
The Components list shows Local components applied to the selected distribution.

From the Components list, under Local/default category/[user category]/, select the relevant
Post-action, Pre-action, Probe,Macro, or Configuration file.

Do one of the following:

� From the tool bar, click the Open knowledge base File button.
� Right-click the selected component and choose Local -> Open -> Knowledge Base File.
� From the Components menu, choose Local -> Open -> Knowledge Base File.

The Knowledge Base File window opens, displaying the contents of the file that is in the
knowledge base.

Make any changes to the contents of the knowledgebase file.

Check each distribution towhich the changes should be applied.

Click Apply.
The Status column indicates when the upload is done.

Click Close to close thewindow, or Reset tomakemore changes.

ReplacingKnowledgeBase Files
In this procedure, you attach new files to existing listings of Post-actions, Pre-actions, Probes,
Macros, and Configuration files. Use this procedure to replace a knowledge base file with a different
one from amanaged host.

� ToReplaceKnowledgeBase Files

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.
The Components list shows Local components applied to the selected distribution.

From the Components list, under Local/default category/[user category]/, select the relevant
Post-action, Pre-action, Probe,Macro, or Configuration file.
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Dooneof the following:

� From the tool bar, click the Upload KnowledgeBase File button.
� Right-click the selected file and choose Local -> Upload.
� From the Components menu, choose Local -> Upload.

TheAttach Target File window opens.

Select a sourcemachine:

� If the console has access to the file, select Console.
� If a remotemanaged host has access to the file, selectManagedHost.

Note –Remote upload is limited to 5Mbytes. Console upload is unlimited. It is recommended
that you upload from the console whenever possible.

� ToAttach a File from theConsoleMachine
If you selected console, follow this procedure. If you selectedManagedHost, go to “ToUpload a
Macro from aManagedHost” on page 118.

Click the Select File button of the File Namefield.
The Choose File window opens.

Browse to and select the relevant file.

ClickOpen.
The Choose File window closes, and the path name appears in the File Name field of theAttach
Target File window.

Check the distributions towhich youwant to apply these changes.
If you check a distribution that does not have the original file, the attach will fail but no damage will
be done.

Click Apply.
The Status column indicates when the upload is done.

Click Close to close thewindow.

� ToAttach a File fromaManagedHost
If you selectedManagedHost, follow this procedure.

Click the Select Host button of theHost Namefield.
TheHost Selection window opens.
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Select themanagedhost that has the file, and clickOK.

TheHost Selection window closes. The host name appears in the Host Name field.

In the File Namefield, type the full path nameof the file.

Check the distributions towhich youwant to apply these changes.

If you check a distribution that does not have the original file, the attach will fail but no damage will
be done.

Click Apply.

The Status column indicates when the upload is done.

Click Close to close thewindow.

DeletingKnowledgeBase Files
You can remove anything that you (or another user) added to the Local knowledge base, but before
deletion, make sure the component is not already included in a profile or scheduled job. Deleting a
local file that will be referenced later will cause the job to fail. In this procedure you delete
Post-actions, Pre-actions, Probes,Macros, Configuration files, or File Declarations.

� ToDelete a Local File

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows Local components applied to the selected distribution.

From the Components list, select the component youwant to delete.

Do one of the following:

� From the tool bar, click the Delete Local Component button.
� Right-click the selected component and choose Delete.
� From the Components menu, choose Delete.

The Delete Local Component window opens.

Check the distributions fromwhich youwant to delete the component.

Youmay leave it on the component list of some distributions and delete it from others, or delete it
from all.
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Click Apply.
The Status column indicates when the change is done. Youmight have to wait until the console is
updated with the changes; time depends on your local environment configuration.

OpeningHost Files
After you have uploaded Local Configuration files to the knowledge base (see “Uploading Local
Configuration Files” on page 113), and installed these files onmanaged hosts (see “Distributing Local
Files” on page 168), you can access the files from the hosts. This feature allows you to view, edit, and
save-as the content of files on remote hosts, directly on their hosts.

Make sure that:

� The file is installed on themanaged host
� Themanaged host is online
� Themanaged host is not busy with a job

� ToAccess a File fromaRemoteHost

Log inwith full permissions or as the adminuser.

From thedrop-down list in the tool bar, select a distribution-architecture.
The Components list shows Local components applied to the selected distribution.

Select a host. You can viewfiles fromonly one host at a time.

From the Components list, select Local/Configuration files/[category]/file declaration.
The Configuration files on the knowledge base are versions for knowledge base organization. Select
the File Declaration to point to the installed file on the remote host.

Local

-->Configuration Files

---->[category]

------>File Declaration (path name of file on host)

-------->File version (on knowledge base)

Dooneof the following:

� From the tool bar, click the OpenHost File button.
� Right-click the File Declaration and choose Local -> Open ->OpenHost File.
� From the Components menu, choose Local -> Open ->OpenHost File.

The Remote File Editor window opens.Wait until the contents of the remote file are uploaded
and displayed.
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Change the text as needed.

Doone of the following:

� Click Cancel, to close the file without changing it.
� Click SaveAs, to save a copy of the file, with any changes included. The SaveAs window opens,

fromwhere you can determine the path name of the copy.
� Click Save, to overwrite the file on the selected remote host.

The File Editor window closes.
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Solaris Baselines

This chapter describes how to use Solaris baselines to update your Solaris hosts with patches.

UsingBaselines toUpdate a Solaris HostWithPatches (Task
Map)

ASolaris baseline is a dated collection of patches, patchmetadata, and tools. Sun releases Solaris
baselines on amonthly basis.When you install the patches of a baseline on a host, that host is
considered to be compliantwith that baseline.

Baselines only pertain to Solaris hosts.

Using Solaris baselines enables you to easily know the patch level of your hosts. For example, you
install some test hosts with a particular baseline. Then, you test these hosts for a period of time to see
whether the patches in this baseline are stable enough to be used on your production hosts.When the
testing reveals that this baseline is stable, you can install the same baseline you tested on your
production hosts.

You canmodify a baseline to create a custom patch set by the use of black lists and white lists.Ablack
list is a list of patch IDs that you never want to be applied to a host.Awhite list is a list of patch IDs
that you always want to be applied to a host.

Solaris baselines appear as a category in the Components list. The Solaris Baselines category contains
a list of dated baselines. Each dated baseline contains these three patch sets:

� Full – Includes all Solaris patches
� Recommended – Includes Solaris recommended patches and security patches
� Security – Includes only Solaris security patches

Selecting a baseline patch set and choosing Details from the Components menu shows you the list of
the patches in the baseline.
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An installed baseline appears in the Components list marked as (Installed). If you install the
baseline and use a policy as a black list, the baseline is notmarked as (Installed) even though it has
been installed.

The following table identifies the tasks that youmight performwhen using Solaris baselines to
update a systemwith patches.

Task Description For Instructions

Create a white list of patches. Your white list must include the
baseline you want to install and can
optionally include any patches that you
want to always install.

“To Create a Solaris Baseline
White List” on page 128

(Optional) Create a black list of
patches.

You can optionally create a black list
that includes the patches that are never
to be installed.

“To Create a Solaris Baseline
Black List” on page 130

Perform a Solaris baseline
compliance analysis.

The result of this analysis is a list of the
number of patches to be installed to
bring it in to compliance with the
baseline, the white list, and the black
list you specify.

“To Perform a Solaris Baseline
ComplianceAnalysis” on page
131

Install a Solaris baseline on a
managed host.

This procedure describes how to use
the white list and black list you created
to deploy a Solaris baseline to selected
Solaris hosts.

“To Install a Solaris Baseline”
on page 132

View details about a baseline
installation job.

Youmust have run a Solaris baseline
deployment job or a Solaris baseline
compliance analysis job that has
successfully completed before you can
view details.

“To View a Summary of a
Baseline Installation Job”
on page 133

� ToCreate a Solaris BaselineWhite List
This procedure uses the profilemechanism to create a white list that contains a baseline and an
optional white list.

For information about working with Solaris baselines, see the following:

� “To Create a Solaris Baseline Black List” on page 130
� “To Perform a Solaris Baseline ComplianceAnalysis” on page 131
� “To Install a Solaris Baseline” on page 132

Note –The terms update and patch are the same.
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From theHosts list, select the host or group forwhich youwant to create a baselinewhite list.
Note that the white listmust contain a baseline and can optionally include a list of patches to install.

Select the baseline youwant to install.

a. From the Components list, expand the Solaris Baselines category.

b. Find and expand the datedbaseline youwant to install.

c. Select one of the followingpatch sets:

� Full – Includes all Solaris patches
� Recommended – Includes Solaris recommended patches and security patches
� Security – Includes only Solaris security patches

d. (Optional) View the contents of the baseline, by choosingDetails from the Componentsmenu.
TheDetails window opens.

e. Add the baseline to theAction list by choosing Required from the Componentsmenu.

Note –You can select only one baseline to for installation on a host, hosts, group or groups. If you
select another baseline for the same host, hosts, group, or groups and choose Required from the
Components menu, an errormessage appears.

� To replace the current baselinewith the one you just selected, clickOK.

� Touse the original baseline, click Cancel.

(Optional) Addone ormore patches to thewhite list.

a. From the Components list, expand the Patches category.

b. Find and expand the patch ID range for the patch or patches youwant.

c. (Optional) Viewadescription of the patch.
Choose Details from the Components menu.

The Component Information window opens. This window presents information on the
following tabbed pages:

� General tab – Shows the patch ID, the size of the patch, and the platform for which the patch
was created.

� Incident tab – Shows the patch ID, the patch type, and aURL to the patch READMEfile.
� Dependencies tab – Shows any patches that depend on the one you selected.
� Installed tab – Shows you the list of hosts on which the patch has been installed.
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d. Select a patch ID, and then choose Required from the Componentsmenu.

The patches youmark as required are added to theAction list.

e. Repeat Substeps b throughd for each patch youwant to add to thewhite list.

Choose SaveAs Profile from theActionmenu.

The Profile Editor window opens.

Review the list of patches in theAction list.

Give the profile a name that you can easily remember.

Using identifiable names is especially helpful if you want to use this profile again for other jobs.

ClickOK to save the profile.

The profile is saved and appears in the Profiles window.

Click Close to dismiss the Profileswindow.

� ToCreate a Solaris BaselineBlack List
This procedure describes how to use the policymechanism to create a black list of updates that are
never to be installed.

Note –The terms update and patch are the same.

From theHosts list, select the host, hosts, group, or group forwhich youwant to create a black list.

Open the Policieswindowby choosing Policies from the Toolsmenu.

Click theNewbutton to open the Policy Editorwindow.

Give the policy a name that you can easily remember.

Using identifiable names is especially helpful if you want to use this policy again for other jobs.

Expand the Patches category.

Find and expand the patch ID range inwhich the patch or patches youwant to add to the black list is
found.

Select a patch ID, and add the patch to the black list by choosingNo from theApply Fix drop-down
menu.
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Repeat Steps 6 and 7 for each patch youwant to add to the black list.

ClickOK to save the policy on the Policieswindow.

� ToPerformaSolaris Baseline ComplianceAnalysis
This procedure describes how to perform a Solaris baseline compliance analysis. The result of this
analysis is a list of the number of patches to be installed to bring it in to compliance with the baseline,
the white list, and the black list you specify.

Youmust have a Solaris baseline white list and an optional black list to perform this task. Formore
information about creating these lists, see the following:

� “To Create a Solaris BaselineWhite List” on page 128
� “To Create a Solaris Baseline Black List” on page 130

Note –The terms update and patch are the same.

Open theNew Jobwindowby choosingNew from the Jobsmenu.

Select Simulate to run the job in simulationmode.

Open the Task Editorwindowby clicking theAdd (New) Task button.

a. Choose yourwhite list from the Profiles drop-downmenu.

b. (Optional) Choose your black list from the Policy drop-downmenu.

c. Open the Select Hostswindowby clicking theHost Select button.

d. Select the host or group, click theAddbutton (right-facing arrow) to add it to the list, and then
clickOK.

e. ClickOK to save the task.

Repeat Step 3 for each baseline compliance analysis task youwant to run as part of this job.

(Optional) Click theOptions tab to specify the task execution parameters.

If you plan to havemore than one task in this job to run analyses against more than one baseline, you
can select Parallel to run the tasks simultaneously. By default, tasks are run sequentially.

ClickOK to submit the job.
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(Optional) View the progress of the job running on the host by choosingHost Progress from theHost
list.

View the job summarywhen the job completes.

Formore information, see “ToView a Summary of a Baseline Installation Job” on page 133.

� To Install a Solaris Baseline
This procedure describes how to deploy a Solaris baseline to selected Solaris hosts.

Youmust have a Solaris baseline white list and an optional black list to perform this task. Formore
information about creating these lists, see the following:

� “To Create a Solaris BaselineWhite List” on page 128
� “To Create a Solaris Baseline Black List” on page 130

Note –The terms update and patch are the same.

Open theNew Jobwindowby choosingNew from the Jobsmenu.

Select Deploy to deploy the baseline to the selected hosts.

Open the Task Editorwindowby clicking theAdd Task button.

a. Choose yourwhite list from the Profiles drop-downmenu.

b. (Optional) Choose your black list from the Policy drop-downmenu.

c. Open the Select Hostswindowby clicking theHost Select button.

d. Select the host or group, click theAddbutton (right-facing arrow) to add it to the list, and then
clickOK.

e. ClickOK to save the task.

Repeat Step 3 for each baseline deployment task youwant to run as part of this job.

ClickOK to submit the job.

(Optional) View the progress of the job running on the host by choosingHost Progress from theHost
list.
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View the job summarywhen the job completes.
Formore information, see “ToView a Summary of a Baseline Installation Job” on page 133.

(Optional) Performaprofile compliance check of the selected hosts.
See “To Check Profile Compliance” on page 74.

Note – Perform this check only if you used a profile to install the baseline andwhite list. If you also
used a policy to specify a black list, this check will show the host to be non-compliant.

� ToViewaSummaryof aBaseline Installation Job
Youmust have run a Solaris baseline deployment job or a Solaris baseline compliance analysis job
that has successfully completed.

� “To Perform a Solaris Baseline ComplianceAnalysis” on page 131
� “To Install a Solaris Baseline” on page 132

Note –The terms update and patch are the same.

Select the job forwhich youwant viewa summary from the Jobs list.

Open the Job Summarywindowby choosing Summary from the Jobsmenu.

View the following summary information for each task:

� Host – Shows the host name onwhich you ran the task.
� Distribution – Shows the operating system and platform architecture of the host.
� Task – Shows the task type.
� Number of Changes – Shows the number of changesmade or will bemade to the host.

(Optional) Viewdetails about a task.

a. Select a task from the table, and click the ViewChanges button.
TheHost Changes Report window opens.

b. Select a patch ID from the table, and click the Component Info button.
The Incident Information window opens.

c. View information about the patch by clicking one of the following tabs:

� README– Shows the URL to the patch READMEfile.
� General – Shows the patch ID, patch category, and release date.
� CVE ID – Shows the CVE ID of the patch.
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� Package – Shows the packagesmodified by the patch.
� Obsolete – Shows the patches that this patch renders obsolete.

d. Click Close to dismiss the Incident Informationwindow.

e. Click Close to dismiss theHost Changes Reportwindow.

Repeat Step 4 for each task forwhich youwant to viewdetails.

Click Close to dismiss the Job Summarywindow.
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SystemManagement Profiles

This chapter describes the predefined profiles and how you can deploy them to run system-wide
checks and remote restarts.

The following profiles are described:

� Check Bugs Fix
� Check Security
� Check System
� CheckWithdrawn Patches
� Local Software Review
� PerformRestart
� PerformRestart + Reconfigure
� UpgradeAll Components

The procedures in this chapter include some advanced features, which will be explained inmore
detail in later chapters. They are given here to help you get started with execution of predefined
profiles even before you are familiar with the details of SunUpdate Connection – Enterprise
environmentmanagement.

This chapter covers the following topics:

� “Terms” on page 136
� “Predefined Profiles” on page 136
� “Creating Policies for Predefined Profiles” on page 138
� “Running Predefined Profiles” on page 140
� “Running Restart Predefined Profiles” on page 143
� “ConfirmingActions” on page 142
� “Handling Large Jobs” on page 145
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Terms
This chapter uses the following terms:

Conflict When different components need different dependent
components and these dependencies cannot exist on the same
system together (for example, two different packages need two
different versions of the same library), there is a conflict. Sun
Update Connection – Enterprise solves such conflicts by finding a
version of the dependent components that works for both base
components.

Dependency Most Linux and Solaris components depend upon the prior
installation of existing libraries or other packages to operate in
known system configurations. These other components are
dependent components, or dependencies.

Predefined Profile Set of compliancemappings provided with SunUpdate
Connection – Enterprise that performs a full-system check and
fix, a remote restart, or a remote restart with reconfiguration.

PredefinedProfiles
SunUpdate Connection – Enterprise provides various profiles already predefined.While you will be
creating profiles that define system functions (profiles for web servers, printer servers, and so on), the
predefined profiles check complete systems for specific issues or preform restarts on the remote
hosts.

The following table briefly describes the predefined profiles.

ProfileName Finds, and Fixes onDeploy SunUpdate Connection – Enterprise Actions

Check System Dependencies Installs or upgradesmissing dependent
components, according to the rules of the
knowledge base of the selected distribution.

Check Security Software to be patched against
security holes

Every security instance known to the knowledge
base of the selected distribution is checked, to see
whether it can fix installed components.

Check Bug Fixes Software to be patched for known
bugs

Every bug fix patch known to the knowledge base
of the selected distribution is checked, to see
whether it can fix installed components.

Terms
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ProfileName Finds, and Fixes onDeploy SunUpdate Connection – Enterprise Actions

Local Software
Review

Local software that is in Software,
rather than Local RPMs or Local
PKGs, to be replaced with a
same-named certified software

Your local components are checked against the
knowledge base of the selected distribution.

This profile helps you find the local components
under Software.

If you confirm the actions of this profile, Sun
Update Connection – Enterprise replaces the
local version with a certified version.

UpgradeAll
Components

Software to be upgraded Every installed component is checked against the
knowledge base of the selected distribution, to
see if installed components can be upgraded.

Check withdrawn
patches (relevant to
Solaris systems only)

Patches and updates that have been
withdrawn by the vendor and
should not be used

Installed patches are checked against the
knowledge base of the selected distribution to see
if the vendor has withdrawn the patch.Apatch
might be withdrawn due to a better patch or
versionmaking the withdrawn one obsolete, or
due to bugs in the patch itself. SunUpdate
Connection – Enterprise will upgrade to the
correct patch, if available. Or if not, downgrade
back to the vendor supported version.

PerformRestart Restarts selected hosts If an action in a job needs a restart to have the
deployment applied to the computer, you will see
a reminder in the job ToDo list that you should
run a restart profile.

The Notifications category in the tree will show
which hosts should be restarted.

PerformRestart +
Reconfigure (relevant
for Solaris systems
only)

Restarts Solaris hosts and performs
specific post-installation
reconfigurations

If an action in a job needs a restart to have the
deployment applied to the computer, you will see
a reminder in the job ToDo list that you should
run a restart profile.

The Notifications category in the tree will show
which hosts should be restarted.

Policies for PredefinedProfiles
You can deploy, or simulate deployment, of predefined profiles in jobs.When setting up the job, you
include a policy.Apolicy determines how the job handles dependencies. During predefined profiles,
all components are considered dependencies, so the policy determines the trends and automation of
the deployment of the predefined profile as a whole.

Policies for Predefined Profiles
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CreatingPolicies for PredefinedProfiles
In this procedure you create a policy designed to be used in jobs that deploy predefined profiles.

� ToCreate aPolicy for PredefinedProfiles

Log in as any user.

Do one of the following:

� From the tool bar, click the Policies button.
� From the Tools menu, choose Policies.

The Policies window opens.

Click theNewbutton.

The Policy Editor window opens.

Select a distribution and type a name for the policy.

Set the policy according to the policy recommendations.

See “Policy Recommendations for Predefined Profiles” on page 139.

To set a policy, select an item in the Components list and then select a predefined answer (AskMe,
Yes, No) for the listed SunUpdate Connection – Enterprise actions (Install, Uninstall, Upgrade
From, Downgrade From, Apply Fix, Ignore File Conflict).
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Tomake this policy applicable tomultiple distributions, click theMulti Distro button.
See “ToAlign Component Settings forMultiple Distributions” on page 210.

ClickOK.
The Policy Editor window closes. The new policy is listed in the Policies window.

Policy Recommendations for PredefinedProfiles
To automate component handling of jobs that deploy a predefined profile, set Yes policies to Software
or to Local for specific deployment actions.

TABLE 7–1AutomatingPredefinedProfiles

ProfileName Component Set YES to:

Check System Software and Local Apply Fix

Check Security Software and Local Apply Fix

Check Bug Fixes Software and Local Apply Fix

UpgradeAll
Components

Software and Local Upgrade From

Check withdrawn
patches

Software and Local Apply Fix, Upgrade From, Downgrade From

� Local Software Review Policy Recommendations
Fully automating the Local Software Review predefined profile without checking what the
components are that you are going to replace, is not the best handlingmethod.Abetter method is
to check the local components and set a relevant policy.
When you run the Local Software Review, SunUpdate Connection – Enterprise finds the
complete list of uncertified components (NCOs) that are listed under Software, rather than under
Local RPMs or Local PKGs. This placement is done if you upload anNCO that has the same
name as a certified component.
If you are ready to replace local software with certified software (have better deployment rules)
from the universal server, set Upgrade From andDowngrade From toYes.

� NoPolicies for Restart Profiles
PerformRestart and PerformRestart and Reconfigure are different from the profiles. These are
not tests. They do not perform actions on individual components, so no policy is relevant.

� Ignore File Conflicts Policy
Be wary of setting a Yes policy to the Ignore File Conflicts action. This action needs you to take
responsibility for results of forcing an action, regardless of the knowledge base rules. It is
recommended that you always leave this action asAskMe.

� LockingComponents fromChange
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If you automate a job with the policy recommended here, you do not have to set the policy to all
Software, all Local RPMs, or all Local PKGs. In the components list, set a general policy on
categories. Find the package groups or versions that you want to lock from change and give them
aNo policy.All packages in a category inherit the policy of the parent, except for those with a
different policy.

Creating aPolicyWith theCLI
The CLI command to create a policy for a predefined profile is the same as for creating any policy,
-aca. The parameter that sets a policy forApply Fixes is -fix. The following example shows how to
setApply Fixes to Yes for all Software. See “Add PolicyAttribute (-aca) Command” on page 271.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo -n “Enter the name of a policy or create a new one:”

read policyName

uce_cli -aca -C “$policyName” -T “Software” -fix yes -u “$user” -p “$password”

PredefinedProfiles in Jobs
Jobs that include predefined profiles function differently than other Complex Jobs. The following
tasks explain how to set up and handle these jobs.

RunningPredefinedProfiles

� ToCreate Jobwith aPredefinedProfile
In this procedure you deploy predefined profiles onmanaged hosts, with a policy you created in the
previous task. You will use the Complex Jobs feature, but this procedure will give the simplest steps. If
you are restricted to run simulation jobs only, you can perform this task by using Simulate instead of
Deploy.

Note –The Check System predefined profile, especially, should be run before you use a host as a
source in a clone job (see “Cloning Inventories” on page 158), to ensure that you are not cloning a
host with dependency issues.

Before you begin a job on a Solaris machine, make sure the PKG deployment preferences are
appropriate for your local needs. See “Host Preferences – PKGs” on page 301.

BeforeYouBegin
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Dooneof the following:

� From the tool bar, click the New Job button.
� From the Jobsmenu, choose New.

TheNew Job window opens.

Type a name for the job.

Choose a jobmode:

� To discover the list of issues, without touching the hosts, check Simulate.
� To discover and fix the issues by changing host inventories, check Deploy.

(If you are restricted to run simulation jobs only, themode options are disabled. The job will be
run in simulatemode.)

Type a free-text description.

Open the Task Editor.

Type a name for the first task of the job.

In the Profile drop-down list, select one of the PredefinedProfiles.

Click theHosts button next to theHosts field.

The Select Hosts window opens.

Select a host or group and click theAddbutton.

The host or group is added to the SelectedHosts list.

Add asmany hosts and groups as you want.

ClickOK.

TheHosts window closes. Selected hosts are displayed in the Hosts field of the Tasks tab.

In the Policy drop-down list, select a policy:

� Select theAlways askme policy to be asked for confirmation before anything is done. This also
allows you to see the full list of actions and to break up a large job if needed.

� Select a policy that you created (Yes toApply Fixes, for example), if you want the job to be done
automatically, without your confirmation.

Click theAdd Task button.

The task name appears in the tasks list.
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If you want to runmultiple predefined profiles on the selected hosts, you can createmore tasks, each
with a different profile. However, it is recommended that you run only one predefined profile the first
time, to ensure that the job is not so big that it times out.

ClickOK.

TheNew Job window closes and the job begins. See the Jobs panel in themain window.

Running a Predefined ProfileWith the CLI

The CLI submit job command is used to deploy or simulate a predefined profile. The example given
here deploys the Check System profile with theAlways askme policy. See “Submit Job (-sj)
Command” on page 274.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo -n “Type a name for this job:”

read jobName

echo “The list of hosts is:”

uce_cli -lah -u “$user” -p “$password”

echo “The list of groups is:”

uce_cli -lg -u “$user” -p “$password”

echo “Do you want to do this check on a host or on a group (h | g)?”

read hostgroup

echo “Copy the name of a host or group to be checked”

read selected

uce_cli -sj -j “$jobName” -P “Check system” -C “Always ask me” -$hostgroup “$selected” \

-us -dp -u “$user” -p “$password”

ConfirmingActions

� ToConfirmActions
If you selected theAlways askme policy, or if the job found actions to do on dependencies for which
you did not set a policy, the job pauses, waiting for you to confirm or deny suggested fixes.
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Note – If your user account has Notify when: Job pauses selected, youwill receive an email when you
need to confirm actions to continue a job. Therefore, you can schedule the predefined profile to run
during idle hours and confirm the actions when you receive notification. See “To Create a
Full-PermissionUserAccount” on page 47 for details on notification, and “To Create a Feature-Rich
Complex Job” on page 203 for details on scheduling jobs.

Make sure the Jobs panel of themainwindow is available: from theViewmenu, choose Jobs.

From the Jobs list (left-hand frame), click a job namewith the confirmation icon.
The tasks of the job appear in the Tasks list (middle frame).

Select a task namewith the confirmation icon.

Doone of the following:

� From the tool bar, click the Confirmation button.
� Right-click the selected task and choose Confirmation.
� From the Jobsmenu, choose Tasks -> Confirm.

The Confirmation window opens and shows suggested actions.

If a confirmation question dealswith a component forwhich youneedmore information, select the
question and click theDetails button.
The Component Information window opens.

Take note of relevant data and then clickOK to close the Component Informationwindowand return
to the Confirmationwindow.

In the Confirmationwindow, select Yes to the questions you confirmandNo to those youdonotwant
SunUpdate Connection – Enterprise to performon the selected hosts.

� If the job was in Deploymode, the confirmed actions are done on the selected hosts.
� If the job was in Simulatemode, the actions and results are calculated, giving you an accurate

estimation of the required changes.

RunningRestart PredefinedProfiles

� ToCreate a Jobwith aRestart PredefinedProfile
In this procedure you run the predefined profiles that restart remote hosts. This procedure starts with
the Notifications category in the Inventory panel.

Before you begin a job on a Solaris machine, make sure the PKG deployment preferences are
appropriate for your local needs. See “Host Preferences – PKGs” on page 301.
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In themainwindow,make sure the Inventory panel is visible by choosing Inventory from theView
menu.

From theHosts list, select All Hosts and from the Component list, select Notifications or Restart.

If Restart is marked Installed, there are hosts that should be restarted.

To see the names of these hosts, right-click Restart and then clickDetails.

The Component Information window opens. The Installed tab lists hosts that need a restart. Make a
note of these hosts and close the Component Information window.

From the tool bar, click theNew Jobbutton.

TheNew Job window opens.

Type a nameanddescription for the job.

Click theDeploy radio button.

Open the Task Editor.

Type a name for the task of the job.

In the Profile drop-down list, select PerformRestart (or PerformRestart + Reconfigure, for Solaris
hosts, and only if the notificationmentioned a needed reconfiguration).

Click theHosts button next to theHosts field.

The Select Hosts window opens.

Select the hosts younoted from theNotification or Restart list and click Add.

You can add any host that you want to restart, even if it was notmarked in Notifications.

ClickOK.

TheHosts window closes. Selected hosts are displayed in the Hosts field of the Tasks tab.

Click theAdd Task button.

The task name appears in the tasks list.

ClickOK.

TheNew Job window closes and the job begins. The selected hosts are restarted.
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Handling Large Jobs
Jobs that execute predefined profiles can build up a list of hundreds of actions to do. This procedure
explains how to handle such large jobs, by breaking up a large system-wide fix into smaller, faster
jobs. Use this procedure if you get a confirmation list withmany actions (for example, more than 30
action items). It is applicable only for predefined profiles; in other jobs, if you answer No to a
confirmation question, the Dependency Resolver will search for a different solution or fail the job.

� ToHandle LargePredefinedProfile Jobs

In the Confirmationwindow, select Yes for someactions andNo to others.

ClickOK to start the job.

Wait for the job to finish, as shownby the Finished icon in the Jobs list, and then select it.

Do one of the following:

� From the tool bar, click the Rerun Job button.
� Right-click the job name and choose Run.
� From the Jobsmenu, choose ReRun.

The Rerun window opens.

Give the job a new,meaningful nameanddescription.

Check theDeploymode.

ClickOK.

The predefined profile runs again. In the Confirmation window of the continuation job, you will see
the actions to which you answeredNo in the previous run of this task.

Answer Yes orNo to the actions in the list and clickOK to run the job.

You can run a predefined profile in asmany jobs as you want.
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Inventories

This chapter describes the details of inventories and explains how to control hosts through
management of individual components.

The following topics are covered:

� “Terms” on page 147
� “Understanding Inventories” on page 148
� “Inventory Jobs” on page 154
� “Inventory Jobs with Local Scripts and Files” on page 166

Terms
This chapter uses the following terms:

Cost-Effective Manner in which the dependency resolver decides which solution
is optimal for a host; cost effectiveness is measured in number of
deployment changes needed by any one solution to fulfill a given
request.

dependency resolver (DR) Set of patented algorithms to describe a solution for a job.
Initiated by the agent application when a job is received.

DeployMode Jobmode that can change host inventory.

Inventory (1) List of components installed on amanaged host. (2) List of
components on the universal server.

Knowledge Base Sub-system of the SunUpdate Connection – Enterprise system
dependency server, acts as a proxy server for the universal server,
keeping dependency rules for CO deployment onmanaged hosts.

A local knowledge base is a private, on-site only, collection of
NCO listings and their deployment rules as generated by the
Local Expansion technology.

8C H A P T E R 8

147



Policy Set of confirmation rules for the implementation of the
dependency resolver and level of automation of dependency
handling.

SimulateMode Jobmode that produces a test of what would have happened if the
job had been in deploymode.

Understanding Inventories
SunUpdate Connection – Enterprise provides access to the inventory of certified components (COs)
in the universal server. Each supported distribution has its own knowledge base inventory.

You also have access to the inventory of everymanaged host, both COs andNon-Certified
Components (NCOs). The agent on a host scans themachine and brings you an inventory of all
installed components.

You can view the inventory of amanaged host within the inventory of the universal server, quickly
seeing what can be upgraded, installed, replaced, or uninstalled.

The inventory is displayed in the Components list layout. The levels are:

� Category – software components grouped together by function
� Package group –Holder of versions of a software
� Package – Points to one software component in the knowledge base

An inventory can contain different types of packages. The types are:

� CertifiedObjects (CO) –Under the Software category. COs are components certified by the
Certification Lab. In Solaris, Software includes PKGs from the CDs and Sun Freeware.

� NonCertifiedObjects (NCO) –Under the Local RPMs and Local PKGs categories. NCOs are
private, proprietary, or third-party components.

� Local Files –Under the Local/Pre-actions, Post-actions,Macros, Probes, and Configuration files
categories. Local Files are private files, scripts, executables, binaries that you use often on
multiple hosts.
Inventory jobs focus on the component level. You select a component from the inventory and
then apply a setting to it. The component settings are described in the following tables.

TABLE 8–1 Inventory Component Settings on Packages (RPM, PKG,NCO, Local File)

Setting Result if Package Installed Result if PackageNot Installed

Required Nothing is done. DR finds solution to install it.

NotAllowed DR finds solution to uninstall it. Nothing is done.
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TABLE 8–1 Inventory Component Settings on Packages (RPM, PKG,NCO, Local File) (Continued)
Setting Result if Package Installed Result if PackageNot Installed

Upgrade If there is a newer version for an installed
package, the package is upgraded.

If there is more than one version newer than
this package, themost cost-effective version is
chosen.

Nothing is done.

TABLE 8–2 Inventory Component Settings onCategories and PackageGroups

Setting Result if Packages Installed Result if PackagesNot Installed

Required If at least one package is installed, nothing is
done.

If no package in category/group is installed,
the one that is most cost-effective is installed.

NotAllowed All packages within category/group are
uninstalled.

If no package in category/group is installed,
nothing is done.

Upgrade All installed packages within category/group
are upgraded if newer versions exist.

Nothing is done.

For example, you want to install the cURLutility on your FTP servers. You select the FTP group in
the Hosts list. In the Components list, you select curl and apply the Required setting to it. You
right-click the action and choose Run on SelectedHosts. The job installs curl on the FTPhosts that
do not have it yet. It alsomakes sure that a list of dependent components is installed.

You can see the list of dependencies. Open the Inventory window, right-click the curl version you
want to install and choose Details. The Dependencies tab of the Component Information window
lists the components that are required by curl.

Viewing Inventories

� ToView the Inventory of theuniversal server
Each agent discovers the installed inventory on its managed host and sends it to the dependency
manager (DM), which updates the console. This procedure describes the Inventory panel of the
console’s main window.

From theViewmenu,make sure Inventory is selected.1
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From thedrop-down list on the tool bar, select a distribution-architecture.

The Components list shows the components of the selected distribution.

Make sure nohost is selected in theHosts list, and that the Show Installed Components button is
deselected.

The Components list shows all components in the knowledge base of the selected distribution.

To seemore information about a selected component, do one of the following:

� From the tool bar, click the Details button.
� Right-click the selection and choose Details.
� From the Components menu, choose Details.

The Component Information window opens.

� ToView the Installed Inventory of SelectedHosts

From theViewmenu,make sure Inventory is selected.

In theHosts list, select amanagedhost, group, ormultiple hosts andgroups (use Shift or Control to
selectmultiple items).

From thedrop-down list in the tool bar, select a distribution-architecture.

The Components list shows the components of the selected distribution.
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Choose the type of list youwant to view:

� Filtered –Click the Show Installed Components button, if you want to see only those
components which are installed on the selectedmanaged hosts.

� Complete – Leave this button deselected, if you want to see all components available for
download.

FurtherUnderstanding
� If you are a user with permissions restricted to specific groups, you see only the hosts of your

authorized groups.
� Components that are Solaris patchesmight have a Notifications category in the Rules tab of the

Component Information window, which explains if the host must be restarted (and possibly
reconfigured) to apply the patch or to complete a successful installation of the patch.

� If you have a local, private version of a certified component, it is not listed under Local, but under
Software. The name of your component is namebuild-date. You can use the Local Software
Review predefined profile to find these components (see “Predefined Profiles” on page 136).

� Some distributions contain components with the same name onmultiple architectures. In the
Inventory display, these components are named namearchitecture

� Components aremarked with different installation indicators:
� Installed –At least one package of this package group or category is installed on at least one

selectedmanaged host
� No Installedmark –Component is not installed on any selectedmanaged host but is

available for installation from the universal server
� Aratio – Some, but not all, selected hosts have this component installed

� The first number shows howmany of the selected hosts have this component installed
� The second number shows howmany hosts were selected

For example, you select 105 hosts from different groups. The System Environment
component is marked with (Installed 93/105). 93 of the selected hosts have System
Environment components installed on them.

Viewingan Inventorywith theCLI
The CLI command to view an inventory is for one specific host at a time. It outputs package names
only, not categories or package-groups. See “List Host Inventory (-lhi) Command” on page 259.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

4
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echo “The list of hosts is:”

uce_cli -lah -u “$user” -p “$password”

echo -n “Copy the name of the host whose inventory you want to see:”

read hostname

uce_cli -lhi -h “$hostname” -u “$user” -p “$password”

Saving Inventories

� ToSave an Inventory
In this procedure, you save an inventory of a host or of a group. Saving an inventory allows you to
restore a host to a previous state if needed, or to clone the inventory of a host or a group onto another
host (see “RestoringManagedHosts” on page 161). SunUpdate Connection – Enterprise
automatically saves inventories before deploying a job on a host.Automatic inventories have this
naming convention:

� For a host: hostname_Job_jobname_yymmdd_time
� For a group: groupname_Job_jobname_yymmdd_time

Use this procedure to save an inventory record with ameaningful name.

Before saving an inventory, you should run the Check System predefined profile on the host or group.
This will ensure that the saved inventory does not have dependency issues. If you will bemanaging
Solaris hosts, you should run the CheckWithdrawn Patches profile. This will replace withdrawn
Solaris patches with appropriate operating software. See Chapter 7.

From theHosts list, select a single host or a group.

Doone of the following:

� From the tool bar, click the Save Inventory to File button
� Right-click the selected host or group and choose Save Inventory ->To File.
� From theHosts menu, choose Save Inventory ->To File.

Adialog box opens with the date entered in the text-entry box.

Type a name for this inventory and then clickOK.

Saving aHost Inventorywith the CLI

The CLI command to save host inventory saves a record of the inventory of a single host. See “Save
Host Inventory (-shi) Command” on page 275.

BeforeYouBegin
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#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “The list of hosts is:”

uce_cli -lah -u “$user” -p “$password”

echo -n “Copy the name of the host whose inventory you want to save:”

read hostname

echo -n “Type a name for the inventory record:”

read savedInven

uce_cli -shi -h “$hostname” -s “$savedInven” -u “$user” -p “$password”

Saving a Group Inventorywith the CLI

The CLI command to save group inventory saves a record of the inventory for each host of the group.
This does not create a composite record. It creates a separate file for each host.The files are named
according to this convention hostname_suffix_mmddyyyytime. You create the suffix, a name or
number to identify this as a group inventory save. See “Save Group Inventory (-sgi) Command”
on page 276.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “The list of groups is:”

uce_cli -lg -u “$user” -p “$password”

echo -n “Copy the name of the group whose hosts inventories you want to save:”

read groupname

echo -n “Type a group suffix for the inventory saves:”

read suffix

uce_cli -sgi -g “$groupname” -sn “$suffix” -u “$user” -p “$password”

Example 8–2
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Inventory Jobs
You canmanipulate inventory components to create quick jobs. Use Inventory jobs to install,
uninstall, upgrade, or downgrade specific components.

Although Inventory jobs are quickly created and deployed, more control and features are available
with Complex jobs, which options offer more efficient environmentmanagement. Formore details,
see Chapter 11.

Creating Inventory Jobs

� ToChange the Inventory of aHost orGroup
This procedure explains how to create an inventory job tomanage the installed components of hosts.

Before you begin a job on a Solaris machine, make sure the PKG deployment preferences are
appropriate for your local needs. See “Host Preferences – PKGs” on page 301.

From theViewmenu,make sure Inventory is selected.

From thedrop-down list on the tool bar, select a distribution-architecture.

The Components list changes to display components of the selected distribution.

In theHosts list, select groups or hosts.

In the Components list, select a component.

Assign an action to the selected component.

Do one of the following:

� From the tool bar, click the Required, NotAllowed, or Upgrade button.
� Right-click the selected component and choose Required, NotAllowed, or Upgrade.
� From the Components menu, choose Required, NotAllowed, or Upgrade.

See Table 8–1 formore explanations of these options.
The action-component setting appears in theActions list.

Enter asmany component actions as youwant.

Tomake the inventory job applicable to hosts of different distributions:

� To select specific components from different distributions, change the selection of the
drop-down list of distributions in the tool bar. Find the relevant components and add the action
settings to theActions list.
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� To let SunUpdate Connection – Enterprise find components from other distributions that are
comparable to the ones you have in theActions list, click theMulti Distribution button (see “To
Align Component Settings forMultiple Distributions” on page 210).

Dooneof the following:

� From the tool bar, click the Run Job button.
� Right-click in theActions list and choose Run on SelectedHosts.
� From theActionsmenu, choose Run on SelectedHosts.

The Run Job window opens.

Give the job a nameand anoptional, free-text description.

Select amode for the job:

� Deploy –Do the actions on the selected hosts
� Simulate – Simulate the actions to estimate job time and full job actions

(If you have restricted permissions to run simulation only jobs, these options are disabled. The
job will be run in simulatemode.)

ClickOK.
The Run Job window closes. The job starts.

Comparing Inventories

� ToCompare Inventories
The Inventory Comparison feature shows the differences of installed components between two
hosts. The hosts must be of the same distribution-architecture, both in console and in CLI
commands.

Comparing inventories offers the following features:

� Check that managed hosts of same functions have same software.
� Run a job that replicates the software deployment of one host to another.
� Rollback amanaged host to a saved inventory.
� Compare the inventory of a host with the inventory of a group of hosts. Make a single host like

the rest of the hosts in a group.
There are different types of inventories to choose from. The following table describes each type.
� Current Inventory – Installed software as-is
� Automatically Saved Inventory – Before a job, SunUpdate Connection – Enterprise

automatically saves a record of the inventory of selected hosts
indicated byAU: at the beginning of the inventory name
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� SavedHost Inventory –User initiated saved record of the inventory of a selected host
� SavedGroup Inventory –User-initiated saved record of the inventory of a group; a

composite list of software installed on all hosts of the group

Before comparing inventories, you should run the Check System profile on the host or group. This
will ensure that the source inventory does not have dependency issues. If you will bemanaging
Solaris hosts, you should run the CheckWithdrawn Patches profile. This will replace withdrawn
Solaris patches with appropriate operating software. See Chapter 7.

In addition, if you will be comparing Solaris machines, you should edit the PKG settings (see “Host
Preferences – PKGs” on page 301) to ensure that the deployment operates as expected.

Make sure the Inventory panel is open in themainwindow. From theViewmenu, choose Inventory.

Do one of the following:

� From the tool bar, click the Compare Inventories button.
� Right-click in the Hosts list and choose Compare Inventories.
� From theHosts menu, choose Compare Inventories.

The Inventory Comparison window opens.

Click theHost Select button to the right of the Target host field.
TheHost Selection window opens.

Select the host youwant to change and then clickOK.
TheHost Selection window closes. The selected host name appears in the Target host field.

BeforeYouBegin
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From the Inventory drop-down list, select a stored inventory or the current inventory.
If you want to create a job from the comparison, select Current Inventory.

Click theHost Select button to the right of the Source field.
TheHost Selection window opens.

Select themanagedhost youwant to use as the source and then clickOK.
TheHost Selection window closes. The selected host name appears in the Source field.

From the Inventory drop-down list, select a saved inventory.
(If the source host is different from the target host, you can select the current inventory.)

In the Filter section, select the types of components youwant to be in the comparison:

� Software packages
� Hardware drivers
� Configuration Files
� whether you want the comparison to ignore differences in Versions of the same packages

Click Compare.
The results of the inventory comparison are displayed.

Under the See section of the Inventory Comparisonwindow, select Tasks toMake Target like Source.
If the results include at least one difference between the selected inventories which can be converted
to an action (differences in configuration files cannot be converted), more features are available. See
the following procedures.

Comparing Inventorieswith the CLI

The compare host inventories CLI command outputs two lists: what is installed in the source
inventory and not in the target inventory, and what is in the target inventory and not in the source
inventory.

Both hosts must be of the same distribution. Both the source host and the target host may be the
same host, but the inventories must be different.

If you do not use the -s or the -ts parameters, the current inventories are used by default. See
“Compare Hosts and Inventories (-chi) Command” on page 277.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”
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read password

echo “What distribution are you working on?”

uce_cli -ld -u “$user” -p “$password”

echo -n “Copy the distribution name you want:”

read distroGroup

echo “The list of hosts in this distribution is:”

uce_cli -lgh -g “$distroGroup hosts” -u “$user” -p “$password”

echo -n “Copy the name of the source host:”

read sourcehost

echo -n “Copy the name of the target host:”

read targethost

echo “The list of saved inventories is:”

uce_cli -lss -g “$distroGroup hosts” -u “$user” -p “$password”

echo -n “Copy the name of the source inventory:”

read sourceInven

echo -n “Copy the name of the target inventory:”

read targetInven

uce_cli -chi -h “$sourcehost” -s “$sourceInven” -t “$targethost” -ts “$targetInven” \

-u “$user” -p “$password”

Cloning Inventories

� ToClone Software Inventory
If the results of a Compare Inventory include differences which can be converted to tasks, and if the
target inventory is a Current Inventory of a host, you canmake the target inventory like the source
inventory. This operation does not dump everything on the target as a traditional clone feature
would. It allows for amore secure job. It shows you which components are on the source that are not
on the target, and could be installed; and which are on the target which could be uninstalled.

Compare a source inventory to the Current Inventory of a target host.

If the source inventory can be cloned onto the target inventory, theMake Target Like Source button is
enabled.

ClickMake Target like Source.

The Run Job window opens.

The actions under Deploy source’s inventory on target->Profile Data show the components to be
installed, uninstalled, upgraded, or downgraded on the target tomake its inventory similar to the
source inventory.
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Youmay continue with the job now, if this is the only type of action to be done:

� Comparison is of Linux inventories
� Differences are of software, not Solaris patches
� Tasks are for only install, with no uninstall of Solaris patches

If the tasks displayed in the Run Job window includeMaintain target’s patches, see “Patch
Management in Solaris Comparisons” on page 159 before continuing with this procedure.

Type a newname for the job.

Select Deploy or Simulate.

ClickOK.
The job installs, uninstalls, upgrades, and downgrades components on the target managed host to
make its inventory consistent with that of the source.

PatchManagement in Solaris Comparisons
Solaris patches are installed and handled differently than Linux components.An inventory
comparison will result in patch comparisons only if the selected inventories have identical software
components.

If patches are compared and differences found:

� If the only actions to take on patches are to install them on the target, youmay continue the job;
return to Step 3.

� If there is at least one patch which should be uninstalled from the target, you should understand
implicit patch installations before continuing with the job.
For example, patch *-05 is installed on a Solaris machine. It is upgraded to patch *-20.All of the
patches between 05 and 20 are implicitly installed. They are not on themachine, but themachine
is affected as though they were. If you uninstall 20, you lose those effects and go back to 05; but
according to what you have seen, youmight believe that 19 should be on themachine.
To handle implicit patch installations, SunUpdate Connection – Enterprise will first uninstall the
patch that was not in the source and then install a comparable patch seen on the inventory of the
source.
You see the following in the Run Job window:

Maintain target’s patches -> Profile Data ->Install patch

TroubleshootingClone Inventory Jobs
� Cannot Create Solaris Patch Job

� Situation –The job cannot be created because there are conflicts in patchmanagement
actions.
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� Error – Cannot create job due to patch conflicts.

� Explanation –One Solaris patch can affect multiple software. In one job, you could see tasks
to both install the patch for one software and uninstall the same patch for another software.
This job cannot be done through the Compare Inventory feature.

� Job Too Big
� Situation – If the job contains toomany actions, the followingmessage is displayed
� Error – The job exceeds the recommended size of 20 tasks. Do you want to

continue?

� Explanation – For every action that is sent as part of a job, more actions are added, to
automatically handle dependency issues. If a job contains toomany actions, there is a larger
possibility that the job will fail on timeout.

� Solution –You can click Continue and try to run the job as is. Or, you can break up the job
into smaller ones:

1. Click Cancel and then delete some of the actions from the panel.
2. ClickMake Target like Source again and run the job.
3. Create a job to run the remaining actions.

Note –You can change the default minimumof 20 actions in the Preferences window (see
“Console Preferences – Jobs” on page 299).

� NoTasks for Job
� Situation –The job cannot be created because there are no actions, even if the comparison

did find some differences.
� Explanation – Some differences in inventory will not be translated into actions. These are the

following:
� Uninstall Local files
� Install Local Unrecognized files
� Change hardware support components

� Solution –Rerun the comparison filter. If such components are the only differences between
the two inventories, they are actually already very similar.

If you still want tomake themanaged hosts duplicates of each other, select the Difference
between inventories radio button, take note of the list of differences, and create separate jobs
to complete the cloning.

� Cannot Locate Software Component
� Situation –The job cannot be created because the components that you selected cannot be

located.
� Error – Cannot locate the following components.

Make sure they are added to the Local Components tree.
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� Explanation –The components that you selected are known because the SDS added them to
the knowledge base. However, the software component itself was not uploaded, or was
removed from the local machines. Therefore, there is no available software to be installed.

� Solution –To add the software component to the knowledge base:
1. Log into the console as an user with full permissions or as admin.
2. From the Components list, select Local/Local RPMs or Local/Local PKGs and then click

Attach.
3. In theAttach Target File window, browse to themanaged host and path where the

software component is stored and then click OK.

RestoringManagedHosts

� ToRoll Back an Inventory
After you run a job and decide that the changes are not what you need, you can roll back the
component inventory of amanaged host to a previously saved inventory. Inventories are saved
automatically before job changes, and you can save an inventory on demand (see “Saving
Inventories” on page 152).

Make sure the Inventory panel is open in themainwindowby choosing Inventory from theView
menu.

Doone of the following:

� From the tool bar, click the Compare Inventories button.
� Right-click in the Hosts list and choose Compare Inventories.
� From theHosts menu, choose Compare Inventories.

The Inventory Comparison window opens.

Click theHost Select button to the right of the Target host field.
TheHost Selection window opens.

Select the host youwant to restore and then clickOK.
TheHost Selection window closes. The selected host name appears in the Target host field.

From the Inventory drop-down list, select Current Inventory.

Click theHost Select button to the right of the Source field.
TheHost Selection window opens.

Select the samemanagedhost youwant to restore and then clickOK.
TheHost Selection window closes. The selected host name appears in the Source field.

1

2

3

4

5

6

7

Inventory Jobs

Chapter 8 • Inventories 161



From the Inventory drop-down list, select the optimal stored inventory of the host or of a group to
which the host belongs.

Filter the inventories for the type that youwant to restore, or select all the inventory options.

Note – If the hosts are Solaris machines, you can rollback only Software or only Patches at one time.

Click Compare.
Check the results of the inventory comparison. If the differences between the inventories can be
converted to componentmanagement tasks, theMake Target like Source button is enabled.

ClickMake Target like Source.
The Run Job window opens.

In the Run Jobwindow, select Deploy and then clickOK.
The restore job begins.

If you are a user with restricted permissions to run only simulation jobs, you do not have this
option.)

Restoring aHostwith the CLI

The CLI command submit compare job can clone the inventory (or part of it) from one host or saved
inventory to another host. It can also restore a host to a previously saved inventory. This example
shows a restore inventory job. See “Submit Compare Job (-scj) Command” on page 278.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “What distribution are you working on?”

uce_cli -ld -u “$user” -p “$password”

echo -n “Copy the distribution name you want:”

read distroGroup

echo “The list of hosts in this distribution is:”

uce_cli -lgh -g “$distroGroup hosts” -u “$user” -p “$password”

echo -n “Copy the name of the host to restore:”

read host

echo “The list of saved inventories is:”

uce_cli -lss -g “$distroGroup hosts” -u “$user” -p “$password”

echo -n “Copy the name of the inventory to which $host is be restored:”

read sourceInven
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uce_cli -scj -h “$host” -s “$sourceInven” -t “$host” -j “Restore $host” -C “Always ask me” \

-dp -u “$user” -p “$password”

Saving Inventory Settings as Profiles

� ToSave Inventory Settings as aProfile
Inventory jobs allow you to quicklymanage hosts based on specific components. You can also
manage hosts using Complex Jobs (see Chapter 11), which allow formore features in one
management task. To do this, you need a profile. In this procedure, you save a inventory action list as
a re-usable profile.

Make sure the Inventory panel is open in themainwindowby choosing Inventory from theView
menu.

From thedrop-down list on the tool bar, select a distribution-architecture.

The Components list changes to display components of the selected distribution.

In the Components list, select a component.

Assign an action to the selected component.

Do one of the following:

� From the tool bar, click the Required, NotAllowed, or Upgrade button.
� Right-click the selected component and choose Required, NotAllowed, or Upgrade.
� From the Components menu, choose Required, NotAllowed, or Upgrade.

The action-component setting appears in theActions list.

Enter asmany component settings as youwant.

Tomake the inventory job applicable to hosts of different distributions:

� To select specific components from different distributions, change the selection of the
drop-down list of distributions in the tool bar. Find the relevant components and add the action
settings to theActions list.

� To let SunUpdate Connection – Enterprise find components from other distributions that are
comparable to the ones you have in theActions list, click theMulti Distribution button.
See “ToAlign Component Settings forMultiple Distributions” on page 210.

Dooneof the following:

� From the tool bar, click the SaveAs Profile button.
� Right-click in theActions list and choose Save as Profile.
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� From theActionsmenu, choose Save as Profile.

The Profile Editor window opens.

Type a newname for the profile, and type a free-text description.

Check that the component actions in the bottompanel arewhat youwant. You can change the
profile before saving it.

ClickOK.
The profile is saved. The Profile Editor closes.

Saving aHost Inventory as a Profile
This Copy Inventory to Profile CLI command takes a host as a parameter. Everything that is installed
on the host is marked as Required in the profile.All remaining components in the knowledge base of
the distribution of the selected host that are not installed on that host aremarked as NotAllowed in
the profile. Use this profile tomake an inventory cloning job onmultiple hosts.

Note that in the following script example, the existence of a policy is assumed.

Make sure to execute a Check System for dependency issues before you save the inventory as a
profile, either in the CLI or in the console. In addition, if the host is a Solaris machine, execute a
CheckWithdrawn Patches profile. See “Convert Inventory to Profile (-cip) Command” on page 277.
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#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “The list of hosts is:”

uce_cli -lah -u “$user” -p “$password”

echo -n “Copy the name of the host you want:”

read host

echo “The inventory of this host will be saved as a profile.”

echo -n “Type a name for this profile:”

read profileName

echo “Checking $host for dependency issues....”

uce_cli -sj -P “Check system” -C “YesToAll” -h “$host” -dp -u “$user” -p “$password”

# Always run the System Test for Dependency Issues before saving an inventory.

# YesToAll is a policy that says Yes to all actions on SW and Local.

uce_cli -cip -h “$host” -P “$profileName” -u “$user” -p “$password”

Saving a Saved Inventory as a Profile

This Copy Snapshot as Profile CLI command takes the name of a saved inventory (known as a
snapshot in the CLI) as a parameter. Everything that was installed on the host when the inventory was
saved, is marked as Required in the profile. This profile could be used for amass clone job.

Make sure to execute a Check System for dependency issues before you save the inventory as a
profile, either in the CLI or in the console. In addition, if the host is a Solaris machine, execute the
CheckWithdrawn Patches profile. See “Convert Snapshot to Profile (-csp) Command” on page 277.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “The list of hosts is:”

uce_cli -lah -u “$user” -p “$password”

echo -n “Copy the name of the host you want:”

read host

echo “The saved inventories of this host are:”

uce_cli -lss -h “$host” -u “$user” -p “$password”

echo -n “Copy the saved inventory that you want to save as a profile”

read inven

echo -n “Type a name for this profile:”
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read profileName

echo “Checking $host for dependency issues....”

uce_cli -sj -P “Check system” -C “YesToAll” -h “$host” -dp -u “$user” -p “$password”

# Always run the System Test for Dependency Issues before saving an inventory.

# YesToAll is a policy that says Yes to all actions on SW and Local.

uce_cli -csp -h “$host” -s “$inven” -P “$profileName” -u “$user” -p “$password”

Inventory Jobswith Local Scripts andFiles
Efficient system and network administrators oftenmaintain a repository of scripts that they use to
run typical host management tasks. Theymight also keep a repository of configuration files that they
have changed for various situations, allowing them to quicklymanage peripherals and do other
frequent environmentmodifications.

SunUpdate Connection – Enterprise allows you to store your scripts and files in your local Sun
Update Connection – Enterprise knowledge base, as explained in “Managing Local Files” on page
102. The following tasks show how you can easily create Inventory jobs to execute your scripts or
install your file versions onmultiple hosts. Using such techniques, you couldmanage complex,
time-consuming tasks with one-click and be done withinminutes: route fifty computers to a new
printer, add nodes to a cluster, change the dynamics of on-demand services, and so on.

Executing Scripts onHosts

� ToExecute a Local File onMultipleHosts
In this procedure you will run Probes, Pre-actions, and Post-actions onmanaged hosts, using
Inventory jobs. You could include these files in jobs that include installation components (RPMs,
PKGs); this procedure shows the difference between SunUpdate Connection – Enterprise install of
installations and SunUpdate Connection – Enterprise install of executions. The local file you want
must already be in the Components list, under Local.

Make sure the Inventory panel is open in themainwindowby choosing Inventory from theView
menu.

From thedrop-down list on the tool bar, select a distribution-architecture.

The Components list changes to display components of the selected distribution.

In theHosts list, select the hosts uponwhich youwant to execute the script.

In the Components list, expand Local and then expand the relevant category: Probes, Pre-actions, or
Post-actions.

Select the probe or action that youwant.
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Dooneof the following:

� From the tool bar, click the Required button.
� Right-click the selected file and choose Required.
� From the Components, choose Required.

The action setting appears in theActions list.

Add asmany Probes, Pre-actions, or Post-actions as youwant.

To execute the files onhosts of different distributions:

� To select specific files from different distributions, change the selection of the drop-down list of
distributions in the tool bar. Find the relevant files and add the action settings to theActions list.

� To let SunUpdate Connection – Enterprise automatically add the same files that you uploaded to
multiple distributions, click theMulti Distribution button. See “ToAlign Component Settings
forMultiple Distributions” on page 210.

Dooneof the following:

� From the tool bar, click the Run Job button.
� Right-click in theActions list and choose Run on SelectedHosts.
� From theActionsmenu, choose Run on SelectedHosts.

The Run Job window opens.

Type a nameanddescription for the job.

Check the bottompanel of the Run Jobwindowandmake sure itwill execute the actions or probes
youwant. Although the action says Install, the actions andprobes are not installed, but are executed
on the remote hosts.

Select Deploymode. As this jobwill execute scripts, a simulationwill not do anything on the hosts.

ClickOK.

The job begins.

Probes are executed first.

If they succeed, Pre-actions are executed next.

If the Pre-actions succeed, Post-actions are executed.
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Distributing Local Files

� To Install Configuration Files onMultiple RemoteHosts
In this procedure you will install local Configuration files onmanaged hosts with an inventory job.
The version you wantmust already be on the Components list, under Local/Configuration files. If
the file has amacro sign in its contents, make sure the appropriate macro is also uploaded to the
knowledge base. You do not need to add themacros to the inventory job; macros are called and
executed automatically by SunUpdate Connection – Enterprise.

Make sure the Inventory panel is open in themainwindowby choosing Inventory from theView
menu.

From thedrop-down list on the tool bar, select a distribution-architecture.
The Components list changes to display components of the selected distribution.

In theHosts list, select hosts onwhich the fileswill be installed.

In the Components list, under Local/Configuration files select the file version that youwant.

Do one of the following:

� From the tool bar, click the Required button.
� Right-click the selected file and choose Required.
� From the Components menu, choose Required.

The action setting appears in theActions list.

To install the files onhosts of different distributions:

� To select specific files from different distributions, change the selection of the drop-down list of
distributions in the tool bar. Find the relevant files and set them to Required.

� To let SunUpdate Connection – Enterprise automatically add to theActions list the same files
that you uploaded tomultiple distributions, click theMulti Distribution button. See “ToAlign
Component Settings forMultiple Distributions” on page 210.

Dooneof the following:

� From the tool bar, click the Run Job button.
� Right-click in theActions list and choose Run on SelectedHosts.
� From theActionsmenu, choose Run on SelectedHosts.

The Run Job window opens.

Type a nameanddescription for the job.

Select Deploymode.
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ClickOK.

The job begins.

The files that were uploaded to the knowledge base are installed on the remote hosts in the path
names provided by the File Declaration of each Configuration file version.

If a Configuration file has amacro sign, themacro is called after file installation. Themacro executes,
and its output replaces themacro sign in the Configuration file.

Distributing Local Files

Your File Declaration is /etc/printcap and the local File is printcap_01. Use this job to install
printcap_01 on ten hosts. On the hosts, it installs a file named /etc/printcap that has the contents
of printcap_01. The contents of each existing printcap file are overwritten with the contents of
printcap_01.
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Profiles

This chapter explains how to use the powerful profile tool tomanagemultiple systems consistently
while automatingmany tedious administration jobs.

This chapter covers the following topics:

� “Terms” on page 171
� “WorkingWith Profiles” on page 172

Terms
This chapter uses the following terms:

Component Any logical unit that is, or can be, part of amachine; not only
software and files, but also any logical construct of the component
hierarchy.

Inventory (1) List of components installed on amanaged host. (2) List of
components on the universal server.

Knowledge Base Sub-system of the SunUpdate Connection – Enterprise system
dependency server, acts as a proxy server for the universal server,
holding and updating deployment rules and certified
components.

Profile Definition of a component configuration for a type of machine;
what is required and what is not allowed to be installed on this
type of machine.

Predefined Profile Profile provided with SunUpdate Connection – Enterprise that
performs a full-system check and fix.
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WorkingWithProfiles
Create profiles to record the requirements of your enterprise and deploy the profiles to automatically
create servers and workstations. Creation and deployment of profiles takesminutes, handles
dependencies, and ensures consistency.

For example, you create a profile calledWeb Servers which defines that your web servers are required
to have the httpd client and server, andmust not have anonFtp. You deploy the profile. SunUpdate
Connection – Enterprise installs the necessary components, uninstalls those you do not want, and
automatically handles dependent components.

You can schedule a job to deploy the profile on a routine basis, such as once amonth. It will make
sure that everything that you want (httpd) is still installed and does not have dependency conflicts. It
will make sure that anonFtp is not installed.

SunUpdate Connection – Enterprise profiles focus on the component level. You select a component
from the knowledge base inventory and then apply a setting to it. The component settings are
described in the following table.

TABLE 9–1ProfileComponent Settings

Setting Setting onPackage Setting onCategory/PackageGroup

Required If package is not installed, DR finds solution to
install it.

If installed, nothing is done.

If at least one package is installed, nothing is
done.

If no package in category/group is installed,
the one that is most cost-effective is installed.

NotAllowed If package is installed, DR finds solution to
uninstall it.

If not installed, nothing is done.

All packages within category/group are
uninstalled.

Upgrade If there is a newer version for an installed
package, the package is upgraded.

If the package is not installed, nothing is done.

If there is more than one newer version, the
most cost-effective is chosen.

All packages within category/group are
upgraded if newer versions exist.

Aprofile is used as a single job. Its settings (Required, NotAllowed, Upgrade) affect amanaged host
only during the actual deployment of the profile.After you deploy a profile, you could run another
job that contradicts the settings of the profile.

If you build a profile that hasmultiple Required andNotAllowed components, the Dependency
Resolver (DR)may find a solution for the Required components that demands that a NotAllowed
component be installed. If this happens, the DR rejects the solution and looks for another, one that
will conform to both the Required and the NotAllowed settings.
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� ToCreate aProfile
In this procedure, you will create and save a new profile, to be used later in a job. Users of all levels
can perform this procedure in the console. Other users see your profiles as read-only. They can
deploy or copy your profiles; they cannot delete or edit them. This restriction applies to users of all
levels.

Dooneof the following:

� From the tool bar, click the Profiles button.

� From the Toolsmenu, choose Profiles.
The Profiles window opens.

Dooneof the following:

� From the tool bar on the Profileswindow, click theNewbutton.

� Right-click a blank space in the Profileswindowand chooseNew.
The Profile Editor window opens.

From thedrop-down list on the tool bar, select a distribution-architecture.
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The Components list shows the components of the selected distribution.

Type a name for the profile and anoptional free-text description.

In the Components list, select a component.

Assign a profile action to the selected component.
Do one of the following:

� From the tool bar, click the Required, Not Allowed, or Upgradebutton.

� Right-click the selected component and choose Required, Not Allowed, or Upgrade.
The component setting appears in theActions list of the Profile Editor.

Tomake the profile applicable to hosts of different distributions:

� To select specific components from different distributions, change the selection of the
drop-down list of distributions in the tool bar. Find the relevant components and add the
action settings to theActions list.

� To let SunUpdate Connection – Enterprise find components from other distributions that
are comparable to the ones you have in theActions list, click theMulti Distribution button.
See “ToAlign Component Settings forMultiple Distributions” on page 210.

ClickOK.
The Profile Editor window closes. The profile is created and appears in the Profiles window.

Creating a Profilewith the CLI

The CLI command to create a profile allows for only one component and its setting. See “Add Profile
Attribute (-apa) Command” on page 271.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo -n “Enter a string to search for exact component name:”

read comp2find

uce_cli -fc -T $comp2find -u $user -p $password

echo -n “Copy the exact component name that you want to add to a profile:”

read comp2use

echo -n “Enter the name of a profile or create a new one:”

read profileName

echo “What do you want to do with the component?”

echo “Make it Required, Not Allowed,”
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echo “or Upgraded when possible?”

echo -n “Enter the setting (-R | -N | -U) (case-sensitive):”

read setting

uce_cli -apa -P “$profileName” -T “$comp2use” $setting -u “$user” -p “$password”

� ToEdit a Profile
In this procedure you will edit an existing profile that you created. Users of all levels can perform this
procedure in the console.

You cannot edit a profile in the following circumstances:

� The profile was created by another user.
� The profile is currently in an active job.
� The profile is a Predefined SystemTest Profile (see Chapter 7).

If you edit a profile that is scheduled for later deployment, the users who deploy that profile
decide whether to use the original profile or the edited one.

Dooneof the following:

� From the tool bar, click the Profiles button.

� From the Toolsmenu, choose Profiles.

The Profiles window opens.

Select a profile from the list.

Do one of the following:

� From the tool bar of the Profileswindow, click the Edit button.

� Right-click the selected profile and choose Edit.

The Profile Editor window opens.

From thedrop-down list on the tool bar of the Profile Editor, select a distribution-architecture.

The Components list changes to display components of the selected distribution.

Change asmany component settings as youwant.

See Table 9–1.
To add a component setting, select the component and do one of the following:

� From the tool bar of the Profile Editor, click the Required, NotAllowed, or Upgrade button.
� Right-click the selected component and choose Required, NotAllowed, or Upgrade.
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To delete a component setting, select an action in theActions list and do one of the following:

� From the tool bar of the Profile Editor, click the Delete button.
� Right-click the selected action and choose Delete.

To change a component setting, delete the action from theActions list and then add a new action for
the component setting you want.

Add asmany component settings as youwant.
Tomake the profile applicable to hosts of different distributions:

� To select specific components from different distributions, change the selection of the
drop-down list of distributions in the Profile Editor tool bar. Find the relevant components and
add the action settings to theActions list.

� To let SunUpdate Connection – Enterprise find components from other distributions that are
comparable to the ones you have in theActions list, click theMulti Distribution button. See “To
Align Component Settings forMultiple Distributions” on page 210.

ClickOK.
The Profile Editor window closes. The profile is edited.

Editing a Profilewith the CLI

The CLI command to edit a profile is the same as to create a profile. See “To Create a Profile” on page
173.

� ToEdit a ScheduledProfile
You can edit a profile that you created, even if you deleted it from the profiles list, so that future
deployments or simulations of the profile will be different from the original profile. Use this
procedure to change scheduled jobs.

You can edit scheduled profiles only when the following are all true:

� The job that deploys/simulates the profile is scheduled for future runs.
� The options of the job are set to automatically accept changes.
� You are the owner of the profile.
� The profile is not in a currently active job.
� The profile is not a Predefined SystemTest Profile.

See Chapter 7.

Make sure the Jobs panel is open in themainwindowby choosing Jobs from theViewmenu.

Select a job name in the Jobs list and then select one of the tasks that appear in the Tasks list.
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Dooneof the following:

� From the tool bar, click the Edit Scheduled Profile button.

� Right-click the selected task and choose Edit Profile.

� From the Jobsmenu, choose Tasks -> Edit Scheduled Profile.
The Profile Editor window opens.

Edit the profile as needed.

ClickOK.
The Profile Editor window closes. The profile is edited for the next run of the job.

� ToCopyaProfile
In this procedure you will copy an existing profile. Use this procedure when another user has created
a profile that is useful to your own deployment andmanagement jobs, but you want to be able to edit
it. You could also use this procedure on your own profiles, to create a new profile based on a prior
one. You cannot copy a Predefined SystemTest Profile (see Chapter 7). Users of all levels can perform
this procedure in the console.

Dooneof the following:

� From the tool bar, click the Profiles button.

� From the Toolsmenu, choose Profiles.
The Profiles window opens.

Select a profile from the list.

Do one of the following:

� From the tool bar of the Profileswindow, click the Copybutton.

� Right-click the selected profile and choose Copy.
The Profile Editor window opens.

Edit the profile as needed, or simply change the name.

ClickOK.
The Profile Editor window closes.Acopy of the profile with the new name appears in the Profiles
window.
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Copying a Profilewith the CLI

The copy profile command in the CLI allows you only to save a profile under a new name, without
making changes to the settings. See “Copy Profile (-cp) Command” on page 272.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo -n “Enter a string to search for exact component name:”

read comp2find

uce_cli -fc -T $comp2find -u $user -p $password

echo -n “Copy the exact component name that you want to add to a profile:”

read comp2use

echo -n “Enter the name of a profile or create a new one:”

read profileName

echo “What do you want to do with the component?”

echo “Make it Required, Not Allowed,”

echo “or Upgraded when possible?”

echo -n “Enter the setting (-R | -N | -U) (case-sensitive):”

read setting

uce_cli -apa -P “$profileName” -T “$comp2use” $setting -u “$user” -p “$password”

� ToCopyanActive Profile
You can copy any profile (except a Predefined SystemTest Profile), even if the owner deleted it from
the profiles list or it is in a currently active job. Use this procedure to create new profiles from those
used in jobs.

Make sure the Jobs panel is open in themainwindowby choosing Jobs from theViewmenu.

Select a job name in the Jobs list and then select one of the tasks that appears in the Tasks list.

Do one of the following:

� From the tool bar, click the Copy Profile button.

� Right-click the selected task and choose Copy Profile.

� From the Jobsmenu, choose Tasks -> Copy Profile.

The Profile Editor window opens.

Edit the profile as needed, or simply change the name.

Example 9–3
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ClickOK.
The Profile Editor window closes. The profile with the new name is added to the Profiles window.

� ToDelete aProfile
In this procedure, you delete a profile that you created. Users of all levels can perform this procedure
in the console.

You cannot delete profiles in the following circumstances:

� The profile was created by another user.
� The profile is currently being deployed in an active job.
� The profile is scheduled to be deployed, and the owner of the job selected that the job not be

updated with profile changes.

Dooneof the following:

� From the tool bar, click the Profiles button.

� From the Toolsmenu, choose Profiles.
The Profiles window opens.

Select a profile from the list.

Do one of the following:

� From the tool bar of the Profileswindow, click theDelete button.

� Right-click the selected profile and chooseDelete.

In the confirmation dialog box, clickDelete again.

To Create a PostfixMail Server Profile – Example

The previous procedures explained how to create, edit, copy, and delete profiles, in general. This
procedure is a specific example of a profile for amail server.

1. To open the SunUpdate Connection – Enterprise Console, type uce_console in a terminal shell
and log in with a valid user name and password.

2. From the Tools menu, choose Profiles.
The Profiles window opens.

3. Right-click in the Profiles window and choose New.
The Profile Editor window opens.
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4. From the drop-down list in the tool bar of the Profile Editor, select a distribution.
5. Give the profile a name.

For example, youmight name the profile PostfixMailServer.
6. Type a description of the profile.
7. In the components list, find postfix, right-click it and choose Required.

See “To Find Components” on page 212 for details on searching the Components list.
Required postfix appears in the Actions list.

8. Find sendmail, right-click it and choose NotAllowed.
Not Allowed sendmail appears in the Actions list.

9. Right-click in theActions list and chooseMulti-Distribution.
TheMulti Distributions window opens. Your locally active distributions are listed. Those that are
listed in green have a componentmatch.

10. Click OK.
TheMulti Distributions window closes. TheActions list in the Profile Editor now includesmore
actions for the additional distributions.

11. In the Profile Editor, click OK.
The Profile Editor closes. PostfixMailServer appears in the Profiles list.
To deploy theMail Server Profile, see Chapter 11.
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Policies

This chapter explains how to create, edit, copy, and delete policies.Apolicy enables you to predefine
how a job is performed. It allows you to determine which solutions are unacceptable, and it allows
you to set the automation level of the job.

This chapter covers the following topics:

� “Terms” on page 181
� “WorkingWith Policies” on page 182

Terms
This chapter uses the following terms.

Component Any logical unit that is, or can be, part of amachine; not only
software and files, but also any logical construct of the component
hierarchy.

Cost-effective solution Deployment solution that has the least requirements for number
of dependency issues, time, and resources, to fulfill a job.

Policy Set of confirmation rules for the implementation of the
dependency resolver and level of automation of jobs.

dependency resolver (DR) Set of patented algorithms to describe a solution for a job.
Initiated by agent application when a job is received.

Inventory (1) List of components installed on amanaged host. (2) List of
components on the universal server.

Knowledge Base Sub-system of the SunUpdate Connection – Enterprise system
dependency server, acts as a proxy server for the universal server,
holding and updating deployment rules and certified
components.
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WorkingWithPolicies
When you send a job tomanaged hosts, each selected agent runs the dependency resolver (DR) to
find themost cost-effective solution for its own host to complete the job.

Creating a policy enables you to add your own rules to how the DR should determine what is the best
solution.

� You can predefine some actions as unacceptable. The DR rejects any solution that contains these
actions. Thus, you can determine trends for the DR, without giving up on the automation.

� You can predefine some actions as automatic, to be carried out without asking for
user-intervention.

SunUpdate Connection – Enterprise policies focus on the component level. You select a component
from the knowledge base inventory, select a possible deployment action, and then apply a
deployment policy setting to the pair. If the selected component is a category or a package-group, the
setting applies to all packages contained in the category or package-group.

EXAMPLE 10–1Example

You want to install the latest version of a security software on a hundred hosts. You create a policy
that protects your kernel from any changes.

Running Kernel Install - No

Running Kernel Uninstall - No

Running Kernel Upgrade From - No

Running Kernel Downgrade From - No

When you run the job on the group of hosts, the policy forces those hosts with old kernels either to
find a way to install the new software in the present environment, or to fail the job.

TABLE 10–1PolicyComponent-Action Settings

AskMe Yes No

Install or
Uninstall

Pause the job for
confirmation before installing
or uninstalling the selected
component.

Install or uninstall the
selected component
automatically, as required by
solution.

Find a solution that does not
install or uninstall the selected
component.

Upgrade
from or
Downgrade
from

Pause the job for
confirmation before changing
the version of the selected
component.

Upgrade or downgrade the
selected component
automatically, as required by
solution.

Find a solution that does not
upgrade or downgrade the
selected component.
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TABLE 10–1PolicyComponent-Action Settings (Continued)
AskMe Yes No

Apply Fix Pause the job for
confirmation before fixing
dependency, security, or bug
issues on selected component.

Deploy fix automatically as
needed.

Find a solution that does not
deploy a fix on the selected
component.

Ignore File
Conflict1

Pause the job for
confirmation, so you see the
conflict and decide run-time
whether to ignore it and
continue the job, or to fail the
job.

The conflict is understood
and known to be
unimportant. Continue the
job without pause.

Caution –Donot set Yes to this
action unless you know the
conflict.

Find a solution that does not
allow for any file conflicts.

1 If the selected component provides a file that cannot be installed on amachine with a file provided by another component that is
already installed, there is a file conflict.

If both components are certified, the rules of the knowledge base handle deployment without conflicts. If one or both are local
components not in the knowledge base, the conflict will cause the job to fail.

� ToCreate aPolicy
In this procedure, you will create a policy to be used later in jobs. Users of all levels can perform this
procedure in the console. Other users see your policies as read-only. They can use or copy your
policies; they cannot delete or edit them. This restriction applies to users of all levels.

Dooneof the following:

� From the tool bar, click the Policies button.

� From the Toolsmenu, choose Policies.

The Policies window opens.

Dooneof the following:

� From the tool bar on the Policieswindow, click theNewbutton.

� Right-click a blank space in the Policieswindowand chooseNew.

The Policy Editor window opens.
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Type a name for the policy.

From thedrop-down list on the tool bar, select a distribution-architecture.

The Components list shows the components of the selected distribution.

In the Components list, select a component, and for each action, set a policy for the selected
component; do one of the following:

� Select AskMe, Yes, or No from thedrop-down list of the action

� Click theAskMe, Yes, or Nobutton for all actions.

Tomake the policy applicable to hosts of different distributions:

� To select specific components from different distributions, select from the drop-down list of
distributions. Find components and add settings to theActions list.

� To let SunUpdate Connection – Enterprise find components from other distributions that
are comparable to the ones you have in theActions list, click theMulti Distro button (see “To
Align Component Settings forMultiple Distributions” on page 210).

ClickOK.

The Policy Editor window closes. The policy is created and appears in the Policies window.

Creating a Policy in the CLI

The CLI command to create a policy allows for only one component-action and its setting. See “Add
PolicyAttribute (-aca) Command” on page 271.
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#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password echo -n “Enter a string to search for exact component name:”

read comp2find

uce_cli -fc -T $comp2find -u $user -p $password

echo -n “Copy the exact component name that you want to add to a

policy:”

read comp2use

echo -n “Enter the name of a policy or create a new one:”

read policyName

echo “What action is relevant for this component?”

echo “(install|downgrade|fix|remove|upgrade|ignore)”

echo -n “Type the exact action, case-sensitive:”

read action

echo -n “Enter the setting (yes|no|ask_me) (case-sensitive):”

read setting

uce_cli -aca -C “$policyName” -T “$comp2use” -$action $setting -u “$user” -p

“$password”

� ToEdit a Policy
In this procedure, you will edit a policy and save the changes. Users of all levels can perform this
procedure in the console.

You cannot edit a policy in the following circumstances:

� The policy was created by another user.
� The policy is currently in an active job.
� The policy is the PredefinedAlways askme policy.

If you edit a policy that is scheduled for later deployment, the users who deploy that policy decide
whether to use the original policy or the edited one.

Dooneof the following:

� From the tool bar, click the Policies button.

� From the Toolsmenu, choose Policies.

The Policies window opens.

Select a policy from the list.
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Dooneof the following:

� From the tool bar of the Policieswindow, click the Edit button.

� Right-click the selected policy and choose Edit.

The Policy Editor window opens.

From thedrop-down list on the tool bar of the Policy Editor, select a distribution- architecture.

The Components list changes to display components of the selected distribution.

Change asmany component settings as youwant.

See Table 10–1.

To add a component setting, select the component and set a policy for each deployment action. Do
one of the following:

� SelectAskMe, Yes, or No from the drop-down list of the action
� Click theAskMe, Yes, or No button for all actions.

To delete a component setting, select an action in theActions list and click the Delete Selected
button.

To change a component setting, delete the action from theActions list and then add a new action for
the component setting you want.

Add asmany component settings as youwant.

Tomake the policy applicable to hosts of different distributions:

� To select specific components from different distributions, change the selection of the
drop-down list of distributions. Find the relevant components and add the settings to theActions
list.

� To let SunUpdate Connection – Enterprise find components from other distributions that are
comparable to the ones you have in theActions list, click theMulti Distro button (see “ToAlign
Component Settings forMultiple Distributions” on page 210).

ClickOK.

The Policy Editor window closes. The policy is edited.

� ToEdit a ScheduledPolicy
You can edit a policy that you created, even if you deleted it from the policies list, so that future runs
of a job will have different confirmation policies. Use this procedure to change the policy of
scheduled jobs.
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You can edit scheduled policies only when the following are all true:

� The job that deploys/simulates the policy is scheduled for future runs.
� The options of the job are set to automatically accept changes.
� You are the owner of the policy.
� The policy is not in a currently active job.
� The policy is not theAlways askme policy.

Make sure the Jobs panel is open in themainwindow. From theViewmenu, choose Jobs.

Select a job name in the Jobs list and then select one of the tasks that appears in the Tasks list.

Do one of the following:

� From the tool bar, click the Edit Policy button.

� Right-click the selected task and choose Edit Policy.

� From the Jobsmenu, choose Tasks -> Edit Scheduled Policy.
The Policy Editor window opens.

Edit the policy as needed.

ClickOK.
The Policy Editor window closes. The policy is edited.

Editing a Policy in the CLI

The CLI command to edit a policy is the same as to create a policy. See Example 10–2.

� ToCopyaPolicy
In this procedure you will copy an existing policy. Use this procedure when another user has created
a policy that is useful to your own deployment andmanagement jobs, but you want to be able to edit
it. You could also use this procedure on your own policies, to create a new policy based on a prior
one. You cannot copy the PredefinedAlways askme policy. Users of all levels can perform this
procedure in the console.

Dooneof the following:

� From the tool bar, click the Policies button.

� From the Toolsmenu, choose Policies.
The Policies window opens.
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Select a profile from the list.

Do one of the following:

� From the tool bar of the Policieswindow, click the Copybutton.

� Right-click the selected policy and choose Copy.

The Policy Editor window opens.

Edit the policy as needed, or simply change the name.

ClickOK.

The Policy Editor window closes. The policy is edited.

Copying a Policywith the CLI

The copy policy command in the CLI allows you only to save a policy under a new name, without
making changes to the settings. See “Copy Policy (-cc) Command” on page 273.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo “The list of existing policies is:”

uce_cli -lc -u $user -p $password

echo -n “Type the exact name of the policy you want to copy:”

read sourceP

echo -n “Type a name for the new policy:”

read targetP

uce_cli -cc -sC “$sourceP” -tC “$targetP” -u “$user” -p “$password”

� ToCopyanActive Policy
You can copy any policy (except the defaultAlways askme policy), even if the owner deleted it from
the policies list or it is in a currently active job. Use this procedure to create new policies from those
used in jobs.

Make sure the Jobs panel is open in themainwindowby choosing Jobs from theViewmenu.

Select a job name in the Jobs list and then select one of the tasks that appears in the Tasks list.
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Dooneof the following:

� From the tool bar, click the Copy Policy button.

� Right-click the selected task and choose Copy Policy.

� From the Jobsmenu, choose Tasks -> Copy Policy.
The Policy Editor window opens.

Edit the policy as needed, or simply change the name.

ClickOK.
The Policy Editor window closes. The policy is edited.

� ToDelete aPolicy
In this procedure you will delete a policy that you created. Users of all levels can perform this
procedure in the console.

You cannot delete policies in the following circumstances:

� The policy was created by another user.
� The policy is currently being deployed in an active job.
� The policy is scheduled to be used in a job, and the owner of the job selected that it not be

updated with policy changes.
If a scheduled job is set to accept changes, youmay delete the policy. On the next scheduled run,
the job will use the defaultAlways askme policy.

Dooneof the following:

� From the tool bar, click the Policies button.

� From the Toolsmenu, choose Policies.
The Policies window opens.

Select a policy from the list.

Do one of the following:

� From the tool bar of the Policieswindow, click theDelete button.

� Right-click the selected policy and chooseDelete.

In the confirmation dialog box, clickDelete again.
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Complex Jobs

This chapter explains how tomanage hosts in themost consistent and efficient manner. Complex
jobs are not difficult to create or use; they are complex because they combine several objects into one
command from the user interface to the system dependency server. Complex jobsmaintain
consistency throughout the environment and tomake sure that even themost complicated lifecycle
managementmissions are orderly and error-free. Complex jobs allow you to includemultiple tasks,
each task combining a set of objects and operation options.

This chapter covers the following topics:

� “Terms” on page 191
� “Complex Job Processes” on page 192
� “Complex JobObjects” on page 194
� “Creating Complex Jobs” on page 194
� “Saving Job Templates” on page 201
� “Copying Jobs” on page 201
� “Creating Complex Jobs” on page 202

Terms
This chapter uses the following terms:

Agent Application of SunUpdate Connection – Enterprise that is
installed on everymanaged host and that runs the Dependency
Resolver, finding solutions specific to its host.

Cost-effective Deployment solution that has the least requirements for number
of dependency issues, time, and resources, to fulfill a job.

dependencymanager (DM) Sub-system of the SunUpdate Connection – Enterprise system
dependency server, responsible formanaging jobs on hosts and
communications between the user interface and agents.

dependency resolver (DR) Set of patented algorithms to describe a solution for a job.
Initiated by agent application when a job is received.
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Mode Job option that determines whether the job changes hosts
(Deploy) or tests the action list on hosts (Simulate).

Job Collection of actions and tests to be run on selectedmanaged
hosts by agents.

Knowledge Base Sub-system of the SunUpdate Connection – Enterprise system
dependency server, acts as a proxy server for the universal server,
keeping dependency rules for CO deployment onmanaged hosts
and the COs themselves.

A local knowledge base is a private, on-site only, collection of
NCO listings and their deployment rules as generated by the
Local Expansion technology.

Policy Set of confirmation rules for the implementation of the
dependency resolver and level of automation of jobs.

Profile Definition of a component configuration for a type of machine;
what is required and what is not allowed to be installed on this
type of machine.

system dependency server (SDS) The completemanagement system for SunUpdate Connection –
Enterprise. Its sub-systems include the Server, the dependency
manager, and the knowledge base.

Task Part of a job that contains a profile, a hostlist, a policy, an optional
schedule, and performance options.

Complex JobProcesses
You create a single job to be run on one ormultiple hosts. Each agent that receives the job runs it
individually, optimizing on the software configuration of the host.

To fulfill a job, an agent uses rules and components from the knowledge base. The agent runs the
dependency resolver, which takes into account installed inventory, selected policy, and selected
profile.

The dependency resolver is a set of algorithms that describes the best possible solution for an agent to
complete a job. The best possible solution includes:

� Themost cost-effective package to deploy, matching component rules in the knowledge base to
the existing configuration of the host

� Themost cost-effective way to fulfill dependency requirements, ensuring that themanaged host
will operate correctly after the job

When you create a job, the agent of each selectedmanaged host picks up the job and runs the
following processes. Each agent performs these actions only for the components of its
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distribution-architecture; irrelevant components are ignored. Therefore, you can safely create a
multiple distribution job and send it to amixed group of hosts.

The job process of each agent, for each task, is as follows:

� Reads the knowledge base to find rule and component updates
� Sends the software component inventory of the host to the dependencymanager
� Runs probes to test that host resources can fulfill the job, if you selected probes
� Runs dependency resolver
� Builds a tasklist (if a simulation job, job ends after this step)
� Saves an inventory of each host to be changed
� Gets confirmation for tasks, either from a policy or interactively
� Runs local pre-actions, if you selected any
� Installs local Configuration files, if you selected any
� Customizes local Configuration files withmacros, if any are called upon
� Installs requested knowledge base components
� Runs local post-actions, if you selected any
� Runs post-fix actions, if applicable (see “Post-FixActions” on page 193)
� Sends job status (success/failure) and new inventory to the DM

Post-FixActions
Apost-fix action is a binary that performs an action on hosts when a specific package has been
installed. SunUpdate Connection – Enterprise runs post-fixes without user intervention. Post-fixes
ensuremachine functionality after changes.

EXAMPLE 11–1UsingPost-FixActions

You create a job that upgrades the kernel. Before the job ends, a post-fix action is triggered, which
updates the boot-loader file for the new kernel version.

AgentQueuing
While an agent is running a job, it cannot perform other SunUpdate Connection – Enterprise
actions:

� It cannot upload its files to the File Browser window.
� It cannot upload its parameters to the Host Settings window.
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� It cannot upload an updated inventory to the console. The inventory of themanaged host will be
updated on the console after the job is done.
Youmay assignmore jobs to this host, and the jobs will be queued.

Complex JobObjects
Acomplex job is made up of one ormore tasks, a schedule, and a set of performance options.At the
time that you create the job, you set the schedule (see “To Set Job Schedules” on page 196) and the
options (see “To Set JobOptions” on page 198). On the other hand, youmay create the objects of the
tasks either on the fly, as you create the tasks, or before you begin to create the job.

A task needs a profile:

� You can create or copy a profile beforehand. See Chapter 9
� You can use Predefined Profiles. See Chapter 7

Atask needs a policy:

� You can create or copy a policy beforehand. See Chapter 10
� You can use the defaultAlways askme policy.

A task needs a hostlist:

� You can select groups to ensure hosts of similar functionality receive consist jobs. See Chapter 4
� You can select one ormore hosts (using the Shift or Control keys) from the New Job window.
� Users with restricted permissions over groups can select only groups and hosts of their

authorized groups.

CreatingComplex Jobs
In the following procedures, you will select the objects and options of a job and then run the job on
selected hosts.

Before you begin a job on a Solaris machine, make sure the PKG deployment preferences are
appropriate for your local needs. See “Host Preferences – PKGs” on page 301 on “Host Preferences –
PKGs” on page 301.

This procedure is broken up into the following parts:

� “To Set Up the Objects of a Job” on page 195
� “To Create the Tasks of a Job” on page 195
� “To Set Job Schedules” on page 196
� “To Set a Single Schedule” on page 197
� “To Set a Recurring Schedule” on page 198
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� “To Set JobOptions” on page 198
� “Running a Job with the CLI” on page 200

� ToSetUp theObjects of a Job
Make sure the Jobs panel is available in themainwindowby choosing Jobs from theViewmenu.

Doone of the following:

� From the tool bar, click theNew Jobbutton.

� Right-click in the Jobs list and chooseNew Job.

� From the Jobsmenu, chooseNew.

TheNew Job window opens.

Give the job a nameand a free-text description.

Select amode for the job:

� Deploy –Perform the tasks on the selected hosts

� Simulate – Test the job to estimate time and full action list
Ausermay be restricted to executing jobs only in Simulatemode.

Do the following:

a. Create tasks for the job.

See “To Create the Tasks of a Job” on page 195.

b. Set job options or leave the default settings.

See “To Set JobOptions” on page 198.

c. Set a schedule or leave the default Now schedule.

See “To Set Job Schedules” on page 196.

� ToCreate the Tasks of a Job
In the Tasks tab of theNew Jobwindow, click Add Task.

The Task Editor opens.
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Type a name for a task.

Select a profile from thedrop-down list, or click the profile editor button to open the Profile Editor
and create a newprofile.

If you select a user-defined profile and then click the button, you can edit an existing profile.

Select a policy from thedrop-down list, or click the policy editor button to open the Policy Editor, to
create or edit a policy as youwould a profile.

Click theHosts button to the right of theHosts field.

The Select Hosts window opens.

Select hosts andgroups and then click theAddbutton.

The hosts or groups are added to the SelectedHosts list.

When the SelectedHosts list contains the hosts or groups that youwant to receive this job, clickOK.

TheHosts window closes. The selected hosts and groups appear in the Hosts field of the Tasks tab.

ClickOK.

The task is added to the Tasks list of the job.Add asmany tasks as you want.

The order of the tasks in the list is the order that they will be executed. To change this order, select a
task name and click the Up or Down buttons.

To edit a task, select the task and click the Edit button.

To remove a task from the job, select the task and click the Delete button.

Decide how to continue:

� If youwant to run the jobwith default settings, clickOKnow.

� If youwant to set a deployment schedule, go to “To Set Job Schedules” onpage 196.

� If youwant to viewand edit the job options, go to “To Set JobOptions” onpage 198.

� If youwant to save the tasks as a job template, click Save Template.

� ToSet Job Schedules
Open the Schedule tab.
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Select a schedule type:

� Single – have the job run at a future date and time.

� Recurring – have the job run on a recurring basis.

� ToSet a Single Schedule
Select Single.

In the Time text box, select the hour and theminutes.

Type in the desired time, or use the arrows to change the selection.The time settings are by 24 hours:
13:00 = 1pm, 14:00 = 2pm, ... 00:00 =midnight.

Click the button to the right of theDate box.

The Calendar opens.

Select a date and then clickOK.

The Calendar closes. The selected date appears in the Date field.

In theNew Jobwindow, clickOKor set job options.

See “To Set JobOptions” on page 198.

The job will begin on the selected time and date.
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� ToSet aRecurring Schedule
Select Recurring.

In theMonth drop-down list, select either EveryMonth (all year schedule) or a specificmonth
(monthly schedule).

Select days of themonth:

� Every day – Job runs every day of themonth, or year (if EveryMonthwas selected).

� Day inweek – Select the days of theweek onwhich the jobwill be run.

� Day inmonth – Select dates in themonth onwhich the jobwill be run.

Select timeof the day:

� Earliest – Set a time (hour:minutes) for the first run of the job.

� Interval – Set aminute interval, to have the job runmultiple times during a day.

� Latest – Set a time for the latest run of the job, if an interval formultiple runswas selected.

� ToSet JobOptions
Open theOptions tab.
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Select Use Secure Components only if youwant to give priority to secure versions. Deselect it to give
priority to cost-effective versions,whichmakes the job run faster.

If you set a recurring schedule for the job, decide how the job should be handled if selected profiles
andpolicies are changedbetweennowand the next run of the job.

Option Selected Function Deselected Function

Notify of changes If the owner of the profiles or policies
changes them, you will get an email
notification. Select if using
profiles/policies that other users created.

You are not notified of changes. Deselect if
you own the selected profiles or policies
and do not want the reminder emails.

Accept changes before
next run

Use updated profiles or policies. Select
for consistency and automation.

Use the profiles or policies as they were
when you created the job. Deselect for
predictability.

Specify howyouwant the task to run in relation to other tasks andhow tohandle failures.

Option Selected Function Deselected Function

Parallel Run the job simultaneously with other
jobs. Do not run jobs that depend on the
results of other jobs in parallel. Run such
jobs in sequential mode only.

Run the job after the previous job
completed. By default, a job is run
sequentially.

Sequential Run the job after other jobs have
completed.

Run the job in parallel mode.
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Option Selected Function Deselected Function

Continue on failure Continue to run a job even if one of the
steps or tasks experienced a failure. This
option is only available for jobs that run
in sequential mode.

Terminate a job if a step or task experiences
a failure.

Priority Select or change a priority for ajob.
Values are Low,Medium, andHigh.

By default, the priority is set toMedium.

Running a Jobwith theCLI
The CLI command to submit a job runs one task on a single selected host or group. See “Submit Job
(-sj) Command” on page 274.

#! /bin/bash

echo -n “Enter your user name:”

read user

echo -n “Enter your password:”

read password

echo -n “Type a name for this job:”

read jobname

echo -n “Do you want to run this job on a host or a group? (h|g):”

read hostgroup

if [ $hostgroup = “h” ];then

echo “Hosts are:”

uce_cli -lah -u “$user” -p “$password”

else

echo “Groups are:”

uce_cli -lg -u “$user” -p “$password”

fi

echo -n “Copy host or group name to receive job:”

read selected

echo “Profiles are:”

uce_cli -lp -u “$user” -p “$password”

echo -n “Copy profile to use:”

read profile

echo “Policies are:”

uce_cli -lc -u “$user” -p “$password”

echo -n “Copy policy to use:”

read policy

echo “Simulating $jobname”

uce_cli -sj -j “$jobname” -P “$profile” -C “$policy” -$hostgroup “$selected”
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-us -sm -u “$user” -p “$password”

echo -n “Do you want to deploy $jobname? (y|n)”

read yes

if [ $yes = “y” ]; then

uce_cli -sj -j “$jobname Deployed” -P “$profile” -C “$policy” -$hostgroup

“$selected” -us -dp -u “$user” -p “$password”

fi

Saving JobTemplates

� ToSave a JobTemplate
After you have set up the objects of a job, you can save it as a template. Using a job template, you can
run the job, with or without edits, whenever you want. Use this procedure if you have the job
requirements, but are unsure of when it should be run, or if the hosts are not yet online.

Open theNew Jobwindowand create tasks.

If you want, you can set a schedule and select options.

With any tab of theNew Jobwindowopen, click Save Template.

SunUpdate Connection – Enterprise saves the job without running it, and sends you amessage
when the save is complete.

The template name appears in the Jobs list, with an icon to indicate that it is not a running job.

To create a job from the template, select the template and then right-click and select Rerun. Select
Deploy or Simulate and then click OK.

Copying Jobs

� ToCopya Job
You can use a job to be the base of another job. Use this procedure if you have a complex job that
would fulfill new requirements with a few changes, rather than creating a new job.

In the Jobs list, select a job to use as the source and then right-click and select Copy.

TheNew Job window opens with the objects and settings of the selected job.

The profile is listed as Based on <source profile> from <date time>. This is to notify you that the
job will be based on the profile as it was at the date and time that the source job was created. If the
profile has been changed since then, this new job will not reflect those changes.
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If the profile is listed as Task’s Profile, the job was not a complex job. It was created by applying
job settings to inventory components. You canmake a copy of this job, but you cannot view its ToDo
basket.

Make any changes to the job that youwant and then clickOK.

The job is added to the Jobs list and begins according to its schedule settings.

Note – If you domake changes to the copied job, there is no indication in the Job list. See the Job Log
for details of how the changes were translated into actions.

CreatingComplex Jobs

� ToCreate a Simple Complex Job
This procedure is a specific example of executing Complex Jobs. This example is of a very simple job.
You could follow it even if you have not yet created profiles, policies, and groups.

Make sure the Jobs panel of themainwindow is openby choosing Jobs from theViewmenu.

From the tool bar, click theNew Jobbutton.

TheNew Job window opens.

Name the job CheckAllHosts. In the description, type This job checks all hosts for missing

dependencies.

Select Simulate.

This job will find anymissing dependencies on any of the hosts and give you an idea of how long the
actual job would take.

In the Tasks tab, click Add Task and a taskwith:

� Name: SingleCheck

� Profile: Check System

� Policy: Always askme

� Hosts: All Hosts

ClickOK in the Tasks tab.

The SingleCheck task is added to the job.
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ClickOK in theNew Jobwindow.

The job is sent to all managed hosts. Each host will be checked to see whether it has anymissing or
conflicting dependencies.

Check the progress of the hosts as they run the job, and the job log of each hostwhen it is done.

See “ToMonitor a Current Job” on page 218.

If the results of the simulation are satisfactory, rerun the job in Deploymode. See “To Rerun a Job”
on page 220.

The DR finds a solution to fix anymissing or conflicting dependencies. You will be asked to confirm
the fixes before they are deployed. See “To ConfirmTasks” on page 214). On confirmation, the
actions are carried out and all dependencies are fixed on all hosts.

� ToCreate a Feature-Rich Complex Job
This procedure is a specific example of using the Complex Job feature. This example is of amore
feature-rich job.

This example assumes the following:

� You have a profile with your requirements of anNFS server (NfsServer) and a profile for anNFS
client (NfsClient).

� You have created a policy to automatically apply fixes (AutoFix).
� You have created a group of machines destined to be NFS servers (nfs servers) and a group for

NFS clients (nfs clients). The machines may be of differing distributions and architectures.
You would have aligned the profile requirements for the different active distributions before
creating this job. See “ToAlign Component Settings forMultiple Distributions” on page 210.

Make sure the Jobs panel of themainwindow is openby choosing Jobs from theViewmenu.

Click theNew Jobbutton.

TheNew Job window opens.

Name the job: NFS Environment.

In the description, type This job provisions NFS servers and NFS clients.

Select Deploy.

As the profiles are your own or the predefined profiles for systemmanagement, you have a good idea
of what will be done on the hosts; you do not need to simulate the job before deploying it.

Before anything is changed on any host, SunUpdate Connection – Enterprise saves its inventory. If
you do not like the results of the job, you can easily restore it to its previous inventory. See “Restoring
ManagedHosts” on page 161.
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In the Tasks tab, click Add Task and a taskwith:

� Name: IntegrityCheck

� Profile: Check System

� Policy: AutoFix

� Hosts: nfs servers andnfs clients groups

ClickOK.
The IntegrityCheck task is added to the job.

Add another task:

� Name: ProvisionNfsServer

� Profile: NfsServer

� Policy: Always askme

� Hosts: nfs servers groups

ClickOK.
The ProvisionNfsServer task is added to the job.

Add another task:

� Name: NfsClient

� Profile: NfsClient

� Policy: Always askme

� Hosts: nfs clients groups

ClickOK.
The ProvisionNfsClients task is added to the job.

Now you have a job with three tasks: check hosts formissing dependencies, provision the NFS server
profile on the nfs servers group, and then provision the NFS client on the nfs clients group.

Let’s set a schedule for this job. If the job is run on a recurring basis, it will make sure that the hosts in
the web servers group always comply with the web server profile. If they do comply, nothing is
changed and the job finishes on success. If there has been an error in changemanagement, the
recurring run will find it.
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Open the Schedule tab.

Select Recurring.

Select EveryMonth.

Select Day inweek, and then selectMonday.

Set Earliest to 7:00.

The job will now run everyMonday, early in themorning. Let’s look at the job options now.

Open theOptions tab.

Select Use secure components only.

If you are the owner of the profiles andof theAutoFix policy, you can leave theNotify of changes
option deselected. They cannot be changedby any other user.

Select Accept changes before next run.

If the requirements of anNFS server change, you need only change the profile once. This option
ensures that the job will automatically use any changes youmake to the profile.

You now have a re-usable job, withmultiple tasks to be run onmultiple hosts in a specific order,
according to what is relevant to the inventory, distribution, and hardware architecture of each
managed host. The job has a schedule. You will be notified by email if there are any tasks to do or if a
host goes down. The job options have been set to optimize this specific set of tasks. To execute the
job, click OK in the New Job window.
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Common JobOperations

This chapter explains how to perform operations that are common to all SunUpdate Connection –
Enterprise jobs: Inventory-based, Complex, and scheduled.

This chapter covers the following topics:

� “Job Preparation” on page 207
� “JobManagement Features” on page 214
� “Troubleshooting Jobs” on page 225

JobPreparation
While you are preparing the settings for a job, either an Inventory-based job or the objects of a
Complex job, you can access features tomake the proceduresmore efficient; or in the case of Solaris
PKG preference settings, tomake the jobs succeed at all.

Procedures in this section include:

� “To Set PKG Preferences” on page 208
� “ToAlign Component Settings forMultiple Distributions” on page 210
� “To Find Components” on page 212
� “ToUse Regular Expressions” on page 214

Settings for PKG Jobs
This procedure is essential for any job that installs, uninstalls, upgrades, or downgrades Solaris PKGs
or patches.

Solaris admin File
The PKG preferences in the Solaris admin file describe how Solaris PKGs are deployed on Solaris
machines.When you install the SunUpdate Connection – EnterpriseAgent on a Solaris machine,
the path name of the Solaris admin file is /opt/local/uce/agent/config_files/admin.
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You can change these parameters in the Preferences ->Host -> PKGs window, to change the
parameters individually for a specific host; or you can point SunUpdate Connection – Enterprise to
your own customized Solaris admin file.

ConfigureAgents on Idle
This procedure explains the steps for changing the SunUpdate Connection – Enterprise preferences
of Solaris agents in your environment. You cannot do the steps if the agent is busy with an Sun
Update Connection – Enterprise job.Make sure the agents are idle before continuing.

� ToSet PKGPreferences
In this procedure you will access and edit Preferences as needed. This proceduremust be done before
you deploy PKGs on hosts.

From the Toolsmenu, choose Preferences.

The Preferences window opens.

In the Preferenceswindow, select theHost radio button.

TheHost Selection window opens.

Select one of the hosts to receive the job and then clickOK.

TheHost Selection window closes and you are returned to the Preferences window.Wait while the
Preferences values of the selected agent are uploaded to the console and displayed in the Preferences
window.

In the Category list, click PKGs.

The PKGs preferences are displayed.

Make appropriate changes and then click Submit.

The Preferences Confirmation window opens.

The listed Targetwill be Host. The bottom panel lists the PKG parameters that you changed, with
their new values.

Check Restart Agent on target hosts.

Click Submit.

Wait for the agent to restart and come back online and then select the same host again in the Host
Selection window.
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Click Select target hosts.

The Select Hosts window opens.

Add the hosts to receive PKGdeployment to the SelectedHosts list and then clickOK.

The preferences that you changed in the original host are copied to the selected hosts.

� Mail address –Notification emails will be sent to these addresses when PKGs are installed.
� Package install basedir – Base directory where relocatable packages are to be installed.
� Instance – If the PKG to install already exists on this machine, this parameter determines what

SunUpdate Connection – Enterprise will do and has the following options:
� Quit –Do not install the PKG
� Overwrite – Install the PKG again
� Unique – Install the PKG as a unique instance

� Partial – If a partial install of a PKG is already on this machine, you can do the following:
� Nocheck –Do not check for partially installed PKGs
� Quit –Do not install the PKG if it is already partially installed

� RunLevel – If the system status is not correct for installing or uninstalling a PKG, you can choose
one of the following:
� Nocheck –Do not check run level
� Quit –Do not install or uninstall if run level requirement is notmet

� Install Depend – If other PKGs depend on the one being installed, you can choose one of the
following:
� Nocheck –Do not check for dependencies
� Quit –Do not install a PKG if its dependencies are notmet

� Remove depend – If other PKGs depend on the one that you want to uninstall, you can choose
one of the following:
� Nocheck –Do not check for dependencies
� Quit –Do not uninstall a PKG that is needed by others

� Check space – If the disk space of this managed host does notmeet the requirements of the PKG
to install, you can choose one of the following:
� Nocheck –Do not check disk space requirements (install will fail if themachine runs out of

space)
� Quit –Do not install the PKG if the listed space requirements are notmet

� Setuid flags –The setuid and setgid flags are used in Solaris programming for security. If a PKG
should enable these flags after installation, you can choose one of the following:
� Nocheck –Do not check for setuid/setgid executables
� Quit –Do not install the PKG if it will turn on these flags
� Nochange – Install the PKG, but override the flags

� Check conflicts – If the installation of a PKGwill overwrite a file provided by a previous PKG
and create a conflict between files, you can choose one of the following:
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� Nocheck –Do not check for conflicts and force install
� Quit –Do not install the PKG if file conflicts are detected
� Nochange – Install the PKG, but do not install conflicting files

� Action scripts – If an install of a PKG provides an action script that contains possible security
impacts, you can choose one of the following:
� Nocheck –Do not check for security impact of action scripts
� Quit –Do not install the PKG if its action scripts could negatively impact security

� Custom admin file full path name – Path name of a customized Solaris admin file; if none, leave
default.

MultipleDistributionHost Lists
SunUpdate Connection – Enterprise has the ability to simultaneouslymanagemachines of different
operating systems and architectures. You can create a single job and send it to any or all of your hosts.
Asingle agent will ignore the components that are irrelevant to its distribution.

You can create Inventory-based jobs, profiles, and policies that contain components of several
distributions, by selecting a new distribution in the drop-down list. However, SunUpdate
Connection – Enterprise offers a feature tomakemultiple distributionmanagement easier.

For example, if you have a group of web servers, some of which are RedHat 9.0 and others are Red
Hat Enterprise Linux 3.0Advanced Server, you can create one profile for web servers.

While you create the profile, you can apply settings to components of either of the distributions.
Then, rather than searching for the same components in the other distribution, you can use the
multiple distribution feature. It will automatically align the selected components with similar
components on the other distribution. You can either accept the automatic alignment or intervene
with checks and changes of your own.

� ToAlignComponent Settings forMultiple
Distributions
In this procedure, you will make the component settings of a profile, policy, or inventory job
applicable to hosts of multiple distributions. This will enable you to simultaneouslymanage hosts of
different distributions in a consistent manner. This feature is available from the Profile Editor, the
Policy Editor, and the Inventory panel of themain window.

In the Components list, select the component and the setting or action that youwant.
The component and the action appear in theActions list.

Dooneof the following:

� From the tool bar (mainwindowor Profile Editor), click theMulti Distributions button.
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� Right-click in theActions list and chooseMulti Distributions.

� From thebottomof the Policy Editor, click theMulti Distro button.

� From theActionsmenuof themainwindow, chooseMulti Distributions.

TheMultiple Distribution window opens.

The list of distributions is color-coded to showwhich have the selected components and which do
not.

Expand the distributions that have the components (shown in green or yellow).

� Check those components that youwant to be aligned.

� Leave unchecked the components that youdonotwant to be aligned.

ClickOK to close thewindow.

You are returned to the Profile Editor, Policy Editor, or Inventory window. The aligned component
settings are added to theActions list.
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To addmore components from thedistributions that did not have similar components (shown in red
in theMulti Distributionwindow), select a newdistribution in the drop-down list.

The components list changes to show components from that distribution. Select the ones you want
and add them to theActions list. You can add asmany component settings, frommultiple
distributions, as you choose.

Component Search
At any time that you are focused on a Components list, the Find feature is available. It operates on
the list of components that is currently active, according to the distribution that you selected.As each
list contains thousands of components, the Find feature is indispensable.

� To FindComponents
SunUpdate Connection – Enterprise jobs are based on the component level. You decide what the
requirements are for each type of machine, or for each individual machine, by selecting components
and setting actions on them. In this procedure you will search the active components list for a
component name or partial string.

Make sure that the active components list is of a relevant distribution.

If it is not, change the selected distribution in the drop-down list on the tool bar.

Dooneof the following:

� From the tool bar (mainwindowor Profile Editor), click the Findbutton.

� Right-click in theActions list and choose Find.

� From the Componentsmenu, choose Find.

The Find Components window opens.
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In the text field, type a component nameor partial string.

Select the options that youwant.

Option Checked Unchecked

Match upper/lower case Case-sensitive Case-insensitive

Include versions Results include package versions,
categories, and package groups

Results include categories and package
groups

Filter for empty names Results include non-certified objects
that have no software components
associated with them

Results include categories and package
groups

Limit search to selected
component

Search within selected category or
package group

Search throughout the entire list

List results in new
window

Display results in Search Result
window

First result highlighted in Components list

Click Find.

The Find window closes.

If the list results in the newwindow are checked, the Search Result window opens and shows all
matching components.

� Double-click a result item to highlight it in the Components list.
� Click Close in the Search Result window to apply a setting on the component.
� To find the next matching component, press F3.

If the list results in the newwindow are unchecked, the first matching component is highlighted in
the Components list.

� To find the next matching component, press F3.
� To find the previousmatch, press Shift + F3.
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ToUseRegular Expressions
The Find feature supports regular expressions and patternmatching wildcards.

SunUpdate Connection – Enterprise assumes that all search stringsmight be partial strings. You do
not need a wildcard for “any characters”. For example, if you search for gimp, the results include
gimp, gimp-print, and xsane-gimp.

If you want to restrict the default behavior, to search only for packages that begin with gimp, use:
^gimp. The carrot (outside of brackets) indicates that the stringmust be the beginning of the pattern.

� [char] – Find any of the characters in the brackets.
To find packages dealing withmarkup languages, either xml or html, search for [xht]ml.

� [^char] – Find any of the characters not in the brackets.
If you want to find http packages, but do not want the list of httpd, search for http[^d]

� [char-char] – Find a range of characters.
Aregular expression of c[a-u]p results in a list that includes cups, cdparanoia-libs, cipe, and
libcap.

JobManagement Features
The following procedures explain how to use various SunUpdate Connection – Enterprise features
that enable you tomonitor andmanage jobs after they have been created.

If your user account is restricted to simulate jobs only, you will not be able to perform all these
features. Users with full permissions can use all the procedures.

Procedures in this section include:

� “To ConfirmTasks” on page 214
� “ToMonitor a Current Job” on page 218
� “ToView Job Log” on page 219
� “To Rerun a Job” on page 220
� “To Filter the Jobs Panel” on page 221
� “ToDelete Jobs” on page 222
� “To Refresh the Jobs List” on page 223
� “To Reschedule Recurring Jobs” on page 223
� “To Install Interactive Solaris Patches” on page 224

� ToConfirmTasks
If you create a policy, you can predefine which actions should be done automatically (see “To Create a
Policy” on page 183). If you chose the predefinedAlways askme policy, or if the selected policy did
not answer all actions, the job will pause for your confirmation. In this procedure, you will confirm
or deny actions of a task of a job. The confirmation answers apply to all hosts selected for the job.
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Make sure the Jobs panel of themainwindow is available. From theViewmenu, choose Jobs.

From the Jobs list, click a paused job, indicatedwith the confirmation icon.

The tasks of the job appear in the Tasks list.

Select a task namewith the confirmation icon.

Doone of the following:

� From the tool bar, click the Confirmation button.

� Right-click the selected task and choose Confirmation.

� From the Jobsmenu, choose Tasks -> Confirm.

The Confirmation window opens, displaying suggested actions.
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If a confirmation question dealswith a component forwhich youneedmore information, select the
question and click theDetails button.

The Component Information window opens.

When youhave the information youneed, clickOK to close the Component Informationwindow. You
are returned to the Confirmationwindow.

In the Confirmationwindow, select Yes to the questions you confirmandNo to those youdonotwant
SunUpdate Connection – Enterprise to performon the selected hosts.

There are different types of questions, and your answers will cause different effect.
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Question Yes No

Install, Uninstall,
Upgrade,
Downgrade

SunUpdate Connection – Enterprise
will perform this action.

The DRwill execute again, searching for a solution
that does not include these actions.

If another solution is not found, the job fails.

Apply Fix SunUpdate Connection – Enterprise
will fix the dependency, security, or
bug issue.

SunUpdate Connection – Enterprise will not apply
the fix in this job.

Perform action
(Mandatory)

SunUpdate Connection – Enterprise
will perform some action that is
necessary to apply the deployment on
the selected hosts.

The job will fail.

Perform action
(without
Mandatory)

SunUpdate Connection – Enterprise
will perform some action that is
necessary to apply the deployment on
the selected hosts.

TheHost Progress window shows Attention!You
do the listed actionmanually.

Accept You accept that you have to do the
special actionmanually.

Until you handle the action, the job
will bemarked as failed.

This action does not concern you; possible effects:
� TheHost Progress windowwill show a

reminder that this action should be done by
someone at some point.

� If the action is mandatory, the job will fail.

ClickOK.

More InformationAbout Confirmation

WhatHappensAfter Task Confirmation
If the job was in Simulatemode, the actions and results are calculated, giving you an accurate
estimation of the required time and changes, and whether your answers will allow the job to succeed.

If the job was in Deploymode, the confirmed actions that SunUpdate Connection – Enterprise can
do automatically are done on the selected hosts. If you have confirmed anAcknowledge question, the
Host Progress windows shows Acknowledged: <action>. Remember that the results of the job
might not be applied to the hosts until you actually do the acknowledged action.

If the Host Progress window shows Attention! <action>, you should do the action to have the
results applied. Some actions can be done through SunUpdate Connection – Enterprise. For others,
you should askmake sure the action is done at some point, by someone.

If a job fails because you said No to a question, the reason given in the Host Log is: Resolve failure
- cannot resolve solution. User request.
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� ToMonitor a Current Job
After you send a single job to be done on a list of hosts, the agent installed on each host finds an
individual solution for the job. You canmonitor the progress of each host, separately, as it performs
the actions of a task in a job. You can also view the job log of each host. This procedure explains how
to open and understand theHost Progress window and the Job Log window for a host.

Make sure the Jobs panel of themainwindow is available. From theViewmenu, choose Jobs.

From the Jobs list, select a job.

The tasks of the job appear in the Tasks list.

From the Tasks list, select a task.

The hosts running this task appear in the Hosts list of the Jobs panel.

Select a host.

Do one of the following:

� From the tool bar, click theHost Progress button.

� Right-click the selected host and chooseHost Progress.

� From the Jobsmenu, chooseHosts -> ShowProgress.

TheHost Progress window opens.
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Monitor the actions of the host for the selected task:

� Basket – The actions that you requested.

� Resolve – Status of the dependency resolver finding a solution.

� ToDoList – List of actions to be taken to fulfill the solution. This listmight contain special
actions. If it is Perform <action>, Sun Update Connection – Enterprise does the action
automatically. If the To Do item is Attention! <action>, you are expected to handle the action
yourself before the jobwill continue.

If there is a problem, you can click the Stop Job button. The job will stop at a safe place.

� ToView Job Log
When a job is done, either on success or failure, you can see the log of actions for all tasks of the job
on the selected host. Each host may have a different log for the same job.

Make sure the Jobs panel of themainwindow is available. From theViewmenu, choose Jobs.
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From the Jobs list, select a job.

The tasks of the job appear in the Tasks list.

From the Tasks list, select a task.

The hosts running this task appear in the Hosts list of the Jobs panel.

Select a host.

Open the Job Log. Doone of the following:

� From the tool bar, click the Job Logbutton.

� Right-click the selected host and choose ShowLog.

� From the Jobsmenu, chooseHosts -> ShowLog.

The Job Log window opens.

The Job Log shows each phase and whether it started and finished successfully. If there are any
errors, they are listed.

To send the log to technical support, click SaveAs, save the log on the consolemachine, and email
it with all relevant details.

If the failure reason is User request, run the job again with different Confirmation answers or a
different Policy. This error indicates that you denied actions that were necessary to the success of the
job.

� ToReruna Job
Rerun a job that has completed, either successfully or with a failure.

Make sure the Jobs panel of themainwindow is available.

From the Viewmenu, choose Jobs.

From the Jobs list, select a job.

Doone of the following:

� From the tool bar, click the Rerunbutton.

� Right-click the selected job and choose Rerun.

� From the Jobsmenu, choose Rerun.

The Rerun window opens.

2

3

4

5

1

2

3

JobManagement Features

SunUpdate Connection – Enterprise 1.0 User’s Guide • September, 2006220



Give the job a newnameand anoptional description.

Select amode for the job:

� Deploy – Execute the job actions

� Simulate – Test the job

If the job failed because the policy did not allow certain components to be changed, check Ignore
Policy to ensure that the job has a chance to succeed.

ClickOK.

The Rerun window closes and the new job is added to the Jobs list. This job runs the same tasks, on
the same host list, as the original job.

� To Filter the Jobs Panel
Set the filters to show the information you want in the Jobs panel. This enables you to easily find
information about jobs, tasks, and hosts in the Jobs list that is important to you.

Make sure the Jobs panel of themainwindow is available.

From the Viewmenu, choose Jobs.

Dooneof the following:

� From the tool bar, click the Filter button.
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� Right-click in the Jobs list and choose Filter.

� From the Jobsmenu, choose Filter.

The Jobs Filter window opens.

Check options to filter the list for jobs by status andby owner.

ClickOK.

The Jobs list changes to display only the jobs that match the checked filtering options.

Note –You can organize the Jobs list by dragging columns in any order you choose. You can click a
column header to order the list alphanumerically.

� ToDelete Jobs
In this procedure, you will delete job listings that are no longer relevant.When you delete a job
listing, the data remains in the system dependency server. You can query job history from reports (see
“JobHistory Reports” on page 249).

Note –You can use the profiles and policies of jobs that are in the list, so do not delete jobs until you
are sure they are no longer relevant.
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Make sure the Jobs panel of themainwindow is available.

From the Viewmenu, choose Jobs.

From the Jobs list, select a job that is no longer current.

Do one of the following:

� From the tool bar, click theDelete Jobbutton.

� Right-click in the Jobs list and chooseDelete.

� From the Jobsmenu, chooseDelete.

The job listing is removed from the Jobs window.

� ToRefresh the Jobs List
The Jobs list is updated for current dynamics on a schedule. If you want tomake sure that the list is
accurate, use this procedure to force the update and refresh the list.

Make sure the Jobs panel of themainwindow is available. From theViewmenu, choose Jobs.

Do one of the following:

� From the tool bar, click the Refresh button.

� Right-click in the Jobs list and choose Refresh.

� From the Jobsmenu, choose Refresh.

The list is updated, if necessary.

� ToReschedule Recurring Jobs
If you set a Complex job for a recurring schedule, you can change the schedule at any time after it is
in the Jobs list.

Make sure the Jobs panel of themainwindow is available. From theViewmenu, choose Jobs.

Do one of the following:

� From the tool bar, click the Reschedule button.

� Right-click in the Jobs list and choose Reschedule.
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� From the Jobsmenu, choose Reschedule.
The Reschedule window opens.

Select days of themonth:

� Every day – Job runs every day of themonth, or year (if EveryMonthwas selected).

� Day inweek – Select the days of theweek onwhich the jobwill be run.

� Day inmonth – Select dates in themonth onwhich the jobwill be run (use Shift or Control to
selectmultiple dates).

Select timeof the day:

� Earliest. Set a time (hour:minute) for the first run of the job.

� Interval. Set aminute interval to have the job runmore than one time aday.

� Latest. Set a time for the latest run of the job if you specified an interval formultiple runs.

ClickOK.

� To Install Interactive Solaris Patches
You can install Solaris patches as an inventory-based job or as a complex job. Some patches are
handled automatically by SunUpdate Connection – Enterprise, while other patches demand user
interaction.

When you need to install an interactive Solaris patch, SunUpdate Connection – Enterprise
downloads the patch for you, but youmust handle themanual intervention actions yourself.

Create a job to install the patches.

Run the job.
The job will pause with confirmation questions.

From the Jobs panel, select the task that contains the patch and click the Confirmation button.
The Confirmation window opens.

One of the following questions will appear:

�

Accept Install of patch requires manual intervention for component
�
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Accept Uninstall of patch requires manual intervention for component

Click Yes for this question.
Thismeans that you accept the responsibility for handling this patch. If you select No, the job fails.

In the Confirmationwindow, clickOK.
The job begins. It downloads the patch you requested to the /opt/local/uce/agent/blobs.save
directory on the selected Solaris machines.

When the job reaches the point where it would install the patch, it is marked as failed and stops.

On the Solarismachines,manually install /opt/local/uce/agent/blobs.save/patchname-ver.

On the consolemachine, right-click the job in the Jobs panel and choose Rerun.
The Rerun window opens.

Select Deploy and then clickOK.
SunUpdate Connection – Enterprise runs the job again, recognizes the installed required patch, and
continues.

Troubleshooting Jobs
In the Jobs panel, youmight see that a job failed on a host. There are various reasons for a failed job,
and different ways in which you can handle the issue.

To which troubleshooting procedure is most relevant, open the Job Log (see “ToMonitor a Current
Job” on page 218).

Procedures in this section include the following:

� “Handling Resolve Failures” on page 225
� “Handling Failures Due to Cost” on page 226
� “HandlingMissing Components” on page 226
� “Handling Installation Issues” on page 227

HandlingResolve Failures
If a job failure occurs during the resolve stage, troubleshoot the solution offered by the Dependency
Resolver with these checks.

� Open theHost Progress window of a failed host and check formanual intervention points.
Handle themanual procedures and rerun the job.

� Open the Job Log of a failed host. Carefully check components and actions in the job. For
example, youmight have created a profile that demanded conflicting actions on some
components. Recreate the job without the problematic components.
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� Change or create a policy that causes the agent to look for a different DR for the job. The
confirmation policy should NotAllow the components listed under the failure reason to receive
the failed actions.
Youmight find it helpful to review the Resolve Log of the failed host. Open the Preferences
window of the selected host to find the directory and file name of this log (see “Host Preferences –
Logs” on page 301).

Handling FailuresDue toCost
Sometimes a failed DR cannot be fixed. The message cost in change too high indicates that the
DR found somany components that would have had to be changed, that it will not go on.

� If you requestedmany components, break up your request into smaller jobs.
� If you requested only a few components, trymaking a job of each component separately. You will

probably find one that demands toomany dependency fixes. Perhaps you can select an
alternative component.

HandlingMissingComponents
Sometimes a component cannot be installed or uninstalled. One of the following errors might appear
to explain the DR failure:

�

component is not installable by current KB

�

component is not removable by current KB

Only Local components may be not installable or not removable. To handle these issues, open the
Local category in the Components list of themain window. Expand the subcategories until you find
the problematic components.

� The Components list might include listings for which you do not have the software component:
an NCOwithout an attached software, a 3rd-Party application for which you do not have a
license, a tool without an uploaded script, and so on.
If this is the problem, the package will bemarked with an empty software icon.
If you see one of these icons, upload the required software component.
See “Fixing Local Dependencies” on page 100.

� The local componentmight be in the knowledge base, but missing dependencies according to the
deployment rules.
If this is the problem, the package will bemarked with an exclamation point in a red circle.
Right-click the component and choose Component Details.
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The Component Information window opens, displaying themissing requirements in the
Dependencies tab.

Handling Installation Issues
If the job failed during installation, use these checks to find a solution.

� Check the permissions needed by the component for install. The permissionsmight conflict with
the permissions of the logged-in user. The Job Log of the failed host will show permissions as the
reason for failure.

� Try to install the componentmanually with Linux terminal commands.Afterwards, run a Check
System (see “Running Predefined Profiles” on page 140) to handle dependency issues.
If the installation fails for anNCO (non-certified component), the Job Logmight provide one of
the following reasons.
� Conflict with. Listed NCOhas possible conflicts with a component from the ToDo list.
� Downgrade. Listed NCO appears to be a newer version of a component from the ToDo list.
� Possible Unavailability. Installing one of the components from the ToDo list might cause

the listed NCO to become inoperable.

� Run the Local Software Review predefined profile and replace NCOswith COs, or uninstall the
NCOs.

� Make sure that the NCOhas been detected and added to the components list. If the local software
package is not under Local RPMs or Local PKGs, search for it under a CO listing in Software (see
“To Find Components” on page 212). If the NCO is not in the components list, add it (see
“Adding Undetected Linux Software” on page 85).
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Reports

This chapter describes SunUpdate Connection – Enterprise reports. This chapter defines each
report, shows how to access them, customize them, and understand the report results. Reports enable
you to better manage yourmachines, with regards to patch and incidentmanagement.

This chapter covers the following topics:

� “Terms” on page 229
� “Report Explanations” on page 230
� “Generating Reports” on page 231
� “Filtering andViewing Incident Reports” on page 232
� “Incident Compliance Reports” on page 236
� “Host Compliance Reports” on page 240
� “CVECompliance Reports” on page 242
� “Package Compliance Reports” on page 244
� “Service Pack Compliance Reports” on page 247
� “JobHistory Reports” on page 249
� “Managing Reports” on page 250

Terms
This chapter uses the following terms:

Enhancement Package provided by and defined by a distribution vendor as a fix
that is neither security nor bug fix, but which enhances an earlier
package.

Patch Sun Solaris binary, named in a numbering system, that adds some
type of fix to an already installed PKG.

Nonpatch RPMs from Linux advisories or PKGs from Sun Freeware, which
provide a fix to an existing package; not as a binary to be added to
a package, but as a standalone package.
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Incident Fix for an application or feature that may include a number of
packages.

Channel Linux distribution version or Solaris version, and hardware
architecture.

CVE ID Patches and packages from the list of candidates to be published
as common vulnerabilities and security exposure incidents (also
known as CVE ID). See
http://cve.mitre.org/cve/index.html.

Compliant Host has the patch, package, incident, or profile installed.

Service Pack Mass release of packages by a distribution vendor, which when
installed will solve various incident issues.

Report Explanations
Reports offer access to the latest patches, fixes, and incidents. There is also a report type for Sun
Update Connection – Enterprise job history, for general job auditing.

When you ask that a report be generated, you select the criteria that are relevant to you, such as host
list and whether you want to knowwhich hosts have a specific patch or whether you want to know
which do not. The report that is generated is a table of information that you can easily review for
efficient, up-to-datemanagement of all your hosts.

� Incidents – Basic information of all known distribution and local incidents.
� CVECompliance – Incidents that belong to a given CVE ID.
� Host Compliance –Reports on whether hosts are compliant to security and bug fix incidents.
� Incidents Compliance –Mapping between selected incidents and selected hosts; to find if

incidents are installed.
� Package Compliance – Incidents relevant to selected packages.
� Service Pack – Incidents created by the publication and release of a service pack by a vendor.
� JobsHistory –History of installs and uninstalls done by SunUpdate Connection – Enterprise on

managed hosts.

Reports enable you to check for new patches, security advisories, and so on. You can get a general
report, or test a host or installed package for available fixes. You can search for specific Solaris patches
by their CVE IDs.

Report Explanations

SunUpdate Connection – Enterprise 1.0 User’s Guide • September, 2006230

http://cve.mitre.org/cve/index.html


GeneratingReports
When you open the Reports window, there is a list of types of reports. You select the type that you
want, fill in the criteria options, and then decide whether you want to generate the report
immediately, or save the criteria as a report template.

� ToAccess Reports
Dooneof the following:

� From the tool bar, click the Reports button.

� From the Toolsmenu, choose Reports.

The Reports window opens.

Select one of the report types.

1
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From the tool bar of the Reportswindow, click theNewbutton.

AReport Editor window opens where you choose the criteria to create the new report. Each report
type opens a different Report Editor window.

Type a unique name for the new report and anoptional, free-text description.

Choose the relevant criteria.

Do one of the following:

� Click Report.

Areport is displayed in a Report Result window. The columns of this window differ between the
types of reports.

� Click Save.

The report criteria are saved as a template, under the report type. Select the report template and
click Report to get current results, as often as you like.

Filtering andViewing Incident Reports
Generate Incident reports to get a list of incidents linked to packages, CVE IDs, or just a general list
of incidents. This report does not tell you if your hosts are compliant with the incidents. It provides
information about incidents of filtered categories and types, or a complete list of incidents for a
channel.

When an incident is published by a vendor, it containsmore than the packages; it also contains
information on the source issue of the incident and why the packages included are needed. You can
access this information as well through the Incident report.

� To Filter an Incident Report
Filter an incident report in the Incident Report Editor window. The criteria that you select can create
a large general list or a specific query.

In the Reportswindow, select Incidents and then click theNewbutton.

The Incidents Report Editor opens.
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Select categories and types of incidents that are relevant to the report.

Youmust select at least one category and one type.

Click Report now if youdonotwant to applymore filters.

� To Filter a Report byDate
Click the Select Dates button.

The Select Dates window opens.

Select a date range:

� Relative. Specify howmanydays since the incidentwas published.

2
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� Range. Click the Select Dates buttons to specify a start date and an enddate for the time range.

If the date is not important, leave the defaultAny date selected.

� To Filter a Report byChannel
Click the Select button next to the Channel box.

The Channel Select window opens.

Select relevant channels.

To select multiple channels, use the Shift key or the Ctrl key. To select all, type Ctrl+A.

ClickOK.

The selected channels appear in the Channel box of the Report Editor.

� To Filter a Report by Specific Package, CVE ID, or
Incident
Click a Select button.

The Select window opens and shows the filter names.

Select relevant items and click Add.

ClickOK.

Viewing Incident Reports
After you select the criteria in the Incident Report Editor, you can generate the report, or name it and
save it as a template. If you save it as a template, you can select the template and then click Report in
the Reports window.Whether you generate the report from the editor window or from a template,
the same Report window opens.

1
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FIGURE 13–1ReportWindow– Incidents

Each line in the Report shows the incident name (defined by vendor), category, type, channel, and
release date. It shows the number of packages that belong to this incident.

To see package details of an incident, select an incident name in the report and then click Details.A
new Report window opens, displaying the packages needed for the selected incident. The
Recommended columns list the latest incident name and package version that is recommended for
you to install. If an incident is a newer fix to a previous incident, the recommended incident shows
which incident (and installation of its packages) will bring your systemsmost up-to-date.

To see informational details of an incident, select a line in the new report list and click Incident
Information. The Incident Information window opens.
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FIGURE 13–2 Incidents Information

The Incident Information window has the following tabs:

� General. Includes the name, category of incident, summary (if the vendor published one), date
released, and type (nonpatch or patch).

� CVE. Shows the ID in the CVE list.
� Package. Shows the list of packages that are related to this incident.
� Obsolete. Shows the list of incidents that aremade obsolete by this incident.
� URL. Shows the reference tomore information published by the vendor.

Incident ComplianceReports
Generate Incident Compliance reports to discover which incidents should be installed, or have
already been installed, on which of your hosts. The report provides relevant information. The
Incident report shows all incidents. The Incident Compliance report filters the list for what is
relevant to each selected host.

Incident Compliance Reports
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� To Filter an Incident ComplianceReport
Filter an incident compliance report in the Incident Compliance Report Editor window. This report
requires that you filter for incident name. Youmay choose all available incidents, tomake a very
general report; or youmay choose a specific incident to get a report of host compliance on this
particular set of packages.

In the Reportswindow, select Incident Compliance and then click theNewbutton.

The Incident Compliance Report Editor opens.
1
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FIGURE 13–3 IncidentComplianceReport Editor

Click the Select buttonby theHosts box.

The Select Hosts window opens.

Select relevant hosts and click theAddbutton to add them to the Selected list.

ClickOK.

The selected hosts appear in the Hosts box.
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Select one of the following status options:

� Compliant. Showhosts that have the selected incidents installed.

� Not Compliant. Showhosts that should have the incidents installed.

To check compliancewith specific incidents, select the Select Incidents radio button and click the
Select button next to theNamebox.

The Select window opens and shows incident names.Add the incidents on which you want the
report.

To check compliancewith incidents of categories or types, select the Filter radio button and then
select categories and types of incidents (youmust select one of each).

Optionally, you can filter the incidents for date (see “To Filter a Report by Date” on page 233),
included packages, and CVE ID (see “To Filter a Report by Specific Package, CVE ID, or Incident”
on page 234

Viewing Incident ComplianceReports
After you select the criteria in the Incident Compliance Report Editor, you can generate the report, or
name it and save it as a template. If you save it as a template, you can select the template and then
click Report in the Reports window.Whether you generate the report from the editor window or
from a template, the same Report window opens.

Each line in the Report shows the incidents you selected, or those that matched your filters, and the
number of hosts with the compliance status that you selected (compliant or not compliant). If you
selected compliant for status, the report shows howmany of the selected hosts have this incident
installed. If you selected not compliant, the report shows howmany of the selected hosts should have
this incident installed.

To see which hosts are counted in the row, select an incident name in the report and then click
Details.Anew Report window opens, displaying the host names and the number of packages needed
for the selected incident.

To see package details, click Details again. The Report window is cleared, and then it displays the
packages needed for the selected incident. It shows the versions that are currently installed and lists
the versions that should be installed to finalize this incident.

To see informational details of an incident, select a line in the new report list and click Incident
Information. The Incident Information window opens.
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� ToCreate an Incident Compliance Job
From the Incident Compliance report, you can create a job to install the packages that are related to a
selected incident on the hosts selected in the report editor.

In the Incident Compliance Report Editor, select Not Compliant for the Status.

Select the remaining criteria for the report and thengenerate the report.

Select a specific incident and then clickDetails.

The report shows the noncompliant hosts.

Select hosts and then clickDetails.

The report shows the packages to install on the hosts.

Select packages and then click Send Job.

The job installs the recommended version.

Host ComplianceReports
Generate Host Compliance reports to discover hosts should be updated for security fixes. Youmay
choose to get a report that lists hosts that are compliant; or a report of those that need to be fixed. The
security issues could be of those incidents that are security; or it could include both security and bug
fixes.

� To Filter aHost ComplianceReport
Filter a host compliance report in the Host Compliance Report Editor window. This report requires
that you filter select an option from each filter.

In the Reportswindow, select Host Compliance and then click theNewbutton.

TheHost Compliance Report Editor opens.
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FIGURE 13–4HostComplianceReport Editor

Select hosts for the report.

See “To Filter an Incident Compliance Report” on page 237.

Select status options:

� Compliant. Showhosts that are compliantwith known security incidents.

� Not Compliant. Showhosts that needmanagement to be compliant.

Select level of incidents:

� Security. Show security incidents

� Bugfix. Show security andbugfix incidents

ViewingHost ComplianceReports
After you select the criteria in the Host Compliance Report Editor, you can generate the report, or
name it and save it as a template. If you save it as a template, you can select the template and then
click Report in the Reports window.Whether you generate the report from the editor window or
from a template, the same Report window opens.
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Each line in the Report shows the hosts you selected and the number of incidents with the
compliance status that you selected (compliant or not compliant). If you selected compliant for
status, the report shows howmany incidents have been installed on each of the selected hosts; if you
selected not compliant, the report shows howmany incidents should be installed on each host.

To see which incidents are counted in the row, select a host name in the report and then click Details.
The report displays the incident names.

To see package details, click Details again. The report displays the packages needed for the selected
incident. It shows the versions that are currently installed and lists the versions that should be
installed to finalize this incident.

To see informational details of an incident, select a line in the new report list and click Incident
Information. The Incident Information window opens.

� ToCreate aHost Compliance Job
From theHost Compliance report, you can create a job that will install the packages related to
needed incidents on the selected hosts.

In theHost Compliance Report Editor, select Not Compliant for the Status.

Select the remaining criteria for the report and thengenerate the report.

Select a specific host and then click Send Job.

The job installs the recommended version of each package.

Optionally, you can send the job from the report windows opened after clicking Details, to create a
smaller job, of selected incidents, or selected packages.

CVEComplianceReports
Generate CVECompliance reports to find incidents related to specific CVE IDs and the hosts that
should have these incidents installed.

� To Filter a CVEComplianceReport
Filter a CVE compliance report in the CVECompliance Report Editor window. This report requires
that you filter select an option from each filter.

In the Reportswindow, select CVE Compliance and then click theNewbutton.

The CVECompliance Report Editor opens.
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Select hosts for the report.

See “To Filter an Incident Compliance Report” on page 237.

Select one of the following status options:

� Compliant. Showhosts that are compliantwith known security incidents.

� Not Compliant. Showhosts that needmanagement to be compliant.

Select the CVE IDs that youwant SunUpdate Connection – Enterprise tomatch to incidents.

See “To Filter a Report by Specific Package, CVE ID, or Incident” on page 234.
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ViewingCVEComplianceReports
After you select the criteria in the CVECompliance Report Editor, you can generate the report, or
name it and save it as a template. If you save it as a template, you can select the template and then
click Report in the Reports window.Whether you generate the report from the editor window or
from a template, the same Report window opens.

The Report shows the CVE IDs you selected and the number of incident-packages with the
compliance status that you selected (compliant or not compliant). If you selected compliant for
status, the report shows howmany packages have been installed on each of the selected hosts to be
compliant with an incident. If you selected not compliant, the report shows howmany packages
should be installed on each host for incidents of this CVE ID.

To see which incidents are counted in the row, select a host name in the report and then click Details.
The report displays the incident names and the packages of each incident.

To see informational details of an incident, select a line in the new report list and click Incident
Information. The Incident Information window opens.

� ToCreate aCVECompliance Job
From the CVECompliance report, you can create a job that will install, on the selected hosts, the
packages needed to resolve the CVE ID and the incidents related to it.

In the CVECompliance Report Editor, select Not Compliant for the Status.

Select the remaining criteria for the report and thengenerate the report.

Select listed CVE IDs and then clickDetails.

The report shows the packages to install.

Select packages and then click Send Job.

The job installs the recommended version of each package.

PackageComplianceReports
Generate Package Compliance reports to find incidents related to specific packages. For example, if
you have amission-critical application, use the Package Compliance Report to discover is there are
new incidents related to this application and tomake sure you have up-to-date versions of relevant
packages.
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� To Filter a PackageComplianceReport
Filter a Package Compliance report in the Package Compliance Report Editor window. This report
requires that you filter select an option from each filter.

In the Reportswindow, select Package Compliance and then click theNewbutton.

The Package Compliance Report Editor opens.

Select hosts for the report.

See “To Filter an Incident Compliance Report” on page 237.

Select one of the following status options:

� Compliant. Showhosts that are compliantwith known security incidents.

� Not Compliant. Showhosts that needmanagement to be compliant.

Select one of the following level options:

� Security. Show security incidents.
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� Bugfix. Show security andbugfix incidents.

Select the packages that youwant SunUpdate Connection – Enterprise tomatch to incidents.

See “To Filter a Report by Specific Package, CVE ID, or Incident” on page 234.

ViewingPackageComplianceReports
After you select the criteria in the Package Compliance Report Editor, you can generate the report, or
name it and save it as a template. If you save it as a template, you can select the template and then
click Report in the Reports window.Whether you generate the report from the editor window or
from a template, the same Report window opens.

The Report shows the packages you selected and the number of hosts and incidents with the
compliance status that you selected (compliant or not compliant). If you selected compliant for
status, the report shows howmany hosts have this package to be installed; if you selected not
compliant, the report shows howmany hosts need this package to be installed.

To see which incidents and hosts are counted in the row, select a package name in the report and then
click Details. The report displays host names and incidents, what is installed on the hosts and what is
recommended for installation.

To see informational details of an incident, select a line in the new report list and click Incident
Information. The Incident Information window opens..

� ToCreate aPackageCompliance Job
From the Package Compliance report, you can create a job that will install, on the selected hosts, the
package version need to resolve the incident.

In the Package Compliance Report Editor, select Not Compliant for the Status.

Select the remaining criteria for the report and thengenerate the report.

Select listed packages and then clickDetails.

The report shows the hosts on which the package should be installed.

Select packages and then click Send Job.

The job installs the recommended version of each package.
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Service PackComplianceReports
Generate Service Pack Compliance reports to find if your hosts have the latest service packs provided
by vendors.

� To Filter a Service PackComplianceReport
Filter a Service Pack Compliance report in the Service Pack Compliance Report Editor window. This
report requires that you filter select an option from each filter.

In the Reportswindow, select Service Pack Compliance and then click theNewbutton.

The Service Pack Compliance Report Editor opens.

Select hosts for the report.

See “To Filter an Incident Compliance Report” on page 237.

Select one of the following status options:

� Compliant. Showhosts that are compliantwith known security incidents.
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� Not Compliant. Showhosts that needmanagement to be compliant.

Select the service packs that youwant SunUpdate Connection – Enterprise tomatch to the selected
hosts.

See “To Filter a Report by Specific Package, CVE ID, or Incident” on page 234.

ViewingService PackComplianceReports
After you select the criteria in the Service Pack Compliance Report Editor, you can generate the
report, or name it and save it as a template. If you save it as a template, you can select the template
and then click Report in the Reports window.Whether you generate the report from the editor
window or from a template, the same Report window opens.

The Report shows the service packs you selected and the number of packages with the compliance
status that you selected (compliant or not compliant, with the service pack). If you selected
compliant for status, the report shows howmany packages of the service pack are installed on the
host; if you selected not compliant, the report shows howmany packages this host needs to install.

To see which packages are counted in the row, select a host name in the report and then click Details.
The report displays host names and packages, what version is installed on the hosts and what version
is recommended for installation.

Running Service PackCompliance Jobs
From the Service Pack Compliance report, you can create a job to install, on the selected hosts, the
package version need to install the service pack contents.

� ToCreate a Service PackCompliance Job

In the Service Pack Compliance Report Editor, select Not Compliant for the Status.

Select the remaining criteria for the report and thengenerate the report.

Select listed packages and then clickDetails.

The report shows the hosts on which the packages should be installed.

Select packages and then click Send Job.

The job installs the recommended version of each package.
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JobHistory Reports
Generate JobHistory reports to get a detailed history of the install and uninstall actions taken on
hosts throughout SunUpdate Connection – Enterprise management. This report also shows which
usermade the deployments, enabling you to track a team of operators.

� To Filter a JobHistory Report
Filter a JobHistory report in the JobHistory Report Editor window. This report requires that you
filter select an option from each filter.

In the Reportswindow, select JobHistory and then click theNewbutton.

The JobHistory Report Editor opens.

Select hosts for the report. See “To Filter an Incident Compliance Report” onpage 237.

Select one of the following level options:

� Security. Show security incidents.

� Bugfix. Show security andbugfix incidents.
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Select relevant dates.

See “To Filter a Report by Date” on page 233.

Select one of the following action options:

� Installs. Showdetails of installations done on the selected hosts anddates.

� Uninstalls. Showdetails of uninstallations done on the selected hosts anddates.

Viewing JobHistory Reports
After you select the criteria in the JobHistory Report Editor, you can generate the report, or name it
and save it as a template. If you save it as a template, you can select the template and then click Report
in the Reports window.Whether you generate the report from the editor window or from a template,
the same Report window opens.

The Report shows the date and time that an action was done, what the action was and onwhat
component and host, the job that called for the action, and the user that created the job.

ManagingReports
You can copy, edit, and delete report templates. You create a report template by saving the criteria of a
report.

If you generate the report without saving, these features are not available. In addition, these features
are not applicable to the default report types.

After a report is generated, you can perform various actions with it.

ManagingReport Templates
� To delete a report, select a report template that you created and then click the Delete button in the

tool bar.
� To edit a report, select a report template that you created and then click the Edit button in the tool

bar.
� To create a new report or report template based on a previously created template, select a report

template shown under a default report type, and click the Copy button in the tool bar.
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ManagingReport Results
� To save the report results in a text file, click the Save button.
� To print the report, click the Print button.
� To email the report, click the Send button.
� To get more details on a selected item in the report, click the Details button.
� To create a job that will fix the compliance issues, click the Run button.

Managing Reports
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Command-Line Interface

The Command-line interface (CLI) is provided with the SunUpdate Connection – Enterprise Suite.
You can install it and activate it on anymachine in the network that includes the other SunUpdate
Connection – Enterprise applications. The CLI enables SunUpdate Connection – Enterprise
Console functionality without opening the graphical user interface.

SunUpdate Connection – Enterprise CLI commands can be run either as single lines or embedded
in scripts.

This chapter covers The following topics:

� “Syntax” on page 253
� “Commands” on page 255

Syntax
The command to initiate the CLI is uce_cli.

Note –You can also initiate the CLI with the osc command, which still exists for backward
compatibility purposes. This osc commandmight be removed in future releases.

uce_cli -command -parameter value [...] [-flag][...] -u username -p password

The following command searches for a component with apac in its name:

# uce_cli -fc -T "apac" -u myname -p mypass
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Arguments
The uce_cli command has these two types of arguments:

� Parameter syntax is dash (-), name, space, value: -param value
� Flags have no value. If a flag is specified, it indicates a true value. If a flag is not specified, it

indicates a false value. Flag syntax is dash, name: -flag

You can specify the -verbose flag with any command to produce troubleshooting information as
part of the command output.

Some commands have an optional parameter for the delimiter of output. The delimiter is the
separator between items in output. By default, the delimiter is a line feed, so each item appears on a
separate line. You can change the delimiter in commands that offer this option to any set of
characters or whitespace that meets your requirements.

If you want each item to appear in one line with commas, specify -dlt ", " as the delimiter in the
command.

Some commands have a parameter (usually -T or -pT) whose value is a component in the knowledge
base.When providing the name of a component, in particular, of a Local component, include its
knowledge base path, to ensure that the name is unique. For example, specify the -T parameter as
follows:

-T "Local/Configuration files/yourCat/yourDec/yourFile"

UserNames andPasswords
Every CLI command is accessed with an existing SunUpdate Connection – Enterprise user name of
a user with full permissions, or the admin user, and with its password. Youmay type these access
details directly into the commandwith the -u and -p parameters.

If you do not provide the -u and -p parameters in the command, the CLI prompts for them:

# uce_cli -lg command to list all groups

Initializing ... “Initializing” is output as notification.

Username: admin “Username” is prompted.

Password: “Password” is prompted. Input is hidden.

Special Characters
If a parameter value has a space or a special character, close the value in straight quotationmarks ("
").

Syntax
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The exclamationmark (!) is not a valid character even in quotes. To use it, youmust protect it with a
backward slash: \!.

Local components may have names with the forward slash (/). For example, you could create a
category of Configuration files called "/etc", to show that these files have target installations in the
/etc directory. In the CLI commands, when you use a component that has / in its name, protect it
with a backslash (\), so that the CLI can identify it as part of a string rather than a path.

For example, say that you have a category named /etc, a file declaration named /etc/hosts, and a
file version called /etc/hosts-5 in the Local components list.

The CLI requires that you refer to this hierarchy as the following:

ROOT/Local/Configuration files/\/etc/\/etc\/hosts/\/etc\/hosts-5

Commands
The CLI offers a set of commands to perform SunUpdate Connection – Enterprise functions.

The commands can be divided into the following categories:

� “List and Find Commands” on page 255
� “Host andGroup Commands” on page 265
� “Local Component Commands” on page 268
� “Policy Commands” on page 271
� “Job Commands” on page 274
� “Inventory Commands” on page 275
� “Help Commands” on page 279

List and FindCommands
The commands in this section are useful for all the other commands. They are used to find the values
of other parameters. For example, if you have a command that needs a distribution name, run the
-ld command to get the list of valid input.

This section includes the following:

� “List Distributions (-ld) Command” on page 256
� “Find Component (-fc) Command” on page 257
� “ListAll Hosts (-lah) Command” on page 258
� “List Host Properties (-lh) Command” on page 258
� “List Host Inventory (-lhi) Command” on page 259
� “List Groups (-lg) Command” on page 259
� “List Group’s Hosts (-lgh) Command” on page 260
� “List Profiles (-lp) Command” on page 260
� “List Policies (-lc) Command” on page 261

Commands
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� “List ProfileAttributes (-lpa) Command” on page 261
� “List PolicyAttributes (-lca) Command” on page 262
� “List Logs (-ll) Command” on page 263
� “List Jobs Status (-ljs) Command” on page 263
� “List Job StatusAttributes (-ljsa) Command” on page 264
� “List Saved Snapshots (-lss) Command” on page 264

List Distributions (-ld) Command
The list-distributions command outputs the supported distributions on your local system.If you add
the -all flag, all SunUpdate Connection – Enterprise supported distributions are output.

Use this command to get valid values for the -D (distribution) parameter used in other CLI
commands.

Flag -all – List all distributions supported by SunUpdate Connection – Enterprise.

Without this flag, only the distributions that have been locally activated are listed.

Syntax uce_cli -ld [-all] -u username -p password

Example uce_cli -ld -u admin -p 123

Result Example Available Distributions:

RH9_IA32

SLES8_S390

Example uce_cli -ld -all -u admin -p 123

Commands
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Result Example Available Distributions:

RH72_IA32

RH73_IA32

RH8_IA32

RH9_IA32

FC2_IA32

AS21_IA32

ES21_IA32

AS3_IA32

ES3_IA32

WS3_IA32

AS3_AMD64

WS3_AMD64

SUSE9_IA32

SUSE92_IA32

SLES8_IA32

SLES9_IA32

SLES7_S390

SLES8_S390

SLES8_AMD64

SUSE9_AMD64

SOLARIS8_SPARC

FindComponent (-fc) Command
The find-component command returns the exact names of components.

Use this command to get the values for the -T or -pT parameter used by other commands.

Parameter � -T component – Specify the name of the component. If you type part of a name, without
-sons, the output will be all components that have this string in their names. The value
you specify is case-insensitive.

� -dlt delimiter – Specify the delimiter for the output.

� -D distribution – Specify the distribution to use. If not specified, the command operates
on all distributions.

Flag -sons – List the contained components of the component you specified with -T.

This flag operates only if the component listed with -T is the complete name of a category or
package group holding packages.

If the -T value is not unique in the Components list, include the tree path; otherwise only the
first component’s sons are output.

Syntax uce_cli -fc -T "component" [ -sons ] [ -dlt "delimiter" ] [ -D distribution ] -u

username -p password
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Example uce_cli -fc -T "ROOT" -sons -dlt ", " -D RH9_IA32 -u admin -p 123

Result Example

finding
categories

ROOT/, ROOT/ARCHITECTURES, ROOT/DISTRIBUTION, ROOT/FILESYSTEM, ROOT/HANDLER,

ROOT/Hardware, ROOT/Local, ROOT/SPECIAL, ROOT/Software, ROOT/extensions

Example uce_cli -fc -T "httpd" -sons -u admin -p 123

Result
Example:

finding
packages

ROOT/Software/System Environment/Daemons/httpd/httpd-2.0.40-21

ROOT/Software/System Environment/Daemons/httpd/httpd-2.0.40-21.1

ROOT/Software/System Environment/Daemons/httpd/httpd-2.0.40-21.3

ROOT/Software/System Environment/Daemons/httpd/httpd-2.0.40-21.5

ROOT/Software/System Environment/Daemons/httpd/httpd-2.0.40-21.9

Example uce_cli -fc -T "local" -u admin -p 123

Result
Example:

partial string

ROOT/Local

ROOT/Local/Local RPMs

ROOT/SPECIAL/active_rpmdb/Local RPM DataBase version 4.0

ROOT/Software/System/Libraries/glibc-locale

ROOT/Software/System/Libraries/glibc-locale/glibc-locale-2.3.3-118 [i586]

ListAll Hosts (-lah) Command
The list-all-hosts command outputs a complete list of all managed hosts in the system. Use this
command to get values for the -h parameter of other parameters.

Parameter -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -lah [ -dlt "delimiter" ] -u username -p password

Example uce_cli -lah -u admin -p 123

List Host Properties (-lh) Command
The list-host command outputs the properties (such as IP address, distribution, and so on) of a given
host.

Parameter -h hostname – Specify the host name.

Syntax uce_cli -lh -h hostname -u username -p password

Example uce_cli -lh -h webserver2 -u admin -p 123
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Result Example Host Data:

Host ID = 1

Host Name = webserver2

Unique String = lnx013

Host IP = 127.0.0.2

Host Type is: standard Host (maybe Master)

Host is Connected

Distribution ID is 9

Master Group ID = 0

Master Host ID =0

listen on port 8001

To get valid values for the -h parameter, use the -lah command.

Note that even if a managed host is not connected to SunUpdate Connection – Enterprise at the time
of the command, the data is still retrieved.An error number will be given (example: FailedErrCode
= 34014464) if the host is not online.

List Host Inventory (-lhi) Command
The list-host-inventory command outputs the list of software installed on a given host.

Parameter � -h hostname – Specify the host name.
� -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -lhi -h hostname [ -dlt "delimiter" ] -u username -p password

Example uce_cli -lhi -h lnx013 -dlt " " -u admin -p 123

Result Example up2date-gnome-2.1.7-1 wu-ftpd-2.6.1-6 shapecfg-2....

To get valid values for -h, use the -lah command.

List Groups (-lg) Command
The list-group command lists all the groups. Use this command to get values for the -g parameter
used in other CLI commands.

Parameter -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -lg [ -dlt "delimiter" ] -u username -p password

Example uce_cli -lg -u admin -p 123
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Result Example RH9_IA32 hosts

SLES8_S390 hosts

All Hosts

topGroup

topGroup/nestedGroup

Notice that nested groups are listed in a path. For any command that calls for the -g parameter to list
a group, if you want a nested group, type its complete group path.

Groups that are named distribution_architecture hosts are default distribution groups.When an
agent registers with the SDS, its distribution is recognized and the host is added to the appropriate
distribution group. Each distribution group contains all themanaged hosts of that distribution. The
distribution groups’ host lists are system-defined and cannot bemanually changed.

TheAll Hosts group is also a default group. It contains the complete list of managed hosts in your
environment.

List Group’sHosts (-lgh) Command
The list-group-hosts command outputs the hosts that are assigned to a given group.

Parameter � -g groupname – Specify the name of the group.
� -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -lgh -g "groupname" [ -dlt "delimiter" ] -u username -p password

Example uce_cli -lgh -g "topGroup/nestedGroup" -u admin -p 123

Result Example webserver2

(Note that quotations are required for group paths and for group names that contain spaces.)

Example uce_cli -lgh -g "nestedGroup" -u admin -p 123

Result Example Error: Requested group not found.

(Error indicates that parent-group path is required for nested groups.)

To get valid values for the -g parameter, use the -lg command.

List Profiles (-lp) Command
The list-profiles command outputs a list of all existing profiles.

Use this command to get values for the -P parameter of other CLI commands.
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Parameter -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -lp [ -dlt "delimiter" ] -u username -p password

Example uce_cli -lp -u admin -p 123

Result Example Check System

Perform Restart

Check Security

Upgrade All Components

Check Bugs Fix

Perform Restart + Reconfigure

Local Software Review

Check Withdrawn Patches

Note that the profiles listed in the result example are the default, predefined profiles. Even if you have
not yet created profiles, this commandwill have output.

List Policies (-lc) Command
The list-policies command outputs a list of all existing policies, predefined answers for a dependency
resolver (DR). Use this command to get values for the -C parameter of other CLI commands.

Parameter -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -lc [ -dlt "delimiter" ] -u username -p password

Example uce_cli -lc -dlt ", " -u admin -p 123

Result Example autoSWchanges, lockKernelNode, Always ask me

TheAlwaysAskMe policy is the default policy. Even if you have not yet created policies, this
commandwill have output.

List ProfileAttributes (-lpa) Command
The list-profile-attribute command outputs the attributes, the component-requirement
combinations that make up a profile.

Parameter � -P profile – Specify the name of an existing profile.
� -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -lpa -P "profile" [ -dlt "delimiter" ] -u username -p password
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Example uce_cli -lpa -P "create WebServer" -u admin -p 123

Result Example Profile name = createWebServer

from node = httpd-devel (RH9_IA32)

Install

from node = httpd (RH9_IA32)

Install

from node = httpd-manual (RH9_IA32)

Install

from node = vsftpd (RH9_IA32)

Uninstall

from node = tftp (RH9_IA32)

Uninstall

from node = ftp (RH9_IA32)

Install

To get valid values for -P, use the -lp command.

If a predefined profile is used for the -P parameter, the output will be just the name of the profile.

Notice that the action is listed under the component (node).Although the action is listed as install or
uninstall or upgrade or downgrade, a profile checks compliance. If the component is already
installed and the action is “Install,” nothing is done and the profile succeeds.

List PolicyAttributes (-lca) Command
The list-policy-attribute command outputs the attributes, the component-action-answer
combinations, that make up a confirmation policy.

Parameter � -C policy – Specify the name of the existing confirmation policy.
� -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -lca -C "policy" [ -dlt "delimiter" ] -u username -p password

Example uce_cli -lca -C SWAutoYes -u admin -p 123

Result Example Policy name - SWAutoYes

from node = Software (RH9_IA32) Install Yes

from node = Software (RH9_IA32) Upgrade Yes

from node = Software (RH9_IA32) Apply Fix Yes

To get valid values for -C, use the -lc command.
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List Logs (-ll) Command
The list-logs command outputs logs for actions on selected components of a host or of a group. You
might ask to see, for example, uninstallation actions on Local RPMs for theWebServers group,
installations of Networking components on one host, or any install or uninstall of Software onAll
Hosts.

Parameter � -A action – Specify the action. Legal values are All Actions, Installs, and Uninstalls.

� -dlt delimiter – Specify the delimiter for the output.

� -g groupname – Specify the name of the group.

� -h hostname – Specify the name of the host.

Syntax uce_cli -ll -A action [ -dlt "delimiter" ] ( -g group | -h host ) -u username -p

password

Example uce_cli -ll -A Installs -h lnx13 -u admin -p 123

Result Example Tue May 4 16:32:17 2004 lnx13 Install httpd-devel-2.0.3-1 (RH9_IA32)

Job_buildWebServer rochelle

Explanation: time, host name, action, component, distribution, job name, and user name.

Use the -lg to get values for the -g. Use the -lah to get values for the -h. Use the -ld to get values for
the -D. Use the -fc to get values for the -T.

List Jobs Status (-ljs) Command
The list-job-status command outputs a list of jobs that you created with the current user name,
according to the status criteria that you choose.

Parameter -dlt delimiter – Specify the delimiter for the output.

Flag � -all – List all jobs.
� -ok – List jobs that completed successfully.
� -fl – List jobs that failed.
� -pr – List jobs that are in process.
� -wc – List jobs that are waiting for user confirmation.

Syntax uce_cli -ljs [ -dlt "delimiter" ] ( -all | -ok | -fl | -pr | -wc ) -u username -p

password

Example uce_cli -ljs -ok -u admin -p 123
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Result Example makeWebServer

Deploy

Tue May 6 9:30:09 2004

All hosts finished successfully

anotherJob

Verify

Tue May 6 11:32:15 2004

All hosts finished successfully

Explanation: job name, mode, start time, status; for two jobs: “makeWebServer” and
“anotherJob.”

List Job StatusAttributes (-ljsa) Command
The list-job-status-attributes command outputs status information (current status, profile data, and
so on) of one job that you created with the current user name.

Parameter � -j jobname – Specify the name of the job.
� -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -ljsa -j "jobname" [ -dlt "delimiter" ] -u username -p password

Example uce_cli -ljsa -j ProvServer -u admin -p 123

Result Example makeWebServer

Deploy

Tue May 6 9:30:09 2004

All hosts finished successfully

Explanation: job name, jobmode, start time, and status.

To get valid values for the -j parameter, use the -ljs command.

If a host did not end successfully, more host and profile information is output.

List SavedSnapshots (-lss) Command
The list-saved-snapshots command outputs a list of saved snapshots.When you save an inventory of
a host or of a group, you create a snapshot. A snapshot is also saved, for each selected host, before a
job is deployed.

Parameter � -h hostname – Specify the name of the host.
� -g groupname – Specify the name of the group.
� -dlt delimiter – Specify the delimiter for the output.

Syntax uce_cli -lss ( -g group | -h host ) [ -dlt "delimiter" ] -u username -p password
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Example uce_cli -lss -g WebServers -u admin -p 123

uce_cli -lss -h lnxsrvr13 -u admin -p 123

Youmust specify either -h or -g.

To get valid values for the -h parameter, use the -lah command. To get valid values for the -g
parameter, use the -lg command.

Host andGroupCommands
The following commands allow you to view andmanage hosts and groups of hosts.

This section includes the following:

� “AddHost (-ah) Command” on page 265
� “Delete Host (-dh) Command” on page 265
� “RenameHost (-rh) Command” on page 266
� “AddGroup (-ag) Command” on page 266
� “AddHost to Group (-ahg) Command” on page 266
� “Delete Group (-dg) Command” on page 267
� “RenameGroup (-rg) Command” on page 267

AddHost (-ah) Command
The add-host command adds predefined host data to the system before agent installation. The agent
on the host adds the host automatically. If there is already a host in the systemwith the given host
name, the command results in an error.

Parameter � -h hostname – Specify the name of the host.

� -D distribution – Specify the distribution to use. If not specified, the command operates
on all distributions.

Syntax uce_cli -ah -h hostname -D distribution -u username -p password

Example uce_cli -ah -h wserver03 -D RH9_IA32 -u admin -p 123

To get valid values for the -D parameter, use the -ld command. The value of -hmust not already be in
the output of the -lah command.

DeleteHost (-dh) Command
The delete-host command removes a host from themanagement of the system. This command is
effective only if the agent has been stopped or uninstalled.
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Parameter -h hostname – Specify the name of the host.

Syntax uce_cli -dh -h hostname -u username -p password

Example uce_cli -dh -h wserver03 -u admin -p 123

To get valid values for the -h parameter, use the -lah command.

RenameHost (-rh) Command
The rename-host command renames a host, from an existing name to a new name. The name of the
host is not the DNS name (Unique String) of themachine, but the SunUpdate Connection –
Enterprise name of the host. You can change this name at any time without affecting themachine or
its configurations.

Parameter � -sH hostname – Specify the source host name of an existing host.
� -tH hostname – Specify the name of a target host.

Syntax uce_cli -rh -sH hostname -tH hostname -u username -p password

Example uce_cli -rg -sH lnx013 -tH mailserver_2 -u admin -p 123

To get valid values for the -sH parameter, use the -lah command.

Avalid value for the -tH parameter is a new, unique host name. This namemust not appear in the
output of the -lah command.

AddGroup (-ag) Command
The add-group command creates a new group of hosts.

Parameter � -g groupname – Specify the name of a group.

� -pG groupname –Optionally specify the name of an existing parent group under which
to create the group.

Syntax uce_cli -ag -g "groupname" [ -pG "groupname" ] -u username -p password

Example uce_cli -ag -g ApacheServers -pG WebServers -u admin -p 123

To get valid values for the -pG parameter, use the -lg command.

AddHost toGroup (-ahg) Command
The add-host-group command assigns amanaged host to a group.
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Parameter � -h hostname – Specify the name of a host.
� -g groupname – Specify the name of a group.

Syntax uce_cli -ahg -h hostname -g "groupname" -u username -p password

Example uce_cli -ahg -h wsrvr03 -g WebServers -u admin -p 123

To get valid values for the -h parameter, use the -lah command.

Valid values and results for the -g parameter:

� If the group exists (use the -lg command), the host is added to it.
� If the group does not exist, it is created and the host is assigned to it.
� If the group exists, but has a parent not given in the CLI command, a new top-level group is

created by the same name. You can have same-named groups of different hierarchies.
� If the named group is written as a nested group (“parent/nested”), and this group-path does not

exist, all the groups are created.

DeleteGroup (-dg) Command
The delete-group command deletes a group and its sub-groups from the system. It does not
unregister themanaged hosts. It cannot be used on default groups.

Parameter -g groupname – Specify the name of the group.

Syntax uce_cli -dg -g "groupname" -u username -p password

Example uce_cli -dg -g WebServers -u admin -p 123

To get valid values for the -g parameter, use the -lg command.

RenameGroup (-rg) Command
The rename-group command renames a group, from an existing name to a new name.

Parameter � -sG groupname – Specify the source group name of an existing group.

� -tG groupname – Specify the name of a target group. This namemust be a new group.

Syntax uce_cli -rg -sG "groupname" -tG "groupname" -u username -p password

Example uce_cli -rg -sG WebServers -tG webserver -u admin -p 123

To get valid values for the -sG parameter, use the -lg command.

Avalid value for the -tG parameter is a new, unique group name. It must not appear in the output of
the -lg command.
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Local Component Commands
The following commands are used tomanage local software and files.

This section includes the following:

� “Add Local Category (-alc) Command” on page 268
� “Add Software Package (-asp) Command” on page 268
� “Add File Declaration (-afd) Command” on page 269
� “Add Target Local (-atl) Command” on page 270

AddLocal Category (-alc) Command
The add-local-category command creates a new category under Local, under Probes, Pre-actions,
Post-actions,Macros, or Configuration Files.

Use this command if you want to upload scripts and files to the local knowledge base. You cannot
upload a local file or script until you have created a category to hold it.

Parameter � -T component – Specify the name of the component. If you type part of a name, without
-sons, the output will be all components that have this string in their names. The value
you specify is case-insensitive.

� -ds description – Specify an optional description of the new category.

� -pT category – Specify the parent category name in which to create the new category.
Valid values are: Probes, Pre-actions, Post-actions, Macros, Configuration files,
or one of these, with /existing-subcategory.

� -D distribution – Specify the distribution to use. If not specified, the command operates
on all distributions.

Syntax uce_cli -alc -T "category" [ -ds "description" ] -pT "parent-category" [ -D

distribution ] -u username -p password

Example uce_cli -alc -T "PrintcapVersions" -ds "various config files to set up

different printers" -pT "Configuration files" -u admin -p 123

To get a list of the valid values for the -pT parameter, use the -fc command, with "Local" as the
value of its -T parameter.

One or both of "ROOT/Local/Local RPMs" or "ROOT/Local/Local PKGs" is listed, but are not valid
values for the -alc command; all the other items in this output are acceptable.

AddSoftwarePackage (-asp) Command
The add-software-package command pushes a local software package to the local knowledge base.
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Parameter � -f pathname – Specify the full path name of the source RPMfile.

� -T category – Specify the name of the category in which to add this RPM.

� -D distribution – Specify the distribution to use. If not specified, the command operates
on all distributions.

Flag -secure – Security fixmark. If present, the local package is a security fix for a previous
version.

Syntax uce_cli -asp -f "pathname" [ -secure ] -D distribution [ -T category ] -u

username -p password

Example uce_cli -asp -f "/usr/share/myApps/myApp01.05-73.rpm" -D RH9_IA32 -u admin -p

123

To learnmore about the security fixmark and when to use the -secure flag, see “To Fix Local
SoftwareMissing Dependencies” on page 100 and “Fixing Local Dependencies” on page 100.

To get valid values for the -D parameter, use the -ld command.

AddFileDeclaration (-afd) Command
The add-file-declaration command adds a file declaration to the local knowledge base.Afile
declaration is the target path name for installation of a local Configuration file ontomanaged hosts.

Parameter � -pT category – Specify the parent category name in which to create the new category.
This value must be a user-defined category under Configuration files.

� -ds description – Specify an optional description of the new file.

� -tfp pathname – Specify the target path name for installation on remote hosts.

� -D distribution – Specify the distribution to which the file applies. If not specified, the
command operates on all distributions.

Syntax uce_cli -afd -pT "category" [ -ds "description" ] -tfp "pathname" [ -D distribution
] -u username -p password

Example uce_cli -afd -pT "Configuration files/PrintcapVersions" -ds "install

directory for printcap versions" -tfp "/etc/printcap" -u admin -p 123

Before you can create a file declaration, you have to have a category under Configuration files. Use
the -alc command to create a category. To see a list of categories, use the -fc commandwith -T
"Local/Configuration files" -sons.

The output of this commandwould give valid values for the -pT parameter of the -afd command.
You can shorten the path of the category component to Configuration files/category. You do not
need to type the full path from the root.
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AddTarget Local (-atl) Command
The add-target-local command adds a file or a script to the local knowledge base.

Parameter � -pT category – Specify the parent category name in which to create the new category.
Valid values are: Probes, Pre-actions, Post-actions, Macros, Configuration files
with a user-defined subcategory.

� -f pathname – Specify the full path name of the file to upload.

� -ds description – Specify an optional description.

� -D distribution – Specify the distribution for which this category is relevant. If not
specified, the command operates on all distributions.

� -tF – If -f is a configuration file, creates a file declaration.

� -tM – If -f is a macro, use -tMwith a display name for themacro.

� -tP – If -f is a pre-action, use -tPwith a display name for the pre-action.

� -tR – If -f is a probe, use -tRwith a display name for the probe.

� -tS – If -f is a post-action, use -tSwith a display name for the post-action.

� -v version – Specify the version of the file. This is mandatory for configuration files only
to supply a version suffix display name.

Syntax uce_cli -atl -f "pathname" -pT category [ -ds "description>" ] ( -tF | -tM | -tP

| -tR | -tS name ) [ -v version ] [ -D distribution ] -u username -p password

Example:
Config file

uce_cli -atl -f "/home/admin/myFiles/print_v5" -pT "Configuration

files/PrntVer" -ds "printcap Flr5" -tF "/etc/printcap" -v "05" -u admin -p 123

Example:
Macro

uce_cli -atl -f "/home/admin/scripts/findhost.sh" -pT "hostname" -ds "finds

local hostname for file localization" -tM "hostname" -u admin -p 123

Notes Before performing this procedure, youmust have created the category PrntVer under
Configuration files and the category hostname under Macros (see “Add Local Category
(-alc) Command” on page 268). Youmust also have created a script to upload as amacro.
The example shows a script that finds the host name of the local host.

To find a valid value for -pT, use -fc with -T "Local/default category>/" -sons.

To find a valid value for -D, use the -ld command. If you do not name a specific distribution, the
named parent category (value of -pT) must also be in all distributions.

The -t* parameter that you choose to usemust match the -pT parameter. For example, if -pT is
Macros/localhostname then use -tM to name themacro.

The -tM, -tP, -tR, and -tS parameters take any new name as a value.

The -tF parameter needs a file declaration as its value. If you use a new path name for this value, it
creates a new file declaration. If you use -tF, youmust use -v to give the Configuration file a display
version.
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Policy Commands
The following commands are for profiles and confirmation policies.

This section includes the following:

� “Add ProfileAttribute (-apa) Command” on page 271
� “Add PolicyAttribute (-aca) Command” on page 271
� “Copy Profile (-cp) Command” on page 272
� “Copy Policy (-cc) Command” on page 273
� “Export (-exp) Command” on page 273
� “Import (-imp) Command” on page 274

AddProfileAttribute (-apa) Command
The add-profile-attribute command edits an existing profile by adding a new component-setting to
the profile. It may also be used to create a new profile.

Parameter � -P profile – Specify the name of a new or existing profile.

� -T component – Specify the name of the component to be included in this profile.

� -D distribution – Specify the distribution for which this profile is relevant. If not
specified, the command operates on all distributions.

Flag � -N –Marks the component as NotAllowed.
� -R –Marks the component as Required.
� -U –Marks the component for upgrade if a newer version is available.

Syntax uce_cli -apa -P "profile" -T "component" ( -N | -R | -U ) [ -D distribution ] -u

username -p password

Example uce_cli -apa -P myWebSvr -T "httpd" -R -u admin -p 123

uce_cli -apa -P myWebSvr -T "httpd" -U -u admin -p 123

Result Example The myWebSvr profile now has twomore settings than it originally had: now httpd
components are Required andmust be Updated. If the profile did not exist before, it is
created.

To get a valid value for a name of an existing profile for the -P parameter, use the -lp command. To
get a valid value for the -T parameter, use the -fc command. To get a valid value for the -D parameter,
use the -ld command.

AddPolicyAttribute (-aca) Command
The add-policy-attribute command edits an existing policy, by adding a new
component-action-answer to the policy. This command can also be used to create a new policy.
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Parameter � -C policy – Specify the name of a new or existing policy.

� -T component – Specify the name of the component for which the policy answers
questions.

� -D distribution – Specify the distribution for which this policy is relevant. If not
specified, the command operates on all distributions.

� -install answer – Specify the policy value for installing a component. Valid values are
yes, no, and ask_me.

� -downgrade answer – Specify the policy value for downgrading a component. Valid
values are yes, no, and ask_me.

� -fix answer – Specify the policy value for fixing a component. Valid values are yes, no,
and ask_me.

� -remove answer – Specify the policy value for removing a component. Valid values are
yes, no, and ask_me.

� -upgrade answer – Specify the policy value for upgrading a component. Valid values are
yes, no, and ask_me.

� -ignore answer – Specify the policy value for ignoring file conflicts. Valid values are yes,
no, and ask_me.

Syntax uce_cli -aca -C "policy" -T "component" ( -install | -downgrade | -fix |

-remove | -upgrade | -ignore ) ( yes | no | ask_me ) [ -D distribution ] -u

username -p password

Example uce_cli -aca -C newPolicy -T "User Interface" -remove no -u admin -p 123

One action parameter, and only one, is mandatory, with a value of either yes, no, or ask_me.

To get a valid value for an existing policy name for the -C parameter, use the -lc command; or use a
new one to create a new policy. To get a valid value for the -T parameter, use the -fc command. To get
a valid value for the -D parameter, use the -ld command.

CopyProfile (-cp) Command
The copy-profile command copies an existing profile to a new one. You can then use -apa command
to further customize the copied profile.

Parameter � -sP source-profile – Specify the name of an existing source profile.

� -tP target-profile – Specify the name of the target profile that receives settings of the
source profile.

Syntax uce_cli -cp -sP source-profile -tP target-profile -u username -p password

Example uce_cli -cp -sP webServer -tP webServerHTTP -u admin -p 123
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To get a valid value for the -sP parameter, use the -lp command.

CopyPolicy (-cc) Command
The copy-policy command copies an existing policy to a new one. You can then use the -aca
command to further customize the copied policy.

Parameter � -sC source-policy – Specify the name of an existing source policy.

� -tC target-policy – Specify the name of the target policy that receives settings of the
source policy.

Syntax uce_cli -cc -sC source-policy -tC target-policy -u username -p password

Example uce_cli -cc -sC SWAutoYes -tC SWYesKernelNo -u admin -p 123

To get valid values for the -sC parameter, use the -lc command.

Export (-exp) Command
The export command allows you to export Profiles or Inventories to XMLfiles.An SunUpdate
Connection – Enterprise object in XML format is easy to read and edit, and can bemanipulated as a
file.

Parameter � -ent entity-type – Specify the type of the entity. Valid values are Profile or Inventory.

� -f pathname – Specify the full path name of the XMLfile to which to export.

� -T list – Specify a comma-separated list of profiles to export or a list of hosts whose
inventories are to be exported. If not specified, all objects of type -ent are exported.

Syntax uce_cli -exp -ent ( "Profile" | "Inventory" ) -f pathname.xml [ -T

"profile,profile,..." | "hostname,hostname,..." ] -u username -p password

Example uce_cli -exp -ent "Profile" -f /home/stuff/httpSverProfile.xml -u admin -p

123

Example uce_cli -exp -ent "Inventory" -f /home/stuff/myHost.xml -u admin -p 123

Example uce_cli -exp -ent "Inventory" -T "lnx13,lnx10" -f /home/stuff/rpmsOf13-10.xml

-u admin -p 123

To get valid values for -T, use the -lp command to see profiles, or the -lah to see hosts.

Be aware that as this command creates a file outside of SunUpdate Connection – Enterprise, the
success of the command is dependent upon your user permissions: themachine user executing the
command has to have permissions to write to the path give in the -f parameter.
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Import (-imp) Command
The import command allows you to import XMLfiles into SunUpdate Connection – Enterprise and
convert them back to profiles.

Parameter -f filename – Specify the full path name to the XMLfile to import.

Syntax uce_cli -imp -f path/filename.xml -u username -p password

Example uce_cli -imp -f /home/stuff/httpSverProfile.xml -u admin -p 123

JobCommands
The following commands create andmanage jobs and job tracking.

This section includes:

� “Submit Job (-sj) Command” on page 274
� “Delete Job (-dj) Command” on page 275

Submit Job (-sj) Command
The submit-job command creates a job from a profile, a confirmation policy, and a selected host or
group, and submits it to the dependencymanager.

Parameter � -j jobname – Specify the name of the new job. If you do not supply this value, the job is
given a name based on the date and time it was sent.

� -P profile – Specify the name of an existing profile.

� -C policy – Specify the name of an existing policy.

� -h hostname – Specify a single host name onwhich to run the job. This parameter
cannot be used with the -g parameter.

� -g groupname – Specify a group name onwhich to run the job. This parameter cannot be
used with the -h parameter.

Flag � -us –Use only secure components to fulfill dependency requirements.

� -dp –Run the job in deploymode. Youmust specify this flag if you want the job to
actually make changes to the target host.

� -sm –Run the job in simulationmode. Jobs are run in simulationmode by default.

Syntax uce_cli -sj [ -j "jobname" ] -P "profile" -C "policy" ( -g "groupname" | -h

hostname ) [ -us ] ( -dp | -sm ) -u username -p password
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Example uce_cli -sj -j MakeWebServer -P webserverApps -C autoSW -h lnx13 -us -dp -u

admin -p 123

uce_cli -sj -j 31_12_2003 -P UpgradeApache -C "Always ask me" -g webservers

-sm -u admin -p 123

Either -h or -gmust be given. If you do not give either -dp or -sm, the default mode for the job is
simulate (not deploy).

To get a valid value for the -j parameter, use the -ljs command. To get a valid value for the -P
parameter, use the -lp command. To get a valid value for the -C parameter, use the -lc command. To
get a valid value for the -h parameter, use the -lah command. To get a valid value for the -g
parameter, use the -lg command.

Delete Job (-dj) Command
The delete-job command deletes a completed job from the Status list (used to keep the output of
-ljs relevant), or cancels and deletes an unfinished job.

Parameter -j jobname – Specify the name of the job.

Syntax uce_cli -dj -j "jobname" -u username -p password

Example uce_cli -dj -j "MakeWebServer" -u admin -p 123

To get valid values for the -j parameter, use the -ljs command.

Inventory Commands
The following commands allow you to access, save, and compare the inventory (list of installed
software) of a host or of a group.

This section includes the following:

� “Save Host Inventory (-shi) Command” on page 275
� “Save Group Inventory (-sgi) Command” on page 276
� “Convert Inventory to Profile (-cip) Command” on page 277
� “Convert Snapshot to Profile (-csp) Command” on page 277
� “Compare Hosts and Inventories (-chi) Command” on page 277
� “Submit Compare Job (-scj) Command” on page 278

SaveHost Inventory (-shi) Command
The save-host-inventory command saves a snapshot (a record of the host’s inventory at the current
time) of the given host.
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Parameter � -h hostname – Specify the name of the host.
� -s snapshot-name – Specify the name of the snapshot.

Syntax uce_cli -shi -h hostname -s snapshot-name -u username -p password

Example uce_cli -shi -h lnxsrvr13 -s beforeUpdate -u admin -p 123

To get valid values for -h, use the -lah command.

SaveGroup Inventory (-sgi) Command
The save-group-inventory command saves a snapshot of the inventory of each host in the given
group.

Parameter � -g groupname – Specify the name of the group.

� -sn suffix-name – Specify the name of the snapshot suffix.When you save a snapshot for
a group, a snapshot is created with the following file name format:
hostname-suffix-timestamp.

Syntax uce_cli -sgi -g "groupname" -sn suffix -u username -p password

Example uce_cli -sgi -g WebServers -sn wsrvrs -u admin -p 123

Result Example lnx01-wsrvrs-932111203

lnx12-wsrvrs-933111203

admin0-wsrvrs-9341112033

web13-wsrvrs-93111203

To get valid values for -g, use the -lg command.

Delete SavedSnapshot (-dss) Command
The delete-saved-snapshot command deletes a selected saved snapshot.

Parameter � -h hostname – Specify the name of the host.
� -s snapshot-name – Specify the name of the snapshot.

Syntax uce_cli -dss -h hostname -s snapshot -u username -p password

Example uce_cli -dss -h lnxsrvr13 -s inventory_beforeRestore -u admin -p 123

To get a valid value for the -h parameter, use the -lah command. To get a valid value for the -s
parameter, use the -lss command.
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Convert Inventory toProfile (-cip) Command
The convert-inventory-profile command saves the software inventory of a host into a profile.All
software installed on the host is marked as Required on the profile; everything else is marked as Not
Allowed.

Parameter � -h hostname – Specify the name of the host.
� -P profile – Specify the name of the profile.

Syntax uce_cli -cip -h hostname -P "profile" -u username -p password

Example uce_cli -cip -h lnxsrvr13 -P lnxsrvrProfile -u admin -p 123

To get valid values for the -h parameter, use the -lah command.

Convert Snapshot to Profile (-csp) Command
The convert-snapshot-profile command converts a saved software inventory (a snapshot) of a host
as a profile.All software listed in the snapshot is marked as Required on the profile; everything else is
marked as NotAllowed.

Parameter � -h hostname – Specify the name of the host.
� -s snapshot-name – Specify the name of the snapshot.
� -P profile – Specify the name of the profile.

Syntax uce_cli -csp -h hostname -s snapshot-name -P "profile" -u username -p password

Example uce_cli -csp -h lnxsrvr13 -s beforeUp -P oldSrv -u admin -p 123

To get a valid value for the -h parameter, use the -lah command. To get a valid value for the -s
parameter, use the -lss command.

CompareHosts and Inventories (-chi) Command
The compare-host-inventory command compares the installed software of two hosts, or the
snapshots of two hosts. Youmay also compare the inventory or snapshot of a host against the
snapshot of a group. The result of this command is the set of differences.

Parameter � -h hostname – Specify the name of the source host.
� -s snapshot-name – Specify the name of the source snapshot.
� -t hostname – Specify the name of the target host.
� -ts snapshot-name – Specify the name of the target snapshot.
� -dlt delimiter – Specify the delimiter for the output.
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Syntax uce_cli -chi -h source-hostname [ -s source-snapshot ] -t target-hostname [ -ts

target-snapshot ] [ -dlt "delimiter" ] -u username -p password

Example uce_cli -chi -h lnx13 -s lnxInvDec03 -t lnx29 -ts lnxInvDec18 -u admin -p 123

To get valid values for the -h and -t parameters, use the -lah command. To get values for the -s and
-ts parameters, use the -lss command.

Whether -s and -ts are optional ormandatory depends on the type of comparison you aremaking.
Comparisonmatrix:

Type -h -t -s -ts

Compare two hosts, current inventories Different hosts Different hosts Not used Not used

Compare two hosts, saved snapshots Different hosts Different hosts From -lss,
each is a
different
snapshot

From -lss,
each is a
different
snapshot

Compare current host to group snapshot Host in source
group

Target host From -lss Not used

Compare host at different stages of lifecycle Same host
named for
both
parameters

Same host
named for
both
parameters

From -lss,
each is a
different
snapshot

From -lss,
each is a
different
snapshot

Submit Compare Job (-scj) Command
The submit-compare-job command compares the installed software of two hosts, or the snapshots of
two hosts, and then changes the inventory of the target host to duplicate the inventory of the source
host. The result of this command is application provisioning to the target host.

If the hosts are Solaris machines, you can compare either Software or Patches in one compare job.

Parameter � -h hostname – Specify the name of the source host.
� -s snapshot-name – Specify the name of the source snapshot.
� -t hostname – Specify the name of the target host.
� -j jobname – Specify the name of the job.
� -C policy – Specify the name of the policy.

Flag � -sm –Run the job in simulationmode. This is the default mode.

� -dp –Run the job in deploymode. If you want the job to actually make changes on the
target host, youmust use this flag.
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Syntax uce_cli -scj -h source-hostname [ -s source-snapshot ] -t target-hostname -j

"jobname" -C "policy" [ -sm | -dp ] -u username -p password

Example uce_cli -scj -h lnxsrvr13 -t lnxsrvr29 -j Make29Like13 -C autoSW -dp -u admin

-p 123

To get a valid value for -h and -t, use the -lah command. To get a valid value for -s, use the -lss
command. To get a valid value for -j, use the -ljs command. To get a valid value for -C, use the -lc
command.

HelpCommands
The following commands access helpful information.

Help (-h) Command
The help command outputs usage information. Notice that this command does not operate with a
user name and password.

Syntax � uce_cli -h

This line outputs the complete command list with descriptions.

� uce_cli

Without a specific command to work on, the CLI provides the command list and
descriptions to help you enter the command you want in the correct format.
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SunUpdate Connection – Enterprise Scenarios

This chapter provides procedures for specific concepts. The steps can get into advanced features.
Follow the cross-references to previous chapters formore details.

This chapter covers the following topics:

� “Clusters” on page 281
� “Floating Servers and Loads” on page 284
� “Cloning Servers” on page 286
� “Sharing Directories” on page 288
� “DB2” on page 290
� “WebSphere” on page 293

Clusters
Acluster is a group ofmachines or other resources that act as one powerful system. Clustering
provides high availability, continuous operations for a long time. There aremany varieties of clusters.

This scenario uses openMosix, a Linux kernel extension for clustering. The openMosix cluster is a
single-image cluster: multiple copies of a single operating system kernel.

openMosix joins Linuxmachines to function as one largemultiple-processor computer. If you have a
12-node cluster, it is as though you had one computer with the CPU power of 12 computers. One
process will not be 12-times faster, but you can run 12 processes simultaneously.

The openMosix package is not available from any one distribution. You can download it from the
project site.

Notice that after the profile is set up, cluster creation is automated. You could create an opposite
profile that would undo the actions of this scenario, thereby unclustering themachines. You could set
both profiles to run on a schedule, which would cluster and uncluster your resources according to
your needs.
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Creating anopenMosix Clusterwith SunUpdate
Connection – Enterprise
This procedure to create a cluster with nodes takes about two hours to complete. It might take less
time if there are no unexpected problems or a little more time for different environments.
Maintenance tasks on the cluster (for example, adding or changing a node) take about five to ten
minutes.

� ToCreate anopenMosix Clusterwith SunUpdate Connection –
Enterprise

Choose themachines thatwill be nodes of the cluster.

Eachmachine should have a Linux distribution that is supported by SunUpdate Connection –
Enterprise and the kernel version supported by openMosix.

Install SunUpdate Connection – Enterprise (systemdependency server [SDS], dependencymanager
[DM], the knowledgebase, the console, and the agent) on one of themachines.

See the SunUpdate Connection - Enterprise 1.0 Administration Guide.

Install the agent on the othermachines.

Add the openMosix RPM to the local knowledgebase.

The Local Expansion technology creates deployment rules.

See “Adding Undetected Linux Software” on page 85.

In a text editor, create /etc/mosix.map.

This filemaps a node number to each IP address.

Add afile declaration called /etc/mosix.map

See “Creating File Declarations” on page 111.

Add the /etc/mosix.map file to the local knowledgebase.

See “Uploading Local Configuration Files” on page 113.

In a text editor, create a version of /etc/hostswhich includes the hosts to be in the cluster.

Add a /etc/hostsfile declaration and add the version you justmade to the local knowledgebase.

See “Creating File Declarations” on page 111 and “Uploading Local Configuration Files” on page 113.

Write a script that changes the default boot kernel to openMosix in the grub table:
OpenMosixAsDefault.sh
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See “WritingActions” on page 104.

Add this script to Local/Pre-actions.

See “UploadingActions” on page 104.

Add this script to Local/Post-actions.

See “UploadingActions” on page 104.

Create a profile called openMosixNode that defines the following requirements of a node in the
cluster:

� Required: openMosix kernel andmanagement tools
� Required: /etc/mosix.map (specifying local version)
� Required: /etc/hosts (specifying local version)
� Required: Pre-action OpenMosixAsDefault.sh

See “To Create a Profile” on page 173.

Create a group called Test, which includes twoof themachines, and thenCreate a group called
openMosixCluster, which includes all themachines that are to be nodes in the cluster.

See “To Create a Group” on page 62.

Create a job that runs in simulatemodeon the Test group,with the followingprofile tasks:

� openMosixNode profile
� PerformRestart

Check the estimates and status of the job before continuing. See “Creating Complex Jobs”
on page 194.

Rerun the job in deploymodeon the Test group. Check the results and status of the hosts before
continuing.

See “To Rerun a Job” on page 220.

Run the job again in deploymodeon the openMosixCluster group.

All selectedmachines are now nodes of a cluster. See “Creating Complex Jobs” on page 194.

� ToAddaNode to theCluster

Install the agent on the newmachine.

See the SunUpdate Connection - Enterprise 1.0 Administration Guide.

Add thismanagedhost to the openMosixCluster group.

See “To Edit a Group” on page 65.
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Open the mosix.map knowledgebase file and add anewnodenumber and the IP of the new
machine.

Open the /etc/hosts knowledge base files and add the new host name.

See “OpeningHost Files” on page 124.

Run the jobwith the openMosixNodeprofile in deploymodeon the openMosixCluster group.

Legacy data and applications are not touched by the job, but the newmap and hosts files are
downloaded to each node. See “Creating Complex Jobs” on page 194.

Floating Servers and Loads
Integrating SunUpdate Connection – Enterprise with local environment resourcemonitoring tools
provides Floating Servers and Loads, an implementation of the On-Demand Computingmodel. In
general, the concept of On-Demand Computing enables enterprises tomeet fluctuating resource
demands efficiently, without adding hardware investments or keepingmostly-idle machines.
Resources aremade available as needed.

Aservicing pool is a group ofmachines dedicated to a specific type of service: web servers, print
servers, mail servers, and so on.

Creating Floating Server Environment
In this procedure, you will use SunUpdate Connection – Enterprise to install the needed server
profile on the floating server when the load threshold has reached overload, and to uninstall the
profile when the load threshold has reached idle.

� ToCreate a Floating Server

Using SunUpdate Connection – Enterprise, create the profiles of your servers.

Define what is required and what is not allowed to be on each type of server. For this scenario, define
a WebServerProfile profile and a TelnetServerProfile profile.

See “To Create a Profile” on page 173.

Create a profile that uninstalls the software of the other twoprofiles.

No damage is caused by setting Uninstall to components that are not there. So, make an uninstall
profile called IdleServerProfile.

If there are various distributions used in the server pools and in the floating servers, align the profiles
for all relevant distributions.

See “ToAlign Component Settings forMultiple Distributions” on page 210.
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Create a policy that automates all actions (Yes to all actions on all Software) and call it YesToAll.

See “To Create a Policy” on page 183.

Create groups for each pool of servers, and a group called Idle.

For this scenario, call the server groups WebServers and TelnetServers.

See “To Create a Group” on page 62.

In the Idlegroup, assign a spare server that is your floating server andname it floating.

See “ToAssign aHost to Groups” on page 70 and “To Edit aManagedHost” on page 71.

Write a script that takes the output of your local resourcemonitoring toolwhen the load threshold
has beenpassed (either on overload or on idle) and runs a script similar to floatingServers.sh.

floatingServers.sh Script
This script is called by a local script that finds the group with an overload or an idle threshold pass. Its
arguments are the group with the needed resources (source) and the group that needs the resource
(target).

� If there is an overload on WebServers of TelnetServers, the source is Idle.
� If the server groups are idle, the source is the one containing the floating server.

Write your local script to call floatingServers.sh.

./floatingServers.sh source target

For example, the floatingServers script takes those arguments in the findProfile function,
which tells which profile to use in the deployServer function. The profile either installs a web
server, a telnet server, or uninstalls server software (to return floating server to idle).

# ./floatingServers.sh Idle WebServers

#! /bin/bash

host=floating

policy=YesToAll

function login {

echo -n “Type your user name:”

read user

echo -n “Type your password:”

read password

}

function deployServer {

uce_cli -sj -P “$profile” -C “$policy” -h “$host” -dp -u “$user” -p
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“$password”

}

function findProfile {

sourceG=$1

targetG=$2

if [ $sourceG = “Idle” -a $targetG = “WebServers” ]; then

profile=”WebServerProfile”

elif [ $sourceG = “Idle” -a $targetG = “TelnetServers” ]; then

profile=”TelnetServerProfile”

elif [ $sourceG = “WebServers” -o $sourceG = “TelnetServers” ]; then

profile=”IdleServerProfile”

else

echo “Source is not in automated script.”

echo “From the following list of known profiles, select one to deploy on floating server”

uce_cli -lp -u “$user” -p “$password”

echo -n “Profile to deploy:”

read profile

fi

}

login

findProfile $1 $2

echo “Deploying $profile on $host to make it part of $2”

deployServer

Note – If the servers in a pool are of one distribution, and the floating server is of another, you can use
the BMI Server to recycle the floating server with a new Linux distribution while provisioning it with
a profile. Consult with your Sun distributor for details.

Cloning Servers
Because SunUpdate Connection – Enterprise focuses on the component level, SunUpdate
Connection – Enterprise cloning enables you tomaintain legacy data and applications.A
management tool that focuses on the image level would simply overwrite the existing image with the
source image. The SunUpdate Connection – Enterprise feature provides amore discerning
functionality.

Through the console, you can clone a single managed host to another host in a simple procedure.
The scenario included here includes steps for changing Settings (see Chapter 16) that will ensure
success of the cloning.

An additional scenario explains how to clonemultiple hosts using the SunUpdate Connection –
Enterprise CLI.
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BeforeYouBegin
Run the Check System profile on the host that you are using as the optimal host. This ensures that the
comparison does not include conflicts or dependencies.

See “Running Predefined Profiles” on page 140.

Run the CheckWithdrawn Patches profile on Solaris machines.

� ToClone a Single Server
This procedure uses the Inventory Comparison feature.

Make sure that the sourcemanagedhost is online and as optimal as you think.

Run the predefined system profiles on this host.

See “Running Predefined Profiles” on page 140.

Make sure the targetmanagedhost is online.

From the Toolsmenu, choose Preferences.

The Preferences window opens. See “Accessing and Editing Preferences” on page 297.

In the Console preferences, Jobs category, increase the value ofMax items in a job from20 to 500.

Submit and confirm the change.

See “Console Preferences” on page 298.

From theHostsmenu, choose Compare Inventories.

The Inventory Comparison window opens. See “Comparing Inventories” on page 155.

Select the Target host and the Source host.

Select the current inventory for both hosts.

In the Filter field, select the full inventory (Software and Local) or use the Filter Select button to select
pieces of the inventory to overwrite.

Click the Compare button and select the Tasks toMake Target like Source option.

Click theMake Target like Source button and send the clone job.
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� ToCloneMultiple Servers
This procedure uses the CLI feature to create a profile from a complete host inventory.After you have
the profile, you can delete requirements from it to lock legacy software and files from being
overwritten during the clone job. Then the profile is sent to asmany servers as you choose.

In a terminalwindow, type the CLI command to convert an inventory to a profile.

# uce_cli -cip -P new_profileName -h source_host -u user -p password

See “Convert Inventory to Profile (-cip) Command” on page 277.

View the attributes of the profile (what is required andwhat is not allowed).

# uce_cli -lpa -P profileName -u user -p password

See “List ProfileAttributes (-lpa) Command” on page 261.

Toprotect legacy components on the target servers, delete the profile attributes that youdonot
want to clone over.

a. Export the profile to anXMLfile name.

# uce_cli -exp -ent "Profile" -f path-and-filename.xml -T "profile" -u user -p password

b. Edit the XMLfile. Delete the lines thatmention components youwant to protect on targets.

c. Import the edited XMLfile as the profile.

# uce_cli -imp -f path-and-filename.xml -u user -p password

See “Export (-exp) Command” on page 273.

In the console, create a job that deploys the profile on selected hosts.

See “Creating Complex Jobs” on page 194.

SharingDirectories
The Linux operating system is designed to be a network server or workstation. Sharing directories
and files between computers, even of differing operating systems, is a relatively simple task.Although
useful, it can be a daunting task for large environments. SunUpdate Connection – Enterprise
provides the tools to automate sharing andmounting, at the same time ensuring that the relevant
machines have the necessary software and files to perform the tasks.
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Mounting anNFSDirectory
This procedure shows how scripts can be used in SunUpdate Connection – Enterprise jobs tomake
every-day administration tasks fast and easy. This scenario uses NFS tomount a Linux directory on a
client Linuxmachine. It assumes anNFS server already exists.

� ToMount anNFSDirectory

Create a short script called mntnfs.sh that appends the appropriate line the /etc/fstab.
#! /bin/bash

nfs=nfs_server_hostname

mntPnt=mounted_directory

fstab_line=”$nfs: $mntPnt $mntPnt nfs nfsvers=2,rw 0 0”

echo $fstab_line >> /etc/fstab

/etc/init.d/netfs start

mount -a

Upload the script as a Local -> Pre-Action ->mntnfs.
See “UploadingActions” on page 104.

Create a profile that requires nfs-utils andmntnfs.
See “To Create a Profile” on page 173.

Make the profile applicable to all active distributions.
See “ToAlign Component Settings forMultiple Distributions” on page 210.

Run a job on selected hosts that deploys the profile.
See “Creating Complex Jobs” on page 194.

Mounting aWindows File System fromLinux
This procedure shows how simple scripts can be used in SunUpdate Connection – Enterprise jobs to
make everyday administration tasks fast and easy. This scenario uses samba tomount aMicrosoft
Windows directory (that is previously set to Shared onWindows) from a Linux file system.

� ToMount aWindowsDirectory fromaLinux Filesystem

Create a short script called mntWinSamba.sh that turns on samba and runs the command tomount
the directory.
#! /bin/bash

user=linuxuser

pass=passwd4user
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wincp=//win_hostname

winpath=/win_directory

linuxpath=/linux_mntdir

fstab_line=$wincp$winpath /mnt$linuxpath smbfs

username=$user,password=$pass 0 0

/etc/init.d/smb start

echo $fstab_line >> /etc/fstab

mount -a

Upload the script as a Local -> Post-Action ->mntWin.

See “UploadingActions” on page 104.

Create a profile that requires samba-client andmntWin.

See “To Create a Profile” on page 173.

Make the profile applicable to all active distributions.

See “ToAlign Component Settings forMultiple Distributions” on page 210.

Run a job on selected hosts that deploys the profile.

See “Creating Complex Jobs” on page 194.

DB2
DB2 is a popular application. It is licensed, not Open Source, and therefore, it is not included in
vendor distributions.

If you have the DB2 CD and a valid license, you can use this scenario tomake installation faster and
to ensure that your servers are completelymanaged by SunUpdate Connection – Enterprise.After
you have uploadedDB2 as anNCO to the local knowledge base, the Local Expansion Technology
generates rules for it. These rules ensure that DB2will work as an integral part of your environment.

� ToDeployDB2onMultipleMachines
This procedure uses a script that calls up the DB2 license file during automated installation.

Upload theDB2RPMs to the local knowledgebase.

The RPMs are listed under Local -> Local RPMs. See “Adding Undetected Linux Software” on page
85.

Create a Local File Declaration that is the pathwhere the license file should be installed.

For example, the filemight be /tmp/db2pe.lic.
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See “Creating File Declarations” on page 111.

Upload the license file as a Local Configuration File under the File Declaration.
See “Uploading Local Configuration Files” on page 113.

Create a script that does the following:

� Installs the license
� Creates DB2 users and instances
� Starts DB2

#!/bin/sh

OUTFILE=”/tmp/db2_uce.out”

# Definitions

LICENSE_FILE=”/tmp/db2pe.lic”

INST_DIR=”/opt/IBM/db2/V8.1”

SERVICE_NAME=db2c_db2inst1

SERVICE_PORT=50000

INSTANCE_NAME=db2inst1

INSTANCE_USER=db2inst1

INSTANCE_GROUP=db2grp1 INSTANCE_HOME=”/home/$INSTANCE_USER”

FENCED_USER=db2fenc1

FENCED_GROUP=db2fgrp1

FENCED_HOME=”/home/$FENCED_USER”

ADMIN_USER=dasusr1

ADMIN_GROUP=dasadm1

ADMIN_HOME=”/home/$ADMIN_USER”

# Install the DB2 license

$INST_DIR/adm/db2licm -a $LICENSE_FILE >> $OUTFILE 2>&1

# Fenced User Creation

groupadd $FENCED_GROUP

useradd -g $FENCED_GROUP -m -d $FENCED_HOME $FENCED_USER

chmod 755 $FENCED_HOME

# Instance User Creation

groupadd $INSTANCE_GROUP

useradd -g $INSTANCE_GROUP -m -d $INSTANCE_HOME $INSTANCE_USER

chmod 755 $INSTANCE_HOME

# Admin User Creation

groupadd $ADMIN_GROUP

useradd -g $ADMIN_GROUP -m -d $ADMIN_HOME $ADMIN_USER

chmod 755 $ADMIN_HOME
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# Edit entry in /etc/services??

etc_serv=\Qgrep $SERVICE_NAME /etc/services | wc -l\Q

if [ $etc_serv -eq 0 ] ;

then

echo “$SERVICE_NAME $SERVICE_PORT/tcp #DB2” >> /etc/services

fi

# Create db2 instance

$INST_DIR/instance/db2icrt -a SERVER -u $FENCED_USER -p $SERVICE_NAME

$INSTANCE_NAME >> $OUTFILE 2>&1

# Admin instance creation

$INST_DIR/instance/dascrt $ADMIN_USER >> $OUTFILE 2>&1

# Update DB manager configuration

$INST_DIR/instance/db2iexec $INSTANCE_NAME “. sqllib/db2profile; db2

update dbm

cfg using svcename $SERVICE_NAME; db2set -i $INSTANCE_NAME

db2comm=tcpip; db2 terminate” >> $OUTFILE 2>&1

# Set DB2AUTOSTART=YES for $INSTANCE_NAME

$INST_DIR/instance/db2iset DB2AUTOSTART=YES -i $INSTANCE_NAME >>

$OUTFILE 2>&1

# DB2 Start

$INST_DIR/instance/db2iexec $INSTANCE_NAME “. sqllib/db2profile;

db2stop; db2start “ >> $OUTFILE 2>&1

# DB2 Admin Start

$INST_DIR/instance/db2iexec $ADMIN_USER “. das/dasprofile; db2admin

start “ >> $OUTFILE 2>&1

Upload the script under Local -> Post-actions -> postDB2.

See “UploadingActions” on page 104.

Create a profile that requires the following:

� All DB2 RPMs
� Local -> Configuration files -> license file
� Local -> Post-actions -> postDB2

See “To Create a Profile” on page 173.

Run a job on selected hosts that deploys the profile.

See “Creating Complex Jobs” on page 194.
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WebSphere
WebSphere is another popular licensed application that is not included in vendor distributions.

If you have theWebSphere CD and a valid license, you can use this scenario tomake installation
faster and to ensure that your servers are completelymanaged by SunUpdate Connection –
Enterprise.After you have uploadedWebSphere as anNCO to the local knowledge base, the Local
Expansion Technology generates rules for it. These rules ensure thatWebSphere will work as an
integral part of your environment.

� ToDeployWebSphere onMultipleMachines
This procedure uses a script that calls up theWebSphere response file during automated installation.

Upload theWebSphere RPM to the local knowledgebase.
The RPMwill be listed under Local -> Local RPMs. See “Adding Undetected Linux Software”
on page 85.

Create a Local File Declaration that is the pathwhere the response file should be installed.
For example, the path is /tmp/WSresponse.txt

See “Creating File Declarations” on page 111.

Upload the response file as a Local Configuration File under the File Declaration.
See “Uploading Local Configuration Files” on page 113.

Create a script that runsWebSphere integrated installation procedureswith the response file and
then startsWebSphere.
#!/bin/sh

# In this example, the installation directory should be

# on a local filesystem. Should be updated for NFS if

# moved to a non-standalone demo system

SOURCE_DIR=”/root/demoscripts/websphere/WAS5Trial”

WS_DIR=”/opt/WebSphere/AppServer/bin”

# Ensure that the installation directory is available

if [ ! -f $SOURCE_DIR/install ] ;

then

echo “WebSphere installer not available.”

exit 1

fi
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#Install WebSphere using response file

$SOURCE_DIR/install -options /tmp/wsresponse.rsp

# Start the WebSphere server

$WS_DIR/startServer.sh server1

exit 0

Upload the script under Local -> Post-actions -> postinstallWS.

See “UploadingActions” on page 104.

Create a script that createsWebSphere users andgroups.
#!/bin/sh

# In this example, the installation directory should be

# on a local filesystem. Should be updated for NFS if

# moved to a non-standalone demo system

SOURCE_DIR=”/root/demoscripts/websphere/WAS5Trial”

# Users and groups needed if installing the Messaging Sub-system

# (MQ Series)

groupadd mqm

groupadd mqbrkrs

useradd -g mqm -G mqbrkrs mqm

# Ensure that the installation directory is available

if [ ! -f $SOURCE_DIR/install ] ;

then

echo “WebSphere installer not available.”

exit 1

fi

exit 0

Upload the script under Local -> Post-actions -> postsetupWS.

See “UploadingActions” on page 104.

Create a profile that requires the following:

� WebSphere RPM
� Local -> Configuration files -> response file
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� Local -> Post-actions -> postinstallWS

See “To Create a Profile” on page 173.

Create a profile that requires Local -> Post-actions -> postsetupWS.

See “To Create a Profile” on page 173.

Create a complex job that deploys the first profile and then the secondprofile on selected hosts.

See “Creating Complex Jobs” on page 194.
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Customizing Preferences

This chapter describes how to set preferences to control SunUpdate Connection – Enterprise
operations.

Note –The preferences for the dependencymanager can be viewed and edited only by the admin user.

This chapter covers the following topics:

� “Accessing and Editing Preferences” on page 297
� “Console Preferences” on page 298
� “Host Preferences” on page 300
� “DependencyManager Preferences” on page 302
� “Submit Edits” on page 304

Accessing andEditingPreferences
The following procedures explain how to access, edit, apply, and share changes amongmultiple
hosts.

You can view and change the way the console behaves. You can view and change preferences for any
agent application that is installed on amanaged host, and then propagate the changes to other hosts.

If you have the admin user password, you can change the preferences for the dependencymanager.

You can also set preferences for the SunUpdate Connection – Enterprise server from the preferences
of each of the applications. You can change the directories where downloads from the servers are kept
and the protocol for the applications to communicate with each other.

16C H A P T E R 1 6
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Opening thePreferencesWindow

� ToOpen thePreferencesWindow

Log into the console.

If you want to access the dependencymanager parameters, log in as the admin user.

Dooneof the following:

� From the tool bar, click the Preferences button.

� From the Toolsmenu, choose Preferences.

The Preferences window opens.

Console Preferences
Console Preferences let you control how the SunUpdate Connection – Enterprise GUI operates,
where files are to be stored, how it communicates with the system dependency server, and advanced
background job options.

� ToChangeConsole Preferences
In the Preferenceswindow, select the Console radio button.

The preferences for the console are accessible by default.

Make the changes that youwant.

If you want to change various preferences in different categories of the selected entity, you can
browse between the categories without clicking Submit every time. Your changes are remembered.

Console Preferences – Files
These parameters determine file upload and download times and let you set the path name of the
web browser.

� File timeout. Specifies the time limit in seconds for a file to upload to or download from a remote
host (see “OpeningHost Files” on page 124).
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Note –Take into account local network traffic and physical distance when changing this value.

� Path. Specifies the path to the web browser that SunUpdate Connection – Enterprise opens from
the Component Information window.

Note – To find the path of the current browser, in a terminal window, type which browser.

� Browser. Specifies the browser that SunUpdate Connection – Enterprise opens.

Console Preferences – Jobs
These parameters are fine-tuning for running andmonitoring jobs.

� Max items in a job. Specifies the warning limit for a job that is created in the Inventory
Comparison window. The unit is the task items in a job.
If no value is specified, the user is warned that jobmight be too big to succeed.

� Prerequisite details. Specifies whether to to show data in the Host Progress window that is found
by local probes.

Note –This preference is deselected by default to save on resources.

� Status window refresh interval. Specifies the time interval in seconds between data adjustment
of jobs status in the Jobs panel.

Console Preferences – Logs
These parameters are the path names and sizes for the console logs.

� Error log file name. Specifies the full path name of the error log of the console application.
� Error log size. Specifies the size limit in kbytes of the error log. If no value is specified, the log is

deleted.
� Job log file name. Specifies the full path name of the job log.
� Job log size. Specifies the size limit in kbytes of the job log. If no value is specified, the log is

deleted.

Console Preferences
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Host Preferences
Host preferencesmanage how each agent handles SunUpdate Connection – Enterprise jobs and
logs, and how SunUpdate Connection – Enterprise recognizes the host.

� Youmay view the preferences of only one host at a time.
� The host must be online and the agentmust be connected to the SDS.
� The agentmust not be busy at the time with an SunUpdate Connection – Enterprise job.

� ToChangeHost Preferences
In the Preferenceswindow, select theHost radio button.
TheHost Selection window opens.

Select a single host and then clickOK.

Waitwhile the Preference values of the selected agent are uploaded to the console.

Note – Preference values can be uploaded only if the agent is not busy with another command.

Make the changes that youwant.
If you want to change various preferences in different categories of the selected entity, you can
browse between the categories without clicking Submit every time. Your changes are remembered.

� ToShareHost Preferences
You can change the preferences of one host, and apply those changes tomultiple hosts. For example,
if you want all managed hosts in one group to be configured for a new port, you canmake the change
once, and then share the new port number with all the other hosts in the group.

Make the changes youwant, submit them, restart the agent, andwait for changes to be uploaded.

Open the Preferenceswindowagain select the original host.

Click Select target hosts.
The Select Hosts window opens.

Addmultiple hosts to the SelectedHosts list and then clickOK.
The preferences that you changed in the original host are copied to the selected hosts.

You can choose to share preferences with offline hosts. Their preferences are updated when they
come online.

1

2

3

4

1

2

3

4

Host Preferences

SunUpdate Connection – Enterprise 1.0 User’s Guide • September, 2006300



Host Preferences –General
The following parameters offer various options for a specific host.

� Listening port. Specifies the port on which to listen for the dependencymanager.
� Clean-up after instal. Specifies whether to delete no-longer needed RPMfiles after component is

installed to save disk space.

Host Preferences – Logs
These preferences point to the log files and set limits on their sizes. These logs are kept on the remote
host.

� Error log size. Specifies the size in kbytes of the error log for this agent.
� NCO log file size. Specifies the size in kbytes of the log for local components installed on this

managed host.
� Job log size – Specifies the size in kbytes of the job log for this agent.
� Resolve log file size. Specifies the size in kbytes of the log for each job action and for alternative

job solutions.
� Error log file name. Specifies the full path name of the error log.
� NCO log file name. Specifies the full path name of the NCO log.
� Job log file name. Specifies the full path name of the job log.
� Resolve log file name. Specifies the full path name of the resolve log.

Host Preferences –PKGs
The following parameters describe how Solaris packages are installed on Solaris machines.When
you install the SunUpdate Connection – EnterpriseAgent on a Solaris machine, the path name of
the Solaris admin file is /opt/local/uce/agent/config_files/admin. This file holds the answers
for package deployment. You can change these parameters in the Preferences ->Host -> PKGs
window, to change the parameters individually for a specific host, or you can point SunUpdate
Connection – Enterprise to your own customized Solaris admin file.

� Mail address. Specifies the address to which notification emails are sent when PKGs are installed.
� Package install basedir. Specifies the base directory where relocatable packages are to be

installed.
� Partial. Specifies one of the following if a package is partially installed on this managed host.

� nocheck.Do not check for partially installed packages.
� quit.Do not install the package if it is already partially installed.

� RunLevel. Specifies one of the following if the system status is not correct for the installation or
uninstallation of a package.

Host Preferences
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� nocheck.Do not check the run level.
� quit.Do not install or uninstall if run level requirement is notmet.

� Install depend. Specifies one of the following if other packages depend on the one being
installed.
� nocheck.Do not check for dependencies.
� quit.Do not install a package if its dependencies are notmet.

� Remove depend. Specifies one of the following if other packages depend on the one that you
want to uninstall.
� nocheck.Do not check for dependencies.
� quit.Do not uninstall a package that is needed by others.

� Check space. Specifies one of the following if the disk space of this managed host does notmeet
the installation requirements of the package.
� nocheck.Do not check disk space requirements (install will fail if themachine runs out of

space).
� quit.Do not install the package if the listed space requirements are notmet.

� Setuid flags. Specifies one of the following if a package should enable the setuid flag or the setgid
flag after installation. These flags are used in Solaris programming for security.
� nocheck.Do not check for the setuid executable or the setgid executable.
� quit.Do not install the package if it will turn on these flags.
� nochange. Install the package but override the flags.

� Check conflicts. Specify one of the following if the installation of a package will overwrite a file
that is provided by another package that has been installed and will create a conflict between files.
� nocheck.Do not check for conflicts and force the installation.
� quit.Do not install the package if file conflicts are detected.
� nochange. Install the package but do not install the conflicting files.

� Action scripts. Specify one of the following if the installation of a package provides an action
script that contains possible security impacts.
� nocheck.Do not check for security impact of action scripts.
� quit.Do not install the package if its action scripts could negatively impact security.

� CustomAdmin file full path name. Specify the path name of a customized Solaris admin file. If
no path is specified, use the default.

DependencyManager Preferences
TheDependencyManager Preferences control how the current DependencyManager (DM)works
with consoles and agents.

Youmust be logged in as the admin user to access these Preferences.
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� ToChangeDMPreferences
In the Preferenceswindow, select theDependencyManager radio button.

Wait while the values of the DMpreferences are uploaded to the console from the SDSmachine.

Make the changes that youwant.

If you want to change various preferences in different categories of the selected entity, you can
browse between the categories without clicking Submit every time. Your changes are remembered.

DMPreferences – Clients
TheDM acts as a server to the agents and to the console. These parameters determine connection
behavior for the DM–Console and the DM–Agent.

� Idle Console timeout. Specifies the time limit in seconds before an idle console automatically
logs out.

� Force change password.Automatically opens the Change Password windowwhen a user first
logs in to create a private password. This behavior is the default.

� Auto-saved inventories limit. Specifies the limit of the number of automatically saved
inventories to be kept for comparisons and rollback. If no value is specified, older stored
inventories are deleted.

� All agents read-only. Protects all hosts from change by executing all jobs done in simulatemode.
This paramter is only applicable to certain testing environments..

� Pause Scheduled Jobs. Pauses all scheduled jobs while this checkbox is selected. Use this
parameter before updating agents to ensure the application update is not interrupted by a job.

When you clear this checkbox, scheduled jobs whose time to run has passed are run immediately

DMPreferences – Logs
These parameters give the path names and sizes for the DM logs on the SDSmachine.

� Error log size. Specifies the size limit in kbytes of the error log. If no value specified, the log is
deleted.

� Job log size. Specifies the size limit in kbytes of the job log. If no value is specified, the log is
deleted.

� Error log file name. Specifies the full path name of the error log of the DM application.
� Job log file name. Specifies the full path name of the job log of the DM application.
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Submit Edits
After changing the values of preference parameters of an application, submit the changes and restart
the application.

SubmittingPreferences Customizations
In this procedure you submit the changes youmade and restart the target application.

� ToSubmit Changes

In the Preferenceswindow, click Submit.

The Preferences Confirmation window opens.

If you want tomake sure the changes are applied immediately, check the Restart/Logout option.

In the Preferences Confirmationwindow, click Submit.

The window closes.

Some setting changes are applied immediately. Some changes are applied only after restart. If you
want to continue working and have the changes applied later, leave the Restart/Logout option in the
Preferences Confirmation window deselected.
To restart the application later, use one of the following from the command line:

� Agent – /etc/init.d/uce_agent restart

� Console – uce_console
� dependency manager – /etc/init.d/uce_engine restart
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Index

A
add file declaration, CLI, 269
add group, CLI, 266
add host, 265
add host to group, CLI, 266-267
add local category, CLI, 268
add policy, 271-272
add policy attribute, 271-272
add profile attribute, 271
add software package, CLI, 268-269
add target local, 270
agent

All Hosts, 60
busy, 193
definition, 21
deploying confirmation policies, 182
distribution groups, 60
handling jobs, 226
jobs, 192
localizing files, 116
managed host, 67
read-only, 303
registering, 67
settings, 301
starting, 35

Apply Fix, 138
apply fix, policy recommendations, 139
Auto-saved inventories limit, 303
automation, jobs, 138

B
browser path, 299

browser setting, 299

C
category

add tomore distributions, 82
create, 79
create with CLI, 80
definition, CO, 148
definition, local, 76
delete, 82
edit, 81
properties, 81

Certification Lab, 19
CertifiedObject, see CO, 75
change password

first login, 55
force, 303

changing, managed host inventory, 42-43
Check Bug Fixes, 136, 139
Check Security, 136, 139
Check System, 136
check withdrawn patches, 137, 139
clean-up after install, 301
CLI

add file declaration, 269
add group, 266
add host, 265
add host to group, 266-267
add local category, 268
add policy, 271-272
add policy attribute, 271-272
add profile attribute, 271
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CLI (Continued)
add software package, 268-269
add target local, 270
compare hosts and inventories, 277-278
convert snapshot to profile, 277
copy policy, 273
copy profile, 272-273
delete group, 267
delete host, 265-266
delete job, 275
find component, 257-258
general notes, 16
list all hosts, 258
list distributions, 256-257
list group’s hosts, 260
list groups, 259-260
list host inventory, 259
list host properties, 258-259
list job status, 264
list jobs status, 263-264
list logs, 263
list policies, 261
list policy attributes, 262
list profile attributes, 261-262
list profiles, 260-261
list saved snapshots, 264-265
rename host, 266
save group inventory, 276
save host inventory, 275-276
submit compare job, 278-279
submit job, 274-275

CLI command
ag, add group, 266
ah, add host, 258
ahg, add host to group, 266-267
asp, add software package, 268-269
dg, delete group, 267
dh, delete host, 265-266
dj, delete job, 275
fc, find component, 257-258
h, help, 279
lc, list policies, 261
ld, list distributions, 256-257
lg, list group, 259-260
lgh, list group’s hosts, 260
lh, list host properties, 258-259

CLI command (Continued)
lhi, list host inventory, 259
ljs, list job status, 263-264
ljsa, list job data, 264
lss, list saved inventories, 264-265
rg, rename group, 267
rg, rename host, 266
scj, submit compare job, 278-279
sgi, save group inventory, 276
shi, save host inventory, 275-276

CO
definition, 75
in Knowledge Base, 78, 147
inventory, 76, 148
Local Software Review handling, 227

compare hosts and inventories, 277-278
compare inventories, 155
component

definition, 75
details, 100

component information
confirm tasks, 143
open browser, 299
viewing, 150

components list, 76
configuration file

add, 110
add with CLI, 115
definition, 79

conflict, definition, 136
connect host to DM, 301
console

definition, 21
logging in, 35
logs, 299
preferences, 298
starting up, 36

convert snapshot to profile, 277
copy policy, CLI, 273
copy profile, 272-273

D
default group, definition, 59
delete group, CLI, 267
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delete host, 265-266
delete job, CLI, 275
delete RPMs after install, 301
Dependencies tab, 101
dependency

definition, 136
fix, 100

DependencyManager
agent inventory, 149
definition, 191

dependencymanager
disconnected host, 32

DependencyManager
disconnected host in job, 34

dependencymanager
functions, 21

DependencyManager
jobs, 193
logs, 303

dependencymanager
starting, 35

DependencyManager
submit job to, 274

Dependency Resolver
definition, 147
in agent, 21
in job, 193
rejects conflicts, 172

diskspace, saving, 301
distribution group, 59
distributions, list all, 256-257
DM, see DependencyManager, 172
DR, see Dependency Resolver, 147, 172

E
empty package, 88
enterprise Linux, 19
Error log

console, 299
DM, 303
host, 301

errormessage
Cannot be deleted, 102
Cannot locate the following components, 160

errormessage (Continued)
Cannot process command, 77
job exceeds the recommended size, 160
package-namemismatch, 101

F
failed jobs, 34

confirmation no answers, 217
cost, 226
cost setting, 299
deleted local files, 123
file conflicts, 183
list with CLI, 263
log, 219
NCOs, 227
not installable, 226
permissions, 227
policy locked actions, 182
post-action returns, 103
probe returns, 107
rerun jobs, 220
resolve error, 225
Solaris diskspace, 209, 302
user request, 217

features, 20
file declaration

add, 111
add with CLI, 112

files
errors in comparison jobs, 160
size limit, 298
time limit, 298

find component, 257-258
force change password, 303

G
group

All Hosts, 60
create with CLI, 63
definition, 59
delete, 66
delete with CLI, 67, 267
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group (Continued)
edit, 65
edit with CLI, 65
in jobs, 60
list hosts with CLI, 260
list with CLI, 259-260
parent, 63
profile, 63
renamewith CLI, 267
save inventory with CLI, 153, 276
user-defined, 60

groups, managing, 61

H
help command, CLI, 279
homegrown applications, see also NCO, 19
host

assign to groups, 70
delete, 72
delete with CLI, 73, 265-266
edit, 71
icons, 61
list in group, 260
list inventory with CLI, 259
list properties with CLI, 258-259
list with CLI, 258
logs, 301
missing, 151
preferences, 300
profile compliance, 73
properties, 71
renamewith CLI, 266
save inventory, 152
save inventory with CLI, 152, 275-276
technical definition, 67
view inventory with CLI, 151
viewing, 61

hosts, managing, 67

I
idle console timeout setting, 303
Ignore File Conflict, 138

install
delete packages after, 301
indicator, 151

inventory
auto save limit, 303
compare, 155
compare with CLI, 157
create jobs, 154
definition, 76
limit to stored, 303
list with CLI, 259
save, 152
save with CLI, 152
saving, 152
sending to Engine, 193
understanding, 149

J
Job log

console, 299
DM, 303
host, 301

jobs
automation, 138
delete with CLI, 275
inventory, create, 154
list status details with CLI, 264
list status of all jobs, 263-264
settings, 299

K
Knowledge Base, 161

components without rules, 226
contents, 148
definition, 76

knowledge base, functions, 21
Knowledge Base

jobs, 193
security, 77
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L
lifecycle, 19
limit user to simulate jobs, 50
list all hosts, 258
list distributions, 256-257
list group’s hosts, 260
list groups, 259-260
list host inventory, 259
list host properties, 258-259
list jobs status, 263-264
list logs, 263
list policies, 261
list policy attributes, 262
list profile attributes, 261-262
list profiles, 260-261
list saved snapshots, 264-265
listening port, 301
local

files, categories, 103
fix dependency, 100
packages, add, 85
security fix, 99
software, 76
software, add with CLI, 87
software, see NCO, 88
software review check, 137

Local Expansion technology, 76
local expansion technology, functions, 21
local files

definition, 76
delete, 123
edit from host, 124
edit from knowledge base, 120
edit properties, 120
replace, 121
see also configuration files, macros, probes, pre-actions,

post-actions, 120
logging in to the console, 35
login timeout, 303
logs

console, 299
DM, 303
hosts, 301
list with CLI, 263

M
macro, 79

add, 116
add with CLI, 118
sign, 116

macro_sign, 116
Maintain target’s patches, 159
managed host inventory

changing, 40, 42-43
saving, 40, 42
viewing, 40, 41-42

managed hosts, 67
assign to groups, 70, 71

managing groups, 61
managing hosts, 67
Max items in a job, 299
middleware, 19

N
NCO

add, 85
add tomore distributions, 96
add with CLI, 87
check, 137
definition, 76
delete, 97
detection, 84
fix dependency, 100
handling, 227
host log, 301
linux

attach, 88
replace, 88
upload, 88

remove from distributions, 97
rule generation, 84
security, 84
technical definition, 77

NonCertifiedObject, see NCO, 76
notifications, actions, 76
notifications, component information, 151
notifications, email, 48
notifications, performing needed restart, 143
notifications, restart, 137

Index

309



O
open source, 19

P
package, 76

empty, 88
inventory, 148

package group, 76
edit, 95

password, change, 55
password, force setting, 303
Path setting, 299
PerformRestart, 137
PerformRestart + Reconfigure, 137
permissions

full, 46
limit, 45

permitted groups, user restrictions, 46
PKG, add, 90
policy

add with CLI, 140
copy with CLI, 273
definition, 148, 182
example, 182
list attributes with CLI, 262
list with CLI, 261
predefined profiles, 138

port for agent, 301
post-action, 103

add, 103, 104
add with CLI, 106

pre-action, 103
add, 103, 104
add with CLI, 106

predefined profile, 137, 139
confirm actions, 142
execute with CLI, 142
executing, 140
large jobs, 145
restart, 143

preferences
agents, 300
console, 298
DM, 302

Prerequisite details setting, 299
probe, 103

add with CLI, 109
adding, 107
results, 299

profile
copy with CLI, 272-273
create, 173
from saved inventory, 277
groups, 63
host compliance, 73
list attributes with CLI, 261-262
list with CLI, 260-261
purpose, 171

R
read-only hosts, 303
rename group with CLI, 267
rename host with CLI, 266
requires, 101
resolve, troubleshooting, 225
Resolve log, host, 301
return zero, 104, 107
rollback, 20
rule generation, 84
rules, 19

S
save group inventory, CLI, 276
save host inventory, CLI, 275-276
saving, managed host inventory, 42
SDS., See SystemDependency Server
security fix, 98, 99
Show Installed

deselect to see Local Inventory, 78
viewing host inventory, 151

simulate, default setting, 303
snapshot, 165
snapshot, see saved inventory, 264-265
Solaris baselines, using, 128
Solaris post-patch install, 137
Solaris post-restart, 137
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starting applications, 35
submit compare job, CLI, 278-279
submit job, CLI, 274-275
SunUpdate Connection – Enterprise overview, 19
SystemDependency Server, 21

applications, 21
connected hosts, 67
functions, 21

system dependency server, starting, 35

T
target file path name, 112
testing host, 301
third-party applications, 19
timeout

console, 303
file, 298

U
uce_console command, 36
universal server

connect from SDS, 21
proxy to local, 21

Unknown, 112
updating jobs, 60
upgrade software, check, 137, 139
upload

file timeout, 298
packages fromCD, 85
script, 103

upload PKG, 90
user

full permissions, 47
group limits, 51
read-only permissions, 49
simulate, 49

user-defined groups
definition, 60
nested, 63

user name, first login, 36
user restrictions, 45

users
managing, 46, 55

using, Solaris baselines, 128

V
viewing, managed host inventory, 41-42
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